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WELCOME TO THE
PLAYBACK METHOD™

Welcome to The Playback Method™, a comprehensive course and
workbook designed to revolutionize your performances on-stage
and how you use Playback on-stage. Our goal is to help you
implement playback with your band so that you can book better
gigs, make more money, and have more fun on stage. 

With The Playback Method™, you can finally play the songs you've
always wanted without adding additional musicians to your band
and recreate the sound you have in your head.

Why The Playback Method™?
Integrating playback into your live performances requires mastering
a lot of technology. Whether you're tech-savvy or not, we can all
agree that you didn't get into music to be frustrated with technical
issues. That's why we developed The Playback Method™ – so you
can focus on the music, not the technology.

This workbook and the accompanying course are the culmination of
over 20 years of using playback on-stage with bands and teaching
others to do so. It's not just a collection of how-tos, but a step-by-
step guide that dives into the "why" and will help you master skills
that even many professional playback engineers on the road don't
know.
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The 8 Stages of The Playback Method™

The Playback Method ™ consists of eight crucial stages, each
building upon the last to ensure your success in incorporating
playback into your live shows:

Prep: Why you need to use Playback on-stage.
Program: Creating your playback tracks and organizing your sets.
Practice: How to help your band practice, rehearse, and how to
ensure everything works before you step on-stage.
Perform: How to use Playback on-stage. .
Optimize: How to optimize your computer for the stage, and
how to learn the limits of your computer.
Hands-Free: Program your Ableton set so you don’t have to
babysit your computer on-stage, and can stay focused on the
music.
Redundant: Hope isn’t a good backup plan. Here’s how to
ensure your playback system always keeps working and the
show goes on...no matter what.
Remote: Learn how to move your Playback system off-stage and
still have full control of your show from on-stage.

By following these stages, you'll learn to:

Program your songs and sets in a way that requires minimal
interaction on-stage.
Create a fully redundant playback system for uninterrupted
performances.
Control your playback rig remotely, keeping the audience
focused on your musicianship.
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What You'll Achieve

With The Playback Method™, you'll be able to:
Have confidence that your playback will work, no matter what.
Use playback on-stage without letting the audience in on your
secret.
Feel like a musician again, not a technician.
Move your playback system off-stage and control it remotely.
Stay focused on the music and your performance.

Whether you're new to playback or looking to advance your skills,
this course will guide you from the basics through to advanced
techniques. You'll learn to create the perfect performance,
reducing on-stage effort while improving your overall show.
Remember, you're not on your own. This workbook, the
accompanying course, and the weekly coaching calls included in
the All-Access community provide everything you need to master
The Playback Method™ and elevate your live performances.

To The Perfect Performance!
Will Doggett

T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K



1

2

3

ST
A

G
E

ST
A

G
E

ST
A

G
E

PREP
During the prep stage, we’re talking about gear. In this stage, you’ll
learn the four things every Playback System needs to accomplish, and
you’ll learn how to optimize your computer, before you hit the stage,
so that you’re confident things will work. 

PROGRAM
Once you have your gear in place, it’s time to start programming your
songs and sets. You’ll learn the 3-Part Playback Framework and learn
how to use templates to program your songs and sets. In this stage we
optimize for quick set building, sets that won’t crash,  that are easy to
understand on-stage, and sets that are easy to edit and change
structure on the fly.

PRACTICE
What does playback have to do with practice? A whole lot, and in fact
you’ll learn how a simple shift in terminology, and using Playback, could
drastically improve your rehearsals. Get more done, and keep rehearsal
from dragging on. Plus, you’ll learn a new strategy that will insure your
entire rig functions and works perfectly before you step on stage.

CONTENTS
THE PLAYBACK METHOD™ WORKBOOK
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PERFORMANCE
Finally, it’s time for the performance. If we do our job right, there’s not a
whole lot to do here. Now we get to enjoy all our hard work. You’ll learn
how to easily navigate your Ableton Live Set on stage. 
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OPTIMIZE
Learn to maximize your computer's performance for live playback
without compromising stability. Discover how to determine CPU
limits, optimize track counts, and develop pre-show processes to
prevent performance issues, ensuring flawless shows every time.
Copy

HANDS-FREE
Learn how to program songs and sets to be "hands-free," freeing you
and your band from constant computer interaction during
performances. Master Custom Cues for better on-stage
communication and implement seven advanced programming skills
using the Advanced Playback Template or a setlist management
solution.

REDUNDANT
Don't rely on hope; learn to create a 'redundant' playback system that
serves as an automatic backup plan. Master both audio and MIDI
redundancy techniques to ensure the show always goes on, setting you
apart from most professional Playback Engineers.

CONTENTS
THE PLAYBACK METHOD™ WORKBOOK
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REMOTE
Master the art of remotely controlling your off-stage Playback system
using MIDI controllers, smart devices, or even your phone. Learn to
avoid common pitfalls, maintain control from anywhere on-stage, and
keep your Playback setup discreet, allowing you to focus on the music
without revealing your secret to the audience.
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THE PLAYBACK
METHOD™: 

PREP
Before you hit the stage, you'll need to learn why playback is important,
what you need for a playback system, and how to start setting up your
playback system.

Learn why using Playback is important
Learn how to convince the rest of your band to use Playback
Learn the four things a playback system will need to do (Play, Hear,
Control, Communicate)
Learn how to build a rock-solid, reliable playback system
Learn how to configure your playback template
Learn how to setup your audio interface with the playback template
Learn how to setup your MIDI controller with the playback template



INTRODUCTION
Before we get started, you’ve got to agree with me on this, Ableton and
Playback is an instrument. Using Playback is like adding another instrument
into your band. If we agree on that statement, there are a few implications.

It is not something that can be mastered overnight. As with playing the guitar, it
takes time to build calluses on your fingers and develop the necessary skills.
You’ve got to devote the time to build the skills needed to learn your
instrument. You don’t buy a guitar on Thursday and play the solo to Freebird
during your first show on Saturday. It won’t go well. 

It also means, if you devote the time to putting in the reps, and practicing it will
pay off. You’ll get better at this instrument. You’ll feel more comfortable on-
stage. You’ll understand how to get it to do what you need it to do. The more
time you devote, the better you’ll get at this instrument.

WHAT, WHY, HOW
THE PLAYBACK METHOD™ WORKBOOK

Sometimes your fingers may hurt and they
may bleed… But eventually what happens?

You build calluses on your fingers and it
becomes a little easier to play and a little

more fun to play.

"



By utilizing playback, you can elevate your live performances to a whole new
level. This enables you to book bigger and better gigs, ultimately leading to
increased income. 

Playback allows you to produce a superior sound that sets you apart from
other musicians. By replicating the original record, you can deliver a high-
quality performance that captivates your audience.

Booking Bigger & Better Gigs

Creating a Better Product

5 REASONS TO USE PLAYBACK
THE PLAYBACK METHOD™ WORKBOOK

Playback has the power to transform your live performance. Here’s 5 reasons why
you should learn this instrument:

One of the most significant advantages of using playback is the freedom it
provides on stage. With automation and click tracks, you no longer have to
worry about counting in every song or changing presets on your gear. It’s like
hiring multiple, un-paid, invisible techs to help you pull of the perfect show.

Fun and Freedom on Stage 

Playback opens up a world of possibilities by allowing you to play songs that
require additional musicians or instruments. Whether it’s a pop tune with
intricate synth parts or a classic track with a horn section, playback enables
you to bring these elements to your performances without the need for extra
musicians. 

Playing Songs Beyond Your Capabilities 

With playback, you can achieve a professional production without breaking
the bank. By syncing lights, videos, and lyrics with playback, you can create a
visually stunning performance without the need for additional personnel. 

High-Level, Low-Cost Production



Have More Fun on Stage

Highlight the joy and freedom
that playback brings by
eliminating the technical
distractions. Emphasize that
using playback allows everyone
to focus on the music and enjoy
the performance.

While you may be convinced of the benefits of playback, it can be challenging to convince
your bandmates to embrace playback. I’ve found the best approach is to sell the vision of
what playback allows you to achieve, instead of selling the idea of Playback. You’ve got to
remember, we’re all selfish. What’s in it for me? Why am I going to spend time, money, and
effort to start playing with a click and using playback? By focusing on how playback can
enhance their experience and contribute to their success, you can win them over. 

CONVINCING YOUR
BAND TO USE TRACKS

THE PLAYBACK METHOD™ WORKBOOK

Play Songs with
Instruments You Don’t
Have
Explain how playback enables the
band to play songs that were
previously out of reach due to the
lack of specific instruments or
musicians. By using playback, you
can recreate the desired sound
without adding additional
members.

Create Your Dream Show
Emphasize the creative possibilities
that playback offers. By
incorporating original sounds from
the studio recordings or creating
unique arrangements, the band can
bring their artistic vision to life on
stage. Finally, create the show of
your dreams.

Recording your own parts 

A student of mine, Dave, mentioned
that he won his band over to the
idea of playback when he convinced
them, they could record and create
their own tracks.

This allows your band to explore
their creativity and make unique
arrangements. This approach
eliminates the need to purchase
pre-recorded parts and gives the
band full control over the additional
sounds they use on stage.

Book Better Gigs

Illustrate how playback can lead
to better gigs and higher-paying
opportunities. By producing a
superior sound and impressive
production, you can book better
gigs. Don’t just be another band
in a bar. Become one of the top
bands in your area.



To understand the role of playback on stage, we must first consider how the audience
experiences a live performance. We have speakers (at least two) that are used to amplify
the sound for the audience. This sound is mixed and controlled by a front of house (FOH)
audio console, which receives inputs from the instruments on stage. This allows the
audio engineer to create the perfect blend of instruments and vocalists on-stage, to
create a great experience for the audience. 

However, since FOH is often located far away from the stage, a stage snake is used to
connect the instruments to the console. This stage snake acts as a conduit, allowing the
inputs from the stage to reach the front of house console via one large cable or ethernet
cable, instead of plugging multiple mic cables into the console.

Before we move on, it’s important to grasp that concept. All inputs on stage (instruments
and vocals) get plugged into a stage snake. But what do we do with Playback? The answer
lies in a key concept we discussed earlier... 

What is Playback? Playback is an instrument. What do we do with our instruments on
stage? We connect them to our stage snake. Just like any other instrument, Playback
needs to be connected to the stage snake in order for its sound to reach the front of
house console. We use an audio interface to take the outputs of our computer and
connect it to our stage snake. 

Based on your specific setup, you may connect to direct boxes, or simply connect
multiple XLR cables in a “loom” together to the snake, but the big idea to grasp is that
we’re taking the outputs of our interface and connecting to our snake, just like we take
the cables from our drum mics, or output of our bass, to the stage snake. Don’t
overcomplicate, or over-think this. 

Instrument --> Stage Snake. 
Playback = Instrument, therefore....
Playback --> Stage Snake.

HOW DOES THE AUDIENCE HEAR DURING THE SHOW?

Before we dive into the individual pieces of gear needed to build a playback system, it’s
important to understand Playback’s role on stage. If you’ve never stepped on stage

before, this is massive. If you’ve only used interfaces and computers in the studio, this
will take a massive shift in thinking. If you don’t have a proper perspective you’ll end up

creating an unnecessarily complicated and un-stable Playback system.

WHAT IS
PLAYBACK’S ROLE

ON-STAGE?

THE PLAYBACK METHOD™ WORKBOOK



We’ve discussed how the audience hears the band, but how does the band
hear themselves? 

In-ear monitors. 

In-ear monitoring is a separate aspect of live performances that allows
musicians to hear themselves and the rest of the band more clearly on stage. 

Typically that stage snake we plugged into, is also a “split-snake”. That means
the instruments we plugged into the snake, don’t just go to FOH, but also to a
monitor console. 

This allows another audio engineer to create a separate mix for each band
member of exactly what they need and want to hear in their in-ears. 

There are two, very important concepts you’ve got to understand with
this. 

In order to use playback, it is necessary to have in-ears, 1.
Playback has nothing to do with in-ears. 2.

You have to have in-ears and a monitor mix, in order to use playback. You’ll
need in-ears to hear the click track to keep everyone in time, and the cues in
order to keep everyone on the same page. 

Don’t try and skip in-ears and use floor wedges, and think you can make the
click a shaker and no one will know. The entire audience will know and will be
annoyed by the constant shaker that adds no musical value. 

You need in-ears. 

But, it’s important to understand, Playback has nothing to do with in-ears. This
is where you’ve got to leave your studio mindset in the studio. 

While you probably use your interface in the studio to hear what you’re doing,
your interface on stage is just that, an interface. 

It’s not a mixer or console. We use it to connect Playback to our sound system,
because remember, Playback is another instrument. 

HOW DOES THE BAND HEAR DURING THE SHOW?

THE PLAYBACK METHOD™ WORKBOOK



I know I said don’t do it.. But I know some of you.. you’re different. You’re a
unique little snowflake. Will.. because of budget, skill-level, we’re going to also
create in-ear mixes with our computer. Okay fine, here’s a list of what you’ll
need to do, then let’s chat at the end...

Connect every input on stage to a split snake. If the venue you’re in
doesn’t have a split snake, you’ll need to buy one. 
One side of that snake will go to FOH to be mixed. Please, for the love of
everything holy tell me you weren’t also going to mix FOH with your
computer were you??
Then the other side of all those inputs needs to go to your interface. If
we’re talking about a 3-4 piece band, vocals, drum mics etc.. we’re talking
16 inputs minimum to your interface. 
Then you’ll need to create multiple in-ear mixes, all using multiple outputs
from your interface, to send to each band member on stage. So for our
hypothetical 3-4 piece band, we’re looking at 8 stereo outputs (for four
stereo in-ear mixes).
Remember, we also need to get playback to FOH, so make sure you’ve got
enough outputs left over to get Playback to FOH. The most standard
output configuration I see is 8 outputs. So we need an interface with at
least 16 outputs. 
Each band member will want a different mix, consisting of different levels,
EQs, and panning. Since you’re using your computer for this, you’re in
charge of that mix buckaroo....get to mixing.
Oh yeah.. effects. You’ll need to create separate EQs for each mix, add
different compression, reverb, and delay to make sure each band member
feels comfortable, and make sure we don’t effect the connection to Front
of House. They’ll apply separate effects there.
Make sure the latency of your setup is imperceivable. This means you’ll
need to lower your buffer size as low as possible, so you don’t add any
delay to the signal going to the band.
And then we’ve also got to use our computer for Playback....

Press play, and watch your computer melt down on stage. 

Or heed my advice. 

Playback is another instrument on-stage. 

You have to have in-ears to use Playback, but Playback has nothing to do with
in-ears. 

CREATING AN IN-EAR MIX WITH YOUR COMPUTER

THE PLAYBACK METHOD™ WORKBOOK
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For professional-level artists, prioritize stability slightly over
simplicity, resulting in a slightly more complex, but stable rig.

Aim to find the right balance between simplicity (ease of use
and setup) and stability (reliability and robustness) in your rig.
You want a rig that’s simple to use, but is reliable and stable.

Don't make the rig so simple that it becomes underpowered and unstable.

Think of building a playback rig like balancing a seesaw, where
each side represents simplicity and stability.

Beginners should focus more on simplicity, avoiding over-complication,
and accepting a slight compromise in stability.

Be cautious of making the rig too complex, leading to convolution
which can make troubleshooting and setup difficult. Just because it
looks good for Instagram doesn’t mean it’s a good setup.

Similarly, avoid making the rig so complex that it becomes
convoluted and hard to manage.

BUILDING A PLAYBACK SYSTEM
IS ALL ABOUT BALANCE

THE PLAYBACK METHOD™ WORKBOOK

A good mental image to keep in mind while building a Playback system, is a seesaw. You
know, the balancing game you played on the playground as a kid. This is the perfect
picture of what we have to keep in mind when designing our systems. Here’s eight
concepts that will help you understand the importance of balance in your Playback
system.

The goal is to achieve an ideal balance where the rig is neither too simple
nor too complex, ensuring it is just stable enough without being
convoluted, and is simple enough, but not so simple that it’s un-powered. 



Focus on setups that allow rapid changeovers, crucial for festival performances or
scenarios with back-to-back bands. If you can’t setup your system in less than 5
minutes, it’s too complex, or disorganized.

Pros approach building a rig differently than the rest of us. Because pros have specific scenarios
they encounter, we can learn and integrate their practices into our rigs, no matter how big or small

are performances are. 

THE SECRETS THE PROS KNOW ABOUT
BUILDING A PLAYBACK SYSTEM

THE PLAYBACK METHOD™ WORKBOOK

Utilize separate, dedicated computers or devices for each aspect of the playback
system (e.g., playback, lights, video, vocal processing, keys). 

Each task should be handled by a dedicated machine to reduce stress on any single system.

Opt for rack mounting gear for an organized, protected, and portable setup.

Consider various options like drop-in racks for Pelican cases, modular racks, or specialized
racks like the Strange Electronic Strange Rack.

Use custom rack panels for personalized configurations and simplify connections.

Panels from companies like Redco can include pass-through or wired connections, such as
TRS to XLR.

Implement redundancy by having a secondary computer (B) mirror the primary (A)
playback computer.

Use an interface, like the PlayAUDIO1U to manage MIDI and audio outputs and ensure a
seamless switch in case of failure.

Ensure the setup balances simplicity with meeting all functional performance
requirements, including flexibility in controlling different aspects.

Apply redundancy to other rig components like keys, vocal processing, video, and
lighting for a full-scale professional setup.

Adapt the rack setup based on the specific performance scenario, considering the
difference between permanent setups and mobile 'run and gun' situations.

I know you’ve designed the “Perfect” Playback System.. but trust me.. your needs will
change. Make sure your rig is modular and expandable to accommodate any future
changes or needs. It will happen-trust me.
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BUILDING A PLAYBACK
SYSTEM: PLAY

The first thing we need our playback system to do is Play.
Let’s take a look at:

The best type of content to choose
What Playback Software we should choose
Choosing a computer for playback
And finally, how to back-up and manage our files
successfully.

From Studio to Stage -  Page 79From Studio to Stage -  Page 46

T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K



Use multitracks or stem files rather than stereo files, or split tracks. This allows you to
adjust the mix of your song in real-time based on your scenario, and allows for the
flexibility to un-mute a part when needed.

CHOOOSE MULTITRACKS/STEMS:

Split tracks, where the click and guide might be on one side and the rest of the
content on the other, are limited in flexibility. They do not allow for the removal or
adjustment of individual instruments or vocal parts.

LIMITATIONS OF SPLIT TRACKS/2-TRACKS

CHOOSING CONTENT
FOR ON-STAGE

BUILDING A PLAYBACK SYSTEM: PLAY

While AI tools exist for separating parts from a stereo mix, they may not always
provide optimal results. Using original stems or re-recorded covers of songs in  
multitrack format.

AI SEPARATION TOOLS

For cover or tribute bands, or if playing popular songs, you can purchase
multitracks from websites like Karaoke Version and Song Service.
Karaoke Version requires soloing and downloading each part individually.
Song Service offers a more straightforward approach, providing a folder with all
individual stems.
Worship Leaders will find original master multitracks at LoopCommunity and
Muiltitracks.

SOURCES OF MULTITRACKS

If you're producing your own music, export stems from your recording to use in
Ableton Live. Keep parts separated, but not too separate. Think about how much
flexibility you’ll need, and if they parts will ever need to be played live. Err on the side
of more separation, and flexibility with more stems.

CREATING YOUR OWN CONTENT



Now that we’ve got our songs to work with, we need a playback software to use them. Perhaps
unsurprisingly I suggest Ableton Live. But what version should you choose? Let’s talk a bit more
about the best decision for Playback:

VERSIONS OF ABLETON LIVE
There are three main editions of Ableton Live: Intro, Standard, and Suite. Additionally, there's
a version called Live Lite, which is a simpler version often bundled with hardware purchases.

ABLETON LIVE INTRO LIMITATIONS
The Intro version has limitations that may affect live performance, particularly with the
number of audio/MIDI tracks and outputs. It is limited to 16 audio/MIDI tracks and 8 outputs.

ABLETON LIVE STANDARD FOR PLAYBACK
For live playback, I recommend Ableton Live Standard. It removes track limitations and offers
up to 256 audio outputs.

CHOOSING PLAYBACK
SOFTWARE

BUILDING A PLAYBACK SYSTEM: PLAY

COMPATIBILITY AND REQUIREMENTS
Ensure your computer meets the minimum system requirements for the chosen Ableton Live
version, especially for live performance reliability.

STANDARD VS SUITE DECISION
The decision between Standard and Suite should be based on your specific needs,
particularly if you require advanced features like Max for Live or additional instruments and
effects included in Suite. If you’re using Setlist, TAZ, or Conductor, you’ll need Max4Live.



ABLETON LIVE SUITE FOR ADVANCED FEATURES
The Suite version is suggested for users who plan to utilize Max for Live, which allows for
custom instrument and device creation, and for using specific plugins that require Max for Live.

STARTING WITH ABLETON LIVE LITE OR INTRO
For beginners, starting with Ableton Live Lite or Intro is advised. These versions are more
affordable and suitable for testing the waters before committing to a more advanced
version. But.. keep in mind that you’ll need at least Ableton Live standard to do Playback well.

EDUCATIONAL DISCOUNT 
You can purchase Ableton Live with an EDU discount if you’re a From Studio to Stage student,
or a teacher, student in a education scenario.

UPGRADE PATH
Starting with a simpler version like Lite or Intro and then upgrading to Standard or Suite is a
cost-effective strategy. This approach is especially useful if you're new to Ableton Live.

CHOOSING PLAYBACK SOFTWARE
BUILDING A PLAYBACK SYSTEM: PLAY



CHOOSING A COMPUTER FOR
LIVE PERFORMANCE

BUILDING A PLAYBACK SYSTEM: PLAY

I’m completely biased towards MacOS. Ableton runs on Windows and
Mac, but I suggest macs for audio production. While you’ll see lots of
Windows PCs involved in video production, it’s less common to see

Windows machines for live audio use. If you’ve already got a Windows
machine, install Ableton on it and use it, but if you’re looking for a new

machine-consider a Mac.

MAC OR WINDOWS?

It's crucial to ensure that any computer you choose meets at least the
minimum system requirements set by Ableton Live. This includes the

type of processor, operating system version, RAM, and disk space.

ABLETON LIVE’S MINIMUM
SYSTEM REQUIREMENTS

The biggest mistake to avoid is over-investing in a single, super-powerful
computer. Instead, follow a 'division of labor' approach, which means
purchasing multiple well-spec’d machines, each dedicated to a specific

task (e.g., keys, playback, video, lighting).

INVESTMENT STRATEGY
FOR COMPUTERES 

Even a baseline Apple Silicon MacBook Air, is powerful enough for
running tracks. The M1 MacBook Air is a very cost-effective solution.

BUDGET FRIENDLY OPTION



While a MacBook Pro is more powerful, for a playback scenario, a
MacBook Air is often sufficient. It’s more about meeting the specific
requirements of your use case rather than just choosing the most

powerful option.

MACBOOK PRO VS.
MACBOOK AIR

BUILDING A PLAYBACK SYSTEM: PLAY

 The Mac Mini, especially when used with a rack mount solution like the
Sonnet Technologies Rack Mac Mini, is highly recommended for its
versatility and cost-effectiveness. This setup is ideal for creating a

redundant rig.

MAC MINI FOR RACK
MOUNTING 

It’s better to have two less powerful machines for redundancy than one
very powerful machine, but a single point of failure.

REDUNDANCY AND
MULTIPLE MACHINES

While more RAM and storage are always beneficial, prioritize redundancy
and division of labor over maximum specs. If budget allows, opt for

higher RAM, but not at the cost of foregoing a backup machine.

RAM AND STORAGE
CONSIDERATIONS



Stay current with the latest models (e.g., M1, M2, etc.) if budget permits.
Buying last years “new” computer, is a great way to save money, but

don’t buy something more than 2 years, or 2 models behind the 
current version.

UP-TO-DATE MODELS 

Do not overspend on a extremely high-spec’d machine if the primary use
is running playback. Allocate resources wisely across multiple machines

for different tasks.

AVOIDING OVERKILL

Make sure the computer meets Ableton Live’s minimum
 system requirements.

MEETING SOFTWARE
REQUIREMENTS



You’ve got to back-up your files. It’s not a matter of if something will go wrong, it’s a
matter of when. Don’t email companies after hours on the weekend, with the need for
emergency downloads of files. It’s time to be an adult and backup your files. We have
full control of this situation….It’s time to step it up!

IMPORTANCE OF BACKUP

Store only the most essential files on your internal drive, like templates and the
current set for a specific show. Avoid storing every set you’ve ever built or all
formatted songs on the internal drive.

INTERNAL DRIVE MANAGEMENT 

FILE MANAGEMENT,
BACKUPS, AND HARD DRIVES

BUILDING A PLAYBACK SYSTEM: PLAY

Use an SSD (solid-state drive) as an external storage device for all your songs, the
most recent set, and templates. This should be treated as a working drive.

EXTERNAL STORAGE 

Keep a thumb drive with your templates and the most recent set. This serves as an
emergency backup in case your main system fails and serves as “sneaker-net” to
transfer files between computers.

THUMB DRIVE

Now, we’ve got our content, Ableton Live Standard, and a killer computer to
run playback. The most important piece of this is making sure the show can
always go on. That’s where file management comes into play. Let’s discuss a
few strategies we should implement in order to make sure we always have
what we need, when we need it. 

Use cloud storage services for an additional layer of backup. Be cautious about relying
solely on cloud storage, especially in venues without reliable internet.

CLOUD BACKUP



For long-term storage of less frequently accessed files, consider using larger, cheaper
hard drives. This is especially important for files related to multiple artists or for
security-sensitive content.

COLD STORAGE ARCHIVE 

Ensure that your files are backed up in at least three different places for them to be
fully secure. This can include a combination of cloud storage, hard drive backups, and
system backups.

THE RULE OF THREE 

BUILDING A PLAYBACK SYSTEM: PLAY

Understand the difference between cloud storage (like Dropbox) and cloud backup
services (like Backblaze), and how they serve different purposes.

DISTINGUISHING BETWEEN STORAGE AND BACKUP 

Take personal responsibility for backing up your files to avoid panic situations like
computer crashes or theft, especially when you are on the road.

RESPONSIBILITY AND PREPAREDNESS 

Invest in various backup solutions (hard drives, cloud services) to ensure
comprehensive protection of your content.

INVEST IN MULTIPLE BACKUP SOLUTIONS 

Utilize services like Backblaze for automatic backups of your entire system, including
internal and connected drives.

AUTOMATIC SYSTEM BACKUP
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BUILDING A PLAYBACK
SYSTEM: HEAR

The next thing we need, is the ability to hear. Here’s a look
at what we’ll dive into in this section: 

Choosing In-Ear monitors for the stage
Choosing an In-Ear monitoring System
Choosing an audio interface for live performance 
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Headphones can be used instead of in-ear monitors, especially for musicians who are
not at the front of the stage, like drummers or keyboard players. However, they may
look awkward for front-stage performers. Headphones also let people “into the
secret” that there’s more going on than they first thought. In-Ears can help function a
bit more discreetly. 

HEADPHONES AS AN ALTERNATIVE

One of the main advantages of in-ear monitors over headphones is better sound
isolation. This helps cut out stage noise, which allows you to hear your mix better, without
having to turn up the level to compensate. This ultimately, helps protect your hearing. 

ISOLATION

Custom in-ears are molded to fit an individual's ears, offering superior isolation and
comfort but at a higher cost. Again, minimizing stage volume, and being discrete are
the two big factors here.

Universal in-ears are less expensive and can fit any ear, but they may not provide as
much isolation.

CUSTOM VS. UNIVERSAL IN-EARS 

In-ear monitors are better than monitor wedges for better sound control and
reduction in stage volume. Wedges can be used for monitors, but they can’t be used if
you’re planning on using playback. If you’re not planning on using playback, not sure
why you’re in this course, or reading this workbook.. But welcome!

IN-EARS VS. MONITOR WEDGES

Earlier, we discussed Playback’s role on the stage. One of the important
concepts we learned was that to use Playback, you’ve GOT to use in-ears, but
that Playback has NOTHING to do with in-ears. Let ’s dive into some specifics
that will  help us choose the right pair of in-ears. 

CHOOSING IN-EAR MONITORS
BUILDING A PLAYBACK SYSTEM: HEAR



Different musicians may benefit from different types of in-ears. Companies often
suggest specific models based on the instrument or role (e.g., vocalists, drummers). 

For example, my in-ear company of choice Alclair, does a great job of sharing charts
and suggestions based on each role on the stage.

ROLE-BASED RECOMMENDATIONS 

Custom in-ears might be a better long-term investment for comfort and sound
isolation, especially for musicians who use in-ears frequently.

LONG-TERM COMFORT AND FIT 

Evaluate whether the increase in sound quality with more expensive, multi-driver in-
ears justifies the higher cost for your specific use case.

SOUND QUALITY VS COST

More drivers generally provide better sound quality, with separate drivers dedicated
to different frequency ranges (low, mid, high).

The choice of the number of drivers should be based on the role within the band and
personal preference. Vocalists might be fine with fewer drivers, while drummers or
bassists might prefer more drivers for better representation of the full frequency
spectrum.

FREQUENCY RESPONSE AND DRIVERS 



Will you hire a separate engineer using a separate console to mix your ears? Or, will
you mix your own ears using an iPhone app, or personal monitoring system?

WHO WILL MIX OUR IN-EARS? 

How will your in-ears connect to the console? Wireless gives you alot more flexibility,
but can become pricey, while a wired system is easy to piece together affordably, but
often at the cost of not having as much mobility. 

WILL YOUR CONNECTION BE WIRED OR WIRELESS?

CHOOSING AN IN-EAR
MONITORING SYSTEM

BUILDING A PLAYBACK SYSTEM: HEAR

Decide if your ears will be mixed by an audio engineer, either at FOH or at a separate
monitor console, or if you’ll do it yourself. In short, a digital console, and using an app
to create your own mix, can yield some amazing results, without extra budget or
personnel. But, it’s hard to beat a talented engineer creating the exact mix you’ve
always dreamed of. 

MONITORING SCENARIOS

Regardless of who is mixing your ears, it all has to start at a console. You’ll utilize aux
outputs on your audio console to create individual mixes for each band member.
Using the “Sends on Fader” option you can adjust mixes for each band member. 

CONSOLE OUTPUTS FOR IN-EARS 

Getting in-ear monitors is only one part of the equation. How do we get sound to
them? Earlier, we mentioned the idea of a monitor console. Often you’l l  have a
completely separate audio engineer whose whole job is to mix for the band.
Because of budget reasons, or simply because you’re self-sufficient, you might not
have a monitor engineer, but it ’s sti l l  worth looking at how to get your own mix. 

Choosing an in-ear monitoring solution comes down to answering two questions:

Let’s dive a little deeper: 



Decide between a wireless in-ear monitoring system or a wired setup. Wireless offers
mobility, while wired can be more reliable and less expensive. Don’t be afraid to mix
and match. For members that won’t be moving (drummer, keyboardist) putting them
on a wired mix, might save some money. 

WIRELESS VS WIRED CONNECTION 

Consider low-cost wireless solutions like the Xvive U4 system for basic needs, but be
aware that they offer mono mixes and limited features.

BUDGET-FRIENDLY WIRELESS OPTIONS 

Connect XLR cables from aux outputs on your soundboard. If at all possible,
choose stereo outputs, and create separate mixes for each member of your band. 
Connect the XLR to a headphone mixer (like the Behringer Power Play P1).
Connect a headphone extension cable to your headphone mixer. Make sure the
cable is the right connection for the mixer and your in-ears.
Connect your in-ears to the headphone extension cable. 

For a wired setup: 

For more demanding setups, look into higher-end wireless systems from brands like
Sennheiser or Shure, which offer stereo mixes and more robust performance.

ADVANCED WIRELESS SYSTEMS 

For a wireless setup:

Connect XLR cables from aux outputs on your soundboard. If at all possible,
choose stereo outputs, and create separate mixes for each member of your band. 
Connect the XLR to the wireless transmitter included with your system. Make sure
the antennas with your transmitter, are clearly in view and have line of sight to the
band member that will be using them. If your system includes external antennas
or RF paddles, use them, and place them in clear view of the stage. 
Use the receiver or wireless pack included with your system and make sure that
you’re on the correct RF frequency and channel. 
Connect your in-ears to the wireless receiver.
Adjust and build your mix using your audio console. 



Utilize apps associated with your digital console (like the X32 edit app) to mix in-ears
yourself. Ensure the console is connected to a wireless router for this functionality.

MIXING IN-EARS YOURSELF

Consider personal monitoring systems like Live Mix, or Behringer P16 for individual control
over mixes. These systems require a central hub (brain) connected to the console.

PERSONAL MONITORING SYSTEM

If using a digital console like the Behringer X32, explore compatible personal monitoring
systems (e.g., Behringer P16) that can directly connect via an Ethernet port (Ultranet).

INTEGRATION WITH DIGITAL CONSOLES

For sophisticated needs, systems like Klang for immersive IEM experiences or Live Mix
for Dante integration offer advanced features and flexibility.

HIGH-END MONITORING SOLUTIONS

Investing in a digital console provides the flexibility to mix in-ears via an app and the
potential to expand to a personal monitoring system.

DIGITAL CONSOLE BENEFITS 



For a simple setup, use a basic cable (like the HOSA CMP 153) that splits the
computer's headphone output into two separate outputs - one for the click and cues,
and another for the tracks.

BASIC SETUP WITH MINIMAL OUTPUTS 

For a basic setup (like mentioned above) utilize direct boxes (DI's) to convert TRS
connections to XLR, allowing you to connect to the stage snake or soundboard. 

DIRECT BOXES

CHOOSING AN AUDIO
INTERFACE FOR PLAYBACK

BUILDING A PLAYBACK SYSTEM: HEAR

For setups requiring many outputs or redundancy, the iConnectivity PlayAUDIO1U or
a similar interface with multiple discrete XLR outputs and computer connections is
ideal. This setup allows for backup in case the primary computer fails.

HIGH OUTPUT NEEDS AND REDUNDANCY 

For high track count requirements, Dante and DVS (Dante Virtual Souncard) offers a
powerful solution, allowing for up to 64 channels from a computer via an Ethernet
connection. 

NETWORK-BASED SOLUTIONS (DANTE)

Now we’ve got our in-ears and an in-ear monitoring setup. How do we get audio
out of our interface and connected to our soundboard? 

For more complex needs, consider an audio interface that offers more outputs. Avoid
2 channel interfaces, and buy an interface with 4 or more outputs. An 8-output
interface like the Track Rig from Loop Community is recommended for beginners due
to its straightforward design and rack-mountable feature.

ADVANCED SETUP WITH MORE OUTPUTS 

Don’t let the simplicity of Dante make you skip redundancy. Implementing
redundancy with the EXbox.MD when using Dante is crucial to switch automatically to
a backup computer in case of failure.

REDUNDANCY IN NETWORK-BASED SOLUTIONS 
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BUILDING A PLAYBACK
SYSTEM: CONTROL

Next, you’ll need to consider control options for your
Playback System. In particular, we’ll discuss:

Who should be in charge and in control of Playback? 
How do we control playback, without looking like we’re
checking our email on-stage? 
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Decide whether the playback engineer will be an on-stage musician (like a drummer
or guitarist) who also handles playback, or a dedicated off-stage playback engineer.

ON-STAGE VS. OFF-STAGE 

Prefer someone experienced in using specific playback software (e.g., Ableton) and
capable of making real-time edits or changes.

EXPERIENCE WITH PLAYBACK SOFTWARE 

Behind every great artist,  is a talented (and patient) Playback Engineer. The
Playback Engineer is in charge of running playback, making last minute edits,
and following changes and cues during the show. In many scenarios, they’re
also responsible for sending MIDI and timecode to control the entire show
and automate production. 

To be perfectly honest, besides the artist,  they are the second most important
role! But, with great power, comes great responsibility! So who should be in
charge of playback for you and your band? 

Maybe you’ve got a large enough budget to hire a dedicated playback
engineer? Maybe you’re a muaisicn on-stage AND a playback engineer. Or,
maybe you’re a solo artist,  who is doing it all .  

No matter your budget or personnel setup, we’ve got to make a decision on
who is in charge of playback ultimately. Let ’s walk through a few things to
consider.

Consider the additional costs of having an off-stage playback engineer, including
salary, travel, and accommodation expenses.

BUDGET CONSIDERATIONS 

Evaluate the possibility of existing crew members (e.g., monitor engineer) taking on
playback responsibilities to save costs.

COMBINING ROLES 

WHO SHOULD BE IN 
CHARGE OF PLAYBACK?

BUILDING A PLAYBACK SYSTEM: CONTROL



The ideal candidate should be tech-savvy, capable of handling and troubleshooting
technology issues, while keeping a cool head.

TECHNICAL EXPERTISE 

Consider if the playback engineer role will be combined with other roles, like a music
director, and whether they can handle the additional responsibilities. For example,
managing the emotions and temper tantrums of a diva (or divo) artist and managing
and communicating with the band, means someone other than the Music Director
should be in charge of Playback. But, if you’re in the band (and functioning as the
band’s MD or in-band producer), you might simplify and speed up things if you can be
in charge of Playback also.

ROLE FLEXIBILITY 

Assess how the playback engineer's role fits within the band's dynamics, especially if
they also serve as a music director or band member.

BAND DYNAMICS AND COMMUNICATION 

Determine whether a DIY approach (where a band member takes on the role) or a
professional dedicated playback engineer is more suitable for your needs.

DIY VS. PROFESSIONAL APPROACH 

Acknowledge that programming the set and running it on stage can be separate roles
and decide if they should be combined or split between individuals. For example, a
student of mine, Nick (who plays with a famous pop artist), programs the set
beforehand, and starts and stops songs on-stage (while playing guitar), but has a tech
manage and cue up songs off-stage.

PROGRAMMING VS. PLAYBACK OPERATION 



DON’T LOOK LIKE YOU’RE
CHECKING YOUR EMAIL ON STAGE

BUILDING A PLAYBACK SYSTEM: CONTROL

You’ve decided who will  be in charge or Playback, now it ’s time to talk how.
How will  they control their computers? If they’re on-stage, it becomes even
more crucial to chose the right MIDI controller, so you don’t look like you’re
checking your email on stage. Let ’s look at some considerations for choosing
the right MIDI controller. 

FOR DRUMMERS
Consider something like the Roland SPD-SX to control playback without
putting down your sticks. Drummers might also find success with a foot-
switch like the Looptimus or Morningstar MC-8. 

FOR GUITAR PLAYERS
Highly consider a foot-switch like the Looptimus, Morningstar MC-8 or for
a more integrated experience, choose the Oaktone FloorVista. 

FOR KEYBOARDISTS/OFF-STAGE PLAYBACK ENGINNERS
The Oakboard mini or Slide Duo are great. The LIOBOXv2 is a one of a kind
solution that allows you to control Ableton and build setlists directly on
the controller. 

BUDGET FRIENDLY OPTION
The AKAI LPD-8 is a great solution that can be purchased at almost any
music store in the world.

ADVANCED SETUPS
For advanced setups, especially in larger venues, consider routing your
MIDI controller through a mioXM or mioXL from iConnectivity. This setup
allows you to keep computers off-stage while maintaining control from
your MIDI controller on-stage.

Select a MIDI controller that aligns with your role and setup requirements,
and consider upgrading as your needs evolve.
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BUILDING A PLAYBACK
SYSTEM: COMMUNICATE

The final part of our playback system is the ability to
communicate. In this section we’ll discuss: 

Why is it so difficult to communicate on-stage?
How can we easily communicate on-stage, while still
wearing in-ears? 
How can we communicate on-stage, to a playback
engineer located off-stage?
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I  NEED MORE GUITAR IN MY EARS!!! !  I ’m not yell ing at the Front of House audio engineer
because I ’m mad, but because I ’ve got these sound isolating ear plus in my ear, that lead
me to not realize how loud I ’m talking. 

Have your friends ever laughed at you when they ask you a question while you’re wearing
headphones and hear you screaming back your response? Imagine how much more that’s
intensified when we’re playing loud instruments amplified through speakers. 

No wonder so many bands break up! A stage full of people yell ing commands at each
other, doesn’t always promote unity, and a supportive environment. If we’re going to be
using playback, we’ve got to use in-ears, and using in-ears makes it really difficult to
communicate on stage. Here’s a few ways to improve that experience. 

HOW TO IMPROVE
COMMUNICATION ON-STAGE

BUILDING A PLAYBACK SYSTEM: COMMUNICATE

This allows everyone to communicate with each other and the sound engineers. A
talkback mic is simply a microphone that is only routed to the in-ears, and not heard
in the front of house, main mix. 

EQUIP EACH BAND MEMBER WITH A TALKBACK MIC

If we’re using in-ears to lower stage volume, and create our own mix, the worst thing we
can do is turn on a bunch of mics and leave them on in our mix. So how do we allow band
members to communicate, but turn their mic off when not needed? You can easily use a
footswitch like the Radial HotShot DM-1 to un-mute your mic when you step on the
footswitch. When the mic isn’t active, it is off, and you’ll only hear it when you step on the
footswitch. There are also other solutions like an Optogate, which enables the mic when
you’re near it, or a mic with a on/off switch, but I tend to prefer a simple footswitch
solution like the DM-1.

SETTING UP A MIC MUTE

 If you’re also singing, then you can use the DM-1 to toggle between two different
outputs, one that goes to front of house by default, and the other output that goes to
in-ears only. 

BUT WHAT IF I’M ALSO SINGING? 

If you’re using a wireless mic, check out the Relay XO from radial that allows you to
connect the RelayXO to the wireless receiver and you can remotely toggle between
channels using a footswitch. 

BUT WHAT IF I’M USING A WIRELESS MIC? 



1 Start by getting your band comfortable with in-ear monitors. Again, sell the sizzle
not the steak. They’ll be able to have their own mix-they won’t need to share with
anyone, they’ll be able to save their hearing, and they’ll have the best possible
experience on-stage with monitoring. 

Keep in mind, in most cases our band members aren’t trained audio engineers. We
tell our band mates to wear in-ears that isolate all outside noise, and put an
untrained, in-experienced audio engineer (them) in charge of their mix. No wonder
they hate it so much! 

Give this time. Help them create the perfect mix. Hire an audio engineer to come in
for a few hours during a rehearsal and help create a good starting place. Save that
mix. Have them come back and teach a few basic principles to always start from a
good place, and what to change, and how to change it when you need to make
changes.

FOLLOW THIS TIMELINE TO INTEGRATE
PLAYBACK WITH YOUR BAND 

THE PLAYBACK METHOD™ WORKBOOK

No matter your budget, or the skill-level of your band, you’ll need to follow a specific timeline in
order to integrate playback. If you try and skip the order of the transition, or try and rush the
transition, you’ll only end up frustrating your band and potentially causing your band to be
frustrated and potentially give up on the idea of Playback altogether. 

Before we talk about the timeline, remember that I suggest spacing out each transition by at
least a week, if not even longer. If you're just getting started as a band and using playback, you
may want to add a month between each transition. I remember teaching at a conference years
ago, and I would run into the same person each year. Each year they would let me know they’re
transitioning to the next step that year. There’s nothing wrong with each transition taking a
year-it’s all up to your band and their comfort level.

2 Once in-ears are adopted, introduce playing with a click track. I choose my words
carefully here. We’re playing “with” a click, not “to” a click. Playing to a click means
we’re being told what to do when. When we’re playing “with” a click, it’s apart of the
band-it’s not the leader. If we want to speed up or slow down, we can adjust the
click. 

In every band I’ve ever lead, coached, worked with, there’s always at least one
person that struggles to play with a click. In EVERY situation it is the person that is
most resistant to playing with a click. “Real musicians don’t use click!”.. “A click is for
the studio”...”I’m the drummer…and my job is to keep time, not the click..” 

READ THIS BEFORE STARTING TO USE PLAYBACK WITH YOUR BAND... 



You’ve got to remember this is a self-preservation technique. They’re willing to do
everything to keep from using click, because they can’t do it. They’re embarrassed,
which is why they’re so resistant to this. 

While you should be aware of this reality, instead of calling them out and
embarrassing them further, you should go above and beyond to help them
prepare.

Post the click and tempo for every song you’re performing beforehand. 
Slow the transition to click… again take time.
Share rehearsal and play along tracks with your whole band, so everyone can
practice beforehand.

Once you’re comfortable with in-ears and playing with click, it’s time to tackle the
transition to Playback. 

3 Finally, it’s time to introduce playback. This requires both in-ears and a click track
for proper timing and synchronization. We can’t use playback without click, and we
can’t do that without in-ears. 

This will take time. You’ll want to find the balance of how many tracks are enough
for you. You’ll want to find what sounds sound right for your band, and what
sounds sound too fake. 

Again, remind your band that playing with pre-recorded tracks doesn’t mean you’re
“faking it”. Most bands using playback aren’t simply faking that they’re playing guitar
while all guitar is coming from playback. They’re using extra, additional sounds to
supplement what they’re doing. 

Overall, give it time. Don't rush it. Don't give up. You’ll get there. Your band will be won over. I’ve
seen it in every band I’ve ever been a part of. The people that didn’t get it, weren’t humble
enough or good enough musicians to make it happen. They didn’t stick around. 

But, it always works out. You’ll always find the right musicians that get it, and you’ll be one of
the best bands in your area. Keep going.
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SETTING UP
THE PLAYBACK

TEMPLATE 
The fastest way to program songs and sets in Ableton Live,
is to use a template. In order to speed up this process, let’s
setup our MIDI controller and audio interface with our
template. We’ll learn how to: 

Customize the Playback Basic Template.
How to set up our MIDI Controller with our template. 
How to set up our audio interface with out template.
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1

If you want to customize your template in any way, make sure to make a copy of
your template and make sure to backup your file as well. 

Go to File -> Save Live Set As.

Save in your templates folder, not the default location.

Name the template as desired.

WORKING WITH THE PLAYBACK 
BASIC TEMPLATE 

THE PLAYBACK METHOD™ WORKBOOK

2

SAVE A COPY OF THE TEMPLATE 

Use the 'Collect All and Save' option to include all external samples in your
template. Failing to do this will result in “missing samples” in your template.

COLLECT ALL AND SAVE 

3
Create a backup of your customized template in a separate location. I suggest
backing up your file in at least 3 places, one of which should be cloud storage of
some kind. 

In general, don’t rely on being able to re-download the file from our site. You’ve
now got the file, you can put it in multiple places. Time to be an adult and back it
up Terry.. This one’s on you. 

Here’s the reality..the only person that will have access to this customized
template is you. I don’t have it. If you customize this template, make sure you
back up the file, because no one will have access to it. 

BACK UP THE TEMPLATE 



5

I’ve worked hard to create this template based on years of experience, and
feedback from others. I suggest keeping it intact, but you do you. If you want to
customize and adjust, go for it. Here’s a few things you can change, and a few
things you shouldn’t change

You can delete the 'Songs' track. I like this as a visual reference, but it isn’t
necessary to the function of the template.

You can delete the cues track if you’ll never use cues or slate tracks ever.
Listen, I hate cues. I don’t like them. I’ve seen them be abused by lazy
musicians that rely on them, instead of learning their parts.. But they’re
helpful. They help your band stay on the same page and improve your
performance. So trust me… I hate them, but I still suggest using them.

You can delete the markers track if you want, but I highly suggest keeping it.
This is a “pro-level” skill. Being able to start on any song section of your song,
and know exactly where you are visually will keep rehearsal running
smoothly. It will allow you to edit faster than anyone else. Having the
markers track will allow you to work faster and with less stress than anyone
else around you.

You must keep a click track, and the tempo track. Do not delete these.

GLOBAL TRACK CUSTOMIZATION 

4

Return tracks are for grouping instruments together. They have nothing to do with
outputs on your interface. They are a final grouping tool before we route to our
interface. I’ve made by best guess at a good general suggestion for return tracks,
but you should customize this to fit your needs.

Review the 12 return tracks (groupings).

Delete unnecessary return tracks.

Rename return tracks to match your instrument groupings.

CUSTOMIZE RETURN TRACKS 



7
Again, if you’d rather use audio cues, you’re welcome to convert my MIDI track into
an audio track. You can use the audio cues you’re used to instead of my MIDI, AI
generated cues. Again, here comes the warning as to why you shouldn't’ do this. If
you stick with my AI MIDI cues player, you can update your cue sounds at any time,
and you only have to update them in your set. 

You don’t have to drag them to each song you’ve programmed to have them use
the new sounds. In addition you can clone your existing cues to make new cues
using the AI service I used to generate the cues.

MODIFY CUES TRACK (OPTIONAL) 

6
If for some reason you like less flexibility or just find yourself a tweaker.. You can
choose to use an audio click instead of my MIDI click. Keep in mind, you’ll lose the
ability to subdivide your click, lose the ability to keep all your clicks the same (which
makes managing levels much easier) and you’ll lose the ability to replace your click
samples once, and have them change for all your songs at once. But again.. You do
you. But don’t say I didn’t tell you :) 

MODIFY CLICK TRACK (OPTIONAL)

7
For any new tracks added globally, place them below the 'Markers' track. This allows
you to continually update and refresh your template, but allows you to do this
without having to re-program previous songs.

ADD NEW TRACKS BELOW MARKERS TRACK

8
Here’s a checklist that helps guide you through customizing the basic playback
template in Ableton Live, focusing on maintaining essential elements while tailoring
the template to your specific needs.

Add new locators as needed.
Assign locators to keyboard keys for easy access.
Use letter keys for locators beyond number 8.

CUSTOMIZE LOCATOR ASSIGNMENTS 



01

02

03

04

Avoid overly complex controllers. Aim for simplicity
and something that fits your context. Need
suggestions? Avoid grid based controllers for
Playback, as they don’t provide the visual feedback
needed to navigate your song.

CHOOSE THE RIGHT MIDI CONTROLLER

Plug the USB cable directly into your computer or a
powered USB hub.

CONNECT YOUR MIDI CONTROLLER 

Do not use USB extenders or USB to Ethernet
extenders as they are prone to failure. Connect your
MIDI controller directly to your computer. You’ll learn
in the advanced Playback method how to use a
mioXM or mioXL to send your MIDI long distances
across the stage to your computer.

AVOID USB EXTENDERS 

Ensure your MIDI controller is powered and
compatible with your computer. Install any 
necessary drivers.

CHECK MIDI CONTROLLER POWER
AND COMPATIBILITY 

HOW TO SETUP YOUR MIDI
CONTROLLER WITH THE
PLAYBACK TEMPLATE 

THE PLAYBACK METHOD™ WORKBOOK



05

06

07

Press Command (⌘) + Comma (,) to open Preferences.
OPEN ABLETON LIVE PREFERENCES 

 Go to Link, Tempo, MIDI tab.
 Avoid using pre-set control surface mappings.
 Set 'Takeover Mode' to 'Value Scaling' if your
controller has faders.
Enable 'Remote' in the MIDI Ports “IN” section for
your controller.

CONFIGURE MIDI SETTINGS IN ABLETON LIVE

Press Command (⌘) + M to enter MIDI Map Mode.
Map four essential controls: Play, Stop, Next, 

        and Previous.
Assign each control to a button on your 

        MIDI controller.
Play is assigned to the play button in Live. 
Stop is assigned to the stop button in Live. 
Next is assigned to the next locator button in
arrangement view
Previous is assigned to the previous locator button
in arrangement view.

MIDI MAP YOUR CONTROLLER 

08 Verify that the mapped controls on your MIDI
controller correspond correctly in Ableton Live.

TEST THE MIDI MAPPINGS 

09  Exit MIDI Map Mode.
 Save your template.

SAVE THE TEMPLATE WITH MIDI MAPPING 



Recognize that the template allows for routing tracks to groups (return tracks) once,
saving time on future setups.

UNDERSTANDING TEMPLATE BENEFITS 

Use a cable to connect the interface directly to your computer or a powered USB hub.

CONNECT AUDIO INTERFACE TO COMPUTER 

Do not connect the interface to a USB extender, make sure it’s connected directly to
the computer.

AVOID USING USB EXTENDERS 

Open Preferences in Ableton Live

Go to the 'Audio' tab.

Under 'Audio Output Device', select your interface.

For Windows, use the correct driver as recommended by Ableton. Ableton
recommends ASIO4ALL.

On Mac, Core Audio is used by default.

CONFIGURE YOUR AUDIO INTERFACE IN ABLETON LIVE 

CONNECTING YOUR AUDIO
INTERFACE AND ROUTING
AUDIO IN YOUR TEMPLATE 

THE PLAYBACK METHOD™ WORKBOOK

In 'Output Config', enable all stereo and mono outputs.

Leave output names as default for flexibility.

CHANNEL CONFIGURATION 



For Apple Silicon Macs, use a buffer size of 256 or lower.

For Intel Macs, start with a buffer size of 256 samples and adjust as needed.

ADJUST BUFFER SIZE 

Route the click track to a specific output.

Separate click and cues if possible for volume control.

Don’t route global tracks to return tracks.

ROUTE GLOBAL TRACKS (CLICK AND CUES) 

Route groups/return tracks to different outputs based on needs and
       interface capability.

Save your routing settings in the template.

ROUTING TRACKS TO INTERFACE 

Connect the interface to your computer.

Select the interface in Ableton Live's Preferences.

Check that all tracks are routed correctly.

FINAL SETUP ON STAGE 

Generally, set the sample rate to 44.1 kHz. While higher sample rates in theory are
“better quality”, keep in mind that they sound exactly the same when amplified and a
band playing on top of them.

SET SAMPLE RATE 



WHAT TO DO IF YOU
NEED MORE THAN 12

AUDIO OUTPUTS

THE PLAYBACK METHOD™ WORKBOOK

Understanding Return Tracks: Return tracks are for grouping

instruments, not for direct output tracks like click, cues, or

vocals.

Return Tracks vs. Interface Outputs: Return tracks are not

equivalent to the outputs on your interface. You can route

multiple groupings to the same output.

Configuring More Than Twelve Outputs: For additional

outputs, use direct routing tracks for specific elements like

click, cues, timecode, or lead vocals.

Routing Flexibility: Return tracks offer flexibility in routing,

allowing for changes without affecting the entire setup and

having to re-route every track for every song.

Efficient Output Management: The approach allows for

managing a large number of outputs (e.g., 33) with just

twelve return tracks, by understanding their role in grouping

instruments and using direct routing tracks for

     specific elements.



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

THE PLAYBACK
METHOD™: 
PROGRAM

Learn how to program songs, step by step using the 11-step song
programming process, how to quickly program a set of songs, all with a
strong focus on efficiency, simplicity, and stability.

Learn the essentials of song and set programming for live
performance.
Learn how to optimize your Ableton Live setup for efficient song
and set programming.
Learn the step-by-step process of validating tempos, cleaning up
tracks, and adding programming elements.
Learn advanced techniques for managing tempo variations and
time signature changes in your music.
Learn how to convert and manage different audio file types for a
smoother Ableton Live experience.



PROGRAMMING SONGS:
A QUICK OVERVIEW 

Welcome to the Programming stage of The Playback Method™. In this stage, we’ll dive
into the world of programming songs and sets in Ableton. 

Our goal is to prioritize efficiency, simplicity, portability, flexibility, and stability. By
following this process, you will be able to program your songs and sets quickly, easily,
and with the ability to adapt to changes seamlessly.

Let’s start by taking a quick overview of the song programming process. 
The first step is to set up your song by opening your template and dragging in the
stems. It is crucial to validate the tempo and downbeat of your song to ensure that it
aligns perfectly with the click included in your stems. Having Live’s grid perfectly
synced with your song will allow you to navigate the song quickly and make edits on
the fly. Once the tempo and downbeat are validated and Live’s grid is perfectly in sync
with your song, it’s time to clean up your tracks. Group your stems together and
rename them for simplicity. This keeps our set clean visually, and is the first step
towards easily managing the volume of our songs.

In the next few steps, we’ll start to add our song programming elements. We’ll add a
tempo track to save our tempo with our song, and our markers track to save our song
sections. This allows for easy navigation of the song, and allows us to easily move our
song in and out of sets. We’ll also talk about adding additional song programming
elements, like Foundations for Live ( a MIDI click) and our AI cue player, and a song
name track.

One of the biggest questions I get from Playback Engineers is, “How do I manage the
volumes of my songs so they’re all consistent in my set?”. With the next step, you’ll
learn the dead-simple approach to creating a consistent level between your songs,
that doesn’t require any plugins or special skill. 

Then we’ll move into audio routing. This is perhaps the most impactful trick you’ll
learn. You’ll learn how to route audio for your songs in your set in a way that, no
matter how many outputs you’re using-your routing is always the same, AND in using
this technique, you’ll get a fader for each song so you can easily adjust the volume of
each song independently of each other. And, if you need to re-build your set, or move
songs between sets, your routing comes with it.

Finally, before moving on, it’s crucial to conduct a quality assurance (QA) check. This
allows you to review everything you have done in your song to ensure it is correct and
ready for performance. This final step, gives you the re-assurance that everything will
work-before you hit the stage, and is how you can put your virtual “seal of approval”
on your work.



Ensure you have headphones or in-ears connected to your computer for accurate
monitoring.
Check and set your audio output device in Ableton Live's preferences (Command+
comma or Control + Comma if you’re on Windows).

MONITOR SETUP

When possible, choose files that are stems/multitracks, as opposed to stereo or 
       2-track files.

Use stems with a click track whenever possible.
Opt for WAV, AIFF, or M4A formats, avoiding MP3 stems.

FILE FORMAT 

Store and work from an external SSD to manage song files efficiently.
Ensure the SSD is regularly backed up to a cloud service, and potentially another
“archive” harddrive.

USE AN EXTERNAL SOLID STATE DRIVE (SSD)

BEFORE YOU BEGIN
PREPARING FOR SONG PROGRAMMING IN ABLETON LIVE 

Organize your original song content in a designated 'Raw Stems' folder for
       easy access.

Store the raw stems file on an external hard drive (SSD)

SETUP A RAW STEMS FOLDER 

Create a separate 'Songs' folder where the formatted and finalized Ableton Live
song files will be stored. Avoid storing this on your computer’s internal hard drive
(since these files will be included in a Set), unless you need access to all songs, at
any time (that aren’t in an existing set) and have a large (greater than 1TB) 

       hard drive.
This folder should be distinct from the 'Raw Stems' folder and ideally on the SSD.
Make sure to regularly backup your songs folder to a cloud service, and potentially
another “archive” harddrive.

SETUP A SONGS FOLDER 

Find the key, tempo, and time signature of each song you're working with.
Use online tools (like Tunebat) for key and tempo detection if necessary.
Save this information in the folder name for easy reference.

DETERMINE THE KEY, TEMPO, AND TIME SIGNATURE OF YOUR SONGS 

Use the 'Add Folder' option in the bottom portion of Live's browser, to add your
'Templates' and 'Songs' folders to Ableton Live's browser for quick access.

ADD FOLDERS TO ABLETON LIVE’S BROWSER 

https://tunebat.com/Analyzer


Start by opening the template you've mapped to your MIDI controller and set up with
your audio interface. Whether this was mapped to the Playback Basic template, or a
customized template you’ve created.

OPENING YOUR TEMPLATE 

Determine the tempo, time signature, and key of the song you're working on.
Use a song key detection tool if necessary, and note down this information.

GATHERING SONG INFORMATION 

Enter the song's BPM into Ableton Live's global tempo field.
Set the time signature in Live’s Global Time Signature, if it's different from the
default 4/4.

ADJUST A GLOBAL TEMPO AND TIME SIGNATURE 

STEP 1: SONG SETUP 
11-STEP SONG PROGRAMMING PROCESS

Navigate to your raw stems in your Live’s browser.
Select all stems (click the first stem, hold Shift, then click the last stem).
Hold Command (Mac) or Control (PC) while dragging to ensure stems are placed
on separate tracks.
Drag and drop the stems into Ableton Live, below your global programming
tracks. Make sure you drag as far over to the left as possible, to have the stems
start at 1.1.1.
If you don’t have stems but a 2-track stereo file, drag the file into Ableton, below
your global programming tracks, and make sure you drag as far over to the left as
possible, to have the stems start at 1.1.1.

IMPORTING STEMS INTO ABLETON LIVE 

Locate the click track among the imported stems.
Move the click track to the top of the tracks, below the global programming tracks.
If you have a cues track, place it as the second track after the click track (and below all the
global programming tracks).

ORGANIZING TRACKS IN ABLETON LIVE 



Ensuring the tempo in Ableton Live matches the song's tempo is critical for alignment.
This will allow Live’s grid to perfectly match our song, and allow us to quickly edit, and
navigate our song easily. Incorrect tempo settings can lead to misalignment throughout
the song.

IMPORTANCE OF VALIDATING TEMPO 

Make sure you’ve entered your tempo into Ableton Live's global tempo (as done in step
1). Be aware that certain sources might provide inaccurate tempo information, which
is why we’ll validate our tempo and time signature in this step.

BEFORE BEGINNING . . . 

Zoom into the click track to see if it aligns with Live's grid.
Check different parts of the song (beginning, middle, end) for consistent alignment.

VISUAL INSPECTION OF TEMPO 

STEP 2A: VALIDATING YOUR TEMPO
11-STEP SONG PROGRAMMING PROCESS

Navigate to 'Session View' (Tab key) to access metronome settings.
Set 'Cue Out' to your preferred output to hear the metronome.
Check the “Cue Out” volume to set the level of the metronome.
Check the “Main Out” volume to make sure it’s level isn’t too loud.

ADJUSTING METRONOME SETTINGS 

Enable Ableton's metronome to compare the tempo of the stems with Live’s grid.
Listen at the beginning, middle, and end of the song to ensure the metronome and track
are in sync.
Adjust the metronome volume to be audible over the song.

LISTENING FOR TEMPO SYNCHRONIZATION

Play different sections of the song while listening to the metronome.
Listen for any discrepancies in timing between the song and metronome beats.

TESTING DIFFERENT SONG SECTIONS 



Look at the click track for a visual indication of the downbeat.
Ensure the accent (stronger or higher-pitched beat) aligns with the downbeat of Live's
grid.
Check different sections of the song for consistent alignment.
Use a fixed grid view (e.g., 1 bar) for easier inspection.

VISUAL INSPECTION FOR TIME SIGNATURE 

Turn on Ableton's metronome and listen to the entire song.
Pay attention to the song's pulse and feel for any irregularities.
Listen for any deviations where the song feels out of sync with the metronome.

LISTENING FOR TIME SIGNATURE SYNCHRONIZATION

If a time signature change is detected, add it to your Live Set.
Right click in Live’s scrub area and choose “Insert Time Signature Change” and enter your
change (eg. 4/4).
For songs with multiple time signatures, add remaining time signature changes
throughout the song..

ADJUSTING GLOBAL TIME SIGNATURE 

STEP 2B: VALIDATING YOUR TIME SIGNATURE 
11-STEP SONG PROGRAMMING PROCESS

Realize that stems may be off-grid even if the tempo is correct.
Look for visual cues, like misaligned downbeats, in the click track.

IDENTIFYING THE ISSUE 

Select all stems by clicking the first and holding Shift to select the last.
Use arrow keys to nudge stems left or right to align with the grid.
If unable to move further, extend the song's start point and then nudge.

SHIFTING STEMS TO ALIGN 

REASON #1 LIVE’S GRID DOESN’T MATCH YOUR
SONG: STEMS AREN’T ALIGNED ON THE GRID

WHY LIVE’S GRID DOESN’T MATCH YOUR SONG

For precise adjustments, hold Command (Mac) or Control (PC) to disable snap-to-grid.
Nudge stems incrementally until they align perfectly with the grid.

FINE TUNING THE ALIGNMENT 



Check the alignment at the beginning, middle, and end of the song.
Ensure the click track's accent (stronger beat) matches the grid's downbeat.

VISUAL VALIDATION 

Turn on Ableton's metronome and listen to the song.
Validate that the click track is in sync with the metronome throughout the song.
Adjust stem positions as needed based on auditory feedback.

LISTENING FOR SYNCHRONIZATION

Once the stems are perfectly aligned, recheck the entire song.
Listen to the song with the metronome to confirm perfect synchronization.

FINALIZING THE ADJUSTMENT 

Recognize that the grid misalignment is not due to stem placement but due to an
incorrect tempo setting.
Understand that even if you're confident about the tempo, Ableton Live might require a
different setting for accurate alignment.

IDENTIFYING THE ISSUE 

Focus on the click track and observe its alignment with the grid.
Click on Live’s Global Tempo.
Use the up and down arrow keys to incrementally adjust the tempo.
Look for the tempo that starts to bring the grid into closer alignment, and move more in
that direction.

INITIAL TEMPO ADJUSTMENT 

REASON #2 LIVE’S GRID DOESN’T MATCH YOUR
SONG: THE WRONG TEMPO

WHY LIVE’S GRID DOESN’T MATCH YOUR SONG

If close to the correct tempo but not perfect, consider the possibility of a decimal tempo.

Start with a middle value (e.g., 113.50) if the tempo is between two whole numbers.
Incrementally adjust in tenths (e.g., 113.40, 113.60) to find a closer match

FINE TUNING THE TEMPO (IF YOUR TEMPO IS DECIMAL) 

If still not aligned, adjust in smaller increments (e.g., in fifths or ones).
Each time you adjust the tempo, recheck the alignment at various points in the song.

NARROWING DOWN (EVEN FURTHER) TO THE CORRECT TEMPO 



After each adjustment, listen to the song with Ableton's metronome to check for
synchronization.
If needed, shift your stems back on grid after every tempo change.
Pay attention to the song's flow with the metronome to confirm the tempo is correct.

LISTENING FOR SYNCHRONIZATION

Once you find the correct tempo, recheck the entire song for consistent grid alignment.
Listen to the song with the metronome throughout to ensure perfect synchronization.

FINALIZING THE TEMPO ADJUSTMENT 

Realize that the grid matches the song at some points but not throughout, indicating tempo
fluctuations.
Confirm that this is not an issue of incorrect tempo setting but actual variations in the song's tempo.

IDENTIFYING TEMPO VARIATIONS 

REASON #3 LIVE’S GRID DOESN’T MATCH YOUR
SONG: TEMPO FLUCTUATIONS IN ABLETON LIVE 

WHY LIVE’S GRID DOESN’T MATCH YOUR SONG

Focus on the Click track included in your song files.
Ensure the Click track accurately reflects the tempo changes in your song.

PREPARING FOR ADJUSTMENT 

Select the Click track and enable 'Warp' in the audio toolbox.
Click on the first warp marker, right click and select "Warp From Here (Start at [Your
Song's BPM])." This will add warp markers throughout the click track.

WARPING THE CLICK TRACK 

Change the warp mode from 'Follow' to 'Lead' in the audio toolbox. This action will make
the click track dictate the tempo and adjust Ableton Live's grid to match your click track.

FROM FOLLOWER TO LEADER 

Observe the grid alignment with your click track throughout the song to confirm
synchronization.
If misalignments occur, manually add warp markers at the downbeats where necessary
and drag to match the grid.

VERIFYING GRID ALIGNMENT 

HOW TO MANAGE TEMPO CHANGES WITHOUT
WARPING YOUR STEMS

MANAGING TEMPO CHANGES



Use Ableton Live's metronome to test the synchronization of the click track with the
grid.
Listen to the alignment, especially at the points where tempo changes occur.

TESTING WITH METRONOME 

If needed, refine the warp markers to ensure that every beat lines up precisely with Live's
grid.
Work through the song systematically, adjusting as needed for accurate alignment.

If you  DO plan on changing your song’s tempo (warping stems) 

FINAL ADJUSTMENTS 

Warping allows you to speed up, slow down, or change the key of a song.
Downsides: Can impact CPU heavily, especially with complex warping, and may degrade
audio quality if used excessively.

INTRODUCTION TO WARPING 

WARPING TO MANAGE TEMPO VARIATIONS IN
ABLETON LIVE 

MANAGING TEMPO CHANGES

Select all stems in your Ableton Live project, ensuring the click track is the last one
selected.
If clips have different lengths, consolidate them first. Select all stems and press command
J to consolidate.

PREPARING FOR WARPING 

Enable 'Warp' for all selected tracks.
With all clips still selected and the click track in view, add warp markers at every
downbeat (start of each measure) where the tempo changes occur. Double click on the
pseudo warp markers to create a warp marker.
Adjust the markers to ensure all stems are aligned with the beat grid. While it feels
counterintuitive, add warp markers and drag the warp marker to line up with Live’s Grid.

WARPING PROCESS 

If you want to straighten the tempo: Leave the tracks warped and ensure the warp mode
is set to 'Follow'. This will leave your stems to follow the tempo of your Live Project, as
determined by your Tempo track.

STRAIGHTEN TEMPO (LOSING TEMPO CHANGES) 



To maintain tempo changes but synchronize with Live's grid: Select the click track,
change from 'Follow' to 'Lead'.

TO MAINTAIN TEMPO CHANGES (KEEP TEMPO CHANGES) 

Test the warping by listening to the metronome and observing the grid alignment.
Make further adjustments to warp markers as necessary.

TESTING & ADJUSTING 

Straightening Tempo: Simplifies the song to a constant tempo, removing fluctuations.
Maintaining Tempo Changes: Preserves the original tempo variations of the song but
aligns them with Ableton Live's grid for better synchronization and editing.

CONSIDERATIONS & CHOICES 



STEP 3A: SONG CLEAN-UP
11-STEP SONG PROGRAMMING PROCESS

Confirm the tempo and time signature are validated and aligned.
Ensure Ableton Live's grid lines up perfectly with the stems.
Position the click track and cue tracks below the global programming tracks.

BEFORE BEGINNING . . . 

Position Ableton's playhead at the beginning (1.1.1).
If needed, Insert space for the count-in (use Command + I on Mac or Control + I on PC) to
add a one or two bar count-in.
Opt for a consistent count-in length across all songs, if at all possible.

ADDING A COUNT-IN

Select each track and rename it for clear identification (Command + R or Control + R).
Use simple, recognizable names for each track. Whatever is clearest and easiest to
understand-instantly, is what you should use.
If needed, solo each track to listen to it, and understand what content that track is.

RENAMING TRACKS FOR SIMPLICITY 

Select all (non-global programming) tracks (not clips).
Group the tracks (Command + G or Control + G).
Rename the group track with the song name, key, and tempo. 

GROUPING TRACKS 

Create a new folder for the song in your song folder. By default, this should be the
formatted song (not raw stems) folder on your external drive.
Save the set with a consistent naming convention (song name, key, tempo).
Use 'Collect All and Save' to gather all assets into the Live project folder.

SAVING THE PROJECT 

If your files are in MP3 format, convert them to WAV format within Ableton before
proceeding (see checklist 3b for this process).

CONVERTING MP3 TO WAV (IF NEEDED) 



STEP 3B: CONVERTING MP3 TO WAV 
11-STEP SONG PROGRAMMING PROCESS

Ensure all steps from steps (1-3a) like adding count-ins, renaming tracks, and grouping stems
are completed. If your files are not in mp3 format, please skip this process.

BEFORE BEGINNING . . . 

Select the top non-global programming clip (not track) in your set
Hold Shift and select the bottom clip to highlight all clips/stems for your song.
Include any additional space at the start if your stems are shifted,for example to make
room for a count-in.

SELECTING THE AUDIO CLIPS 

Open Preferences (Command + Comma on Mac, Control + Comma on PC).
Under the 'Audio' tab, set the Sample Rate (44.1 kHz is standard).
Go to 'Record Warp Launch', set the File Type to 'WAV', and Bit Depth to 16.

ADJUSTING ABLETON LIVE PREFERENCES FOR CONVERSION

With all clips selected, use the shortcut Command + J (Mac) or Control + J (PC) to
consolidate.
This process will convert MP3 files to WAV format.

CONSOLIDATING AUDIO CLIPS 

Click “warp” to disable warp on your consolidated clips. All your (non-global
programming) clips should be un-warped.

DISABLING WARP 

Navigate to the desired location (within the song folder on your external drive) for
your project.
Save the set with an appropriate name, including key and tempo.
Use 'Collect All and Save' to gather all assets into the project folder.

SAVING THE PROJECT 

Verify that all samples are now in WAV format in the project folder.

FINAL STEPS 



STEP 4: SAVING YOUR TEMPO 
11-STEP SONG PROGRAMMING PROCESS

Live’s Global Tempo: While the default way to set the tempo in a Live Set, this
tempo doesn’t transfer between Ableton Live Sets. This means when you go to
program an Ableton Live Set of multiple songs, your need to re-enter your tempo
every time.

Tempo Automation: While a bit more “precise” way to set and change tempo mid-
set, using automation for tempo changes in the main track does not transfer
between sets. Again, when you go to program an Ableton Live Set of multiple
songs, you need to re-enter your tempo every time.

Tempo Track: This allows you to use an audio clip to set the tempo of your Ableton
Live Set and “write” the tempo into any Ableton Live set. This allows you to save,
and transfer tempo between sets without having to re-automate and enter your
tempo every time you program a new set.

3 WAYS TO SAVE YOUR TEMPO IN ABLETON

Navigate to your 'Playback Basic Template' (or your template of choice).
Locate the 'Tempo Track' section within the template.

FINDING YOUR TEMPO TRACK 

Identify the BPM of your song. 
Drag the corresponding BPM tempo track into the global programming tempo track of
your song.
Drag the tempo track to cover the entire length of your song.
Ensure the warp mode is enabled and set the clip to 'Lead' in the clip view.

ADDING A TEMPO TRACK TO YOUR SONG 

If your song has tempo changes, use the click track included with your file as the tempo track.
Drag the click track into the tempo track.
Ensure the click track is warped and then set the clip to 'Lead' in the clip view.
Deactivate the audio of the click track by pressing '0'.
Delete the original click track from its previous position.

HEADING SONGS WITH TEMPO CHANGES 

Save your project to ensure all tempo settings are stored. 
Your tempo settings will now transfer with the song when moved to different sets.

FINAL STEPS 



STEP 5: SAVING YOUR SONG SECTIONS 
11-STEP SONG PROGRAMMING PROCESS

Locators allow you to easily navigate between your song while playing audio and to visually
see each section of your song. Sadly, like tempo, locators don’t transfer between sets. To
work around that, we’ll use a “markers” track to save our song sections. 

We’ll use the markers track to visually identify different sections of a song (e.g., intro, verse,
chorus). With our markers track we’ll be able to facilitate easy navigation and editing within
the song and to enhance efficiency during rehearsal and live performance.

PURPOSE OF MARKERS 

Open the song in Arrangement View.
Change the grid view to fixed grid and 1 bar for easier editing.

PREPARING TO ADD MARKERS 

Unfold the “markers” global programming track.
Highlight the entire length of the song in the markers track.
Use the keyboard shortcut (Command + Shift + M on macOS or Control + Shift + M on
Windows) to create a MIDI clip that runs the entire length of the song.

CREATING A MARKERS TRACK 

Listen to the song and identify different sections. If you have a cues track, unfold the cues
track to visually see and audibly hear the start of a new song section. (Please note that
while the cues track will happen a measure before each song section, the marker will run
the length of the song section. Use the cue to let you know where a new section will be.)
Split the MIDI clip at the beginning of each new section using Command + E (macOS) or
Control + E (Windows).
Rename each split clip to label the song section (e.g., Intro, Verse, Chorus).

ADDING MARKERS TO THE TRACK 

Save the project to ensure all markers are stored.

SAVING YOUR WORK

Save your project to ensure all tempo settings are stored. 
Your tempo settings will now transfer with the song when moved to different sets.

FINAL STEPS 



STEP 6: ADDING A CLICK TRACK 
11-STEP SONG PROGRAMMING PROCESS

Subdividable: Allows for changing the rhythm (e.g., adding more 8th notes) to songs by
simply adjusting a macro.
Multi-Sound: Enables changing the click sound without altering each song individually.
Time-Efficient: Global changes affect all songs, saving time in editing. If you want to
replace the click sound of every song in your set, you change the global sample/sound
once, and you don’t have to re-program each song.

ADVANTAGES OF USING MIDI CLICK 

Ensure the song's tempo and time signature are accurate.
Confirm that Ableton Live's grid matches the song perfectly. 

If Live’s grid doesn’t perfectly match your song, Foundations for Live WILL NOT be in time with your
song. Please keep in mind that Foundations follows Live’s grid (tempo and time signature) so if
Live’s grid doesn’t match your song, Foundations won’t match your song.

BEFORE BEGINNING . . . 

Locate the 'Click' section in your playback template.
Drag and drop the appropriate MIDI clip based on the song's time signature.
Choose between clips that provide quarter notes only, quarters and eighths, or include
sixteenth notes.
Drag the MIDI clip to cover the entire length of the song.

PROCESS OF ADDING THE MIDI CLICK

Adjust the volume of different note values (e.g., 8th notes, 16th notes) as required.
Change the click sound as needed for different songs or preferences.

ADJUSTING THE CLICK 

For songs with multiple time signatures, follow the changes with appropriate MIDI clips.
Drag the MIDI clips corresponding to each time signature into the timeline at the correct
positions.

HANDLING TIME SIGNATURE CHANGES 

Save the project and use Collect All and Save after adding the MIDI click to ensure it's
included in your set and all samples you need are also included.

SAVING YOUR WORK 



STEP 7: ADDING CUES 
11-STEP SONG PROGRAMMING PROCESS

Cues, slates, guide cues act as an invisible, virtual, un-paid music director, providing guidance
on song sections. It helps musicians stay on the same page, especially during live
performances. It can also serve as a reminder for song structures and transitions.

PURPOSE OF CUE TRACKS 

Start by selecting the 'Cues' track in your playback template.
Navigate to the start of your song for the count-in.

THE PROCESS OF ADDING CUE TRACKS 

Find the count-in length you want 1 or 2 bar.
Find the time signature that matches your song. 
Drag that corresponding clip into the cues global programming track in your template.

ADDING COUNT-IN CUES 

Use your markers track as a reference for each song section.
Drag and drop the appropriate section cue (e.g., "Verse", "Chorus") into the cue track.
Optionally, you can use the counts+ cues clips to also count into each section cue 

       (e.g., "Verse 2, 3, 4").

MARKING SONG SECTIONS 

Save the project and use Collect All and Save after adding the cues to ensure it's included
in your set and all samples you need are also included.

SAVING YOUR WORK 



STEP 8: ADDING YOUR SONG NAME 
11-STEP SONG PROGRAMMING PROCESS

We can use our song name clip to make working with and navigating our song easier. It acts
as a utility similar to a marker track but for the entire song. It allows us to easily identify the
song within the set and for quick selection and reference to the entire song.

PURPOSE OF A SONG CLIP 

Navigate to your global programming “Songs” track. 
Unfold your “Songs” track.
Select the region from the end of the song to the beginning.
Use the keyboard shortcut (Command + Shift + M on macOS or Control + Shift + M on
Windows) to create a MIDI clip.

CREATING THE SONG NAME CLIP

Rename the MIDI clip with the song's title (e.g., "Enough is Enough").
Optionally, include key and tempo in the name.
Add additional notes or reminders for the band within the clip name.

NAMING AND DETAILING THE CLIP 

After creating and naming the clip, save your work to ensure the clip is included in your set.

SAVING YOUR WORK 



STEP 9: COLLECT ALL AND SAVE 
11-STEP SONG PROGRAMMING PROCESS

Collect All and Save ensures all files, including tempo tracks, cue tracks, MIDI files, and other
imported elements, are collected and saved (hence the name) into the Ableton Live Project
file for your song. 

It allows for portability of our songs, and provides peace of mind that all necessary files for
that song are gathered in one place. 

You should Collect All and Save regularly through the programming process to ensure all
samples are being added to the Live Project and after adding any additional programming
elements to your project. 

Even if you forgot at some point in the process, we’ll ensure we always Collect All and Save at
Step 9 of the Song Programming Process, so no sample will ever go missing.

WHY AND WHEN WE SHOULD USE COLLECT ALL AND SAVE 

Navigate to the File menu in Ableton Live.

Select 'Collect All and Save'.

Confirm the action by clicking 'OK' on the prompt.

HOW TO PERFORM ‘COLLECT ALL AND SAVE’ 



STEP 10: AUDIO ROUTING AND BASIC LEVEL CHECK
11-STEP SONG PROGRAMMING PROCESS

If you follow the playback method process of managing audio, you’ll be able to route your
audio once to your interface, and never have to re-route it again. You’ll be able to quickly
change the number of outputs on your interface, and never have to re-route your audio. 

In addition, if you follow the new updates shared in this updated lesson, you’ll be able to
quickly balance the level of all songs-without any additional plugins or fancy methods, and
incase any band members are there for rehearsal, or someone can’t make a performance,
you can click one button and you’ll have their part available. 

THE REVOLUTIONARY PROCESS OF AUDIO ROUTING & BASIC LEVEL CHECK

Don’t delete tracks for instruments you have live (e.g., drums, bass). We’ll keep them
available for quick reference, to be able to practice and rehearse, and to use live in a
worst-case scenario.
We’ll mute these tracks instead, to always have access to them.
Mute instruments globally rather than at the song level for efficiency. This doesn’t need
to be done at the song level, but at the template level instead. This allows us to un-mute
our bass globally across all songs.

BEFORE BEGINNING . . . 

Unfold your song’s group track.
Identify and mute click and cue tracks within the group. Please note, we’re not muting the
click and cues in global programming tracks, but the click and cues track included with
our file-if they exist.

MUTING THE ORIGINAL CLICK & CUES 

Establish an audio standard for levels (e.g., -4 dB).
Press play to listen to your song.
Adjust the level of your group track to match your standard, ensuring consistency across
songs. If you need to adjust individual tracks, unfold your group track and adjust those
levels as needed.
Skip to the loudest part of the song and skip around your song, for a basic level check.

BASIC LEVEL CHECK 



Use session view to manage return tracks.
If needed, enable sends and return tracks in view settings, so you can view them while
working.
Turn the send knob to 100% that matches the return track you want to route your audio
to.
Assign instruments to specific return tracks based on their type.
If needed, solo tracks to determine their appropriate return track assignment.

ROUTING AUDIO TRACKS TO RETURN TRACKS 

Set the song’s group track ‘Audio To’ section to ‘Sends Only’. This enables separation and
specific output routing of parts.

GROUP TRACK ROUTING 

Make global changes at the template level rather than song level. This ensures all
songs inherit these changes, saving time in audio routing.

TEMPLATE-LEVEL CHANGES FOR EFFICIENCY 

Use the group track fader to adjust the overall level of the song.

ADJUSTING OVERALL SONG LEVEL 

After routing and level adjustments, perform a final check.
Save the changes to solidify the setup.

FINAL CHECKS AND SAVES 



STEP 11: QA PROCESS 
11-STEP SONG PROGRAMMING PROCESS

The Quality Assurance (QA) process is crucial for ensuring the quality of our song before we
use it in practice, rehearsal, and live performance. Skipping this step can lead to errors, and
these efforts reflect on you. Take the time to check everything now, so that things go
smoother later.

At the most basic level, we're going to compare our song with the global programming tracks
in our template and verify that the formatted song matches the template so we can
seamlessly program our Set.

Open the playback basic template and review all tracks. Compare the formatting and
track order of your template to your programmed song.
Ensure song tracks, cues, and markers are correctly placed and labeled.

TRACK VERIFICATION 

Inspect the grouped song; use the 'Tab' key for detailed view.
Check audio settings (e.g., audio to sends only)

GROUPED SONG REVIEW 

Confirm that the song meets your standards and is ready for performance. This is
putting your 'seal of approval' on the song, symbolizing it's ready to go.

FINAL APPROVAL

Confirm the routing of all tracks.
Verify that click and cue tracks are properly configured and routed.
Perform another basic level check to ensure audio balance.

ROUTING AND LEVEL CHECKS 

Use 'Collect All and Save' again to make sure all samples are included in your Live Project
Folder.

FINAL SAVING PROCESS 

Play the entire song and listen carefully.
Check guide cues, cue tracks, and song sections for accuracy.
Ensure the click track is in time and stems are synchronized.
Look for any audio discrepancies or timing issues.

PLAYBACK AND ERROR IDENTIFICATION 



STEPS TO PROGRAM AN
ENTIRE ABLETON LIVE SET

THE PLAYBACK METHOD™ WORKBOOK

Ensure proper fi le management and backups.

Save a copy of the set in a designated folder, possibly backed

up on different devices including a thumb drive, external

SSD, and cloud storage.

FILE MANAGEMENT

Open the template used for individual song programming.

Save the set with a thoughtful naming convention that might

include venue, city, date, or tour revision.

OPEN AND SAVE TEMPLATE 

Save your set in a specific folder on your internal hard drive.

Create backups on a thumb drive, external solid-state drive,

and possibly the cloud.

FILE MANAGEMENT AND BACKUP

Open the template you'll  use for building your set.

Save a copy of the set (File > Save Live Set As).

Choose an appropriate naming convention for the set.

OPENING AND SAVING YOUR TEMPLATE 

Do a 'File Collect All and Save' to ensure all necessary fi les

are included.

PREPARING THE TEMPLATE 



Add your programmed songs folder to Ableton’s browser for

easy access.

Add the time signature of your first song to Live’s Global Time

Signature.

Re-name your first locator with your song name, and optionally

the order of the song in the set, ie. 1-SEPTEMBER.

Start with your first song, adding it below the bottom-most

global programming track in your set. 

Cut and paste all clips from the global programming tracks that

came with the song into the appropriate place in your set.

Delete the global programming tracks that came with the song.

Rename locators and adjust time signatures as needed for 

     each song.

ADDING SONGS TO YOUR SET 

Ensure all tracks and stems align correctly.

Adjust the start and end of stems as needed to match the

song's structure.

ORGANIZING AND ALIGNING TRACKS 

Follow the same process for each additional song: add the

song, align tracks, adjust time signatures, and delete

redundant tracks.

Make sure you add new songs on the downbeat of one.

Rename locators and ensure each song starts on a downbeat.

REPEATING THE PROCESS FOR EACH SONG 

Once all songs are added, go through each to ensure proper

alignment and organization.

Make any necessary adjustments to the song order or

placement.

FINALIZING SONG PLACEMENT 



Assign a unique color to each song for easy visual identification.

Use key mapping (Command K) to highlight group tracks for each

song so that when you select a song locator, that songs group

track is also highlighted.

COLOR CODING AND KEY MAPPING (OPTIONAL)

Add a locator for each song section to facil itate navigation

during live performances.

This can be done manually by clicking the song section and

pressing “l” (using the pre mapped key in your template),

pressing the add locator “set” button, or using tools l ike

Ableset.

ADDING LOCATORS FOR SONG SECTIONS (OPTIONAL)

Perform a final review of the entire set.

Save the set (File > Save Live Set).

Use 'Collect All and Save' again to ensure all components are

included in the set.

FINAL CHECKS AND SAVING 

Right-click on Ableton Live's global tempo.

Choose 'Unfollow Tempo Automation.'

This step is crucial, especially if working with unwarp stems

to avoid issues when editing.

Note: The master tempo lane will  stil l  display all the tempo

changes.

By doing this, the set will  follow the tempo information

written in the track.

FINALIZING TEMPO SETTINGS (CRUCIAL IF NOT
WARPING STEMS) 



TIPS FOR EXPORTING
YOUR OWN STEMS 

THE PLAYBACK METHOD™ WORKBOOK

If  you’re wanting to use your own songs live, here’s a few

considerations I have.

Separation of Instruments: Keep individual instruments

separated in stems, without combining them.

Consideration of Live Elements: Only include parts in

stems that won’t be played live.

Technical Aspects: Export stems as 44.1kHz, 16-bit WAV

files, include a click track matching the song, and if

possible, a cues track for easier navigation during

performances.

This approach ensures greater control during live shows,

allowing for adjustments like muting certain instruments 

     if  needed.



THE TRUTH ABOUT
WARPING YOUR STEMS: TO
WARP OR NOT TO WARP?

THE PLAYBACK METHOD™ WORKBOOK

When deciding whether to warp audio stems in Ableton Live,

it 's important to balance flexibil ity with technical l imitations.

Here's a concise guide to help you make an informed decision:

When changing key and tempo often.

For sets with fewer than 10-12 songs.

CONSIDER WARPING: 

For large sets with many songs.

To maximize CPU efficiency.

AVOID WARPING: 

Export stems as WAV files (44.1K, 16-bit).

Include a click track and cues track.

Consolidate clips after editing.

Use 'Beats' warp mode for lower CPU usage.

Disable 'Follow Tempo Automation' for non-warped tracks.

TECHNICAL TIPS: 

Remember, warping doesn't inherently degrade sound quality,

but it does impact CPU usage. The decision to warp should be

based on your specific needs and the capabilities of your

computer. Warping offers flexibil ity but can be resource-

intensive, so weigh your options carefully before proceeding.



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

Before we rehearse, let's discuss how to best prepare our band for
practice, and how to make the most of Ableton Live in Rehearsal.

Learn the foundations of song editing and rehearsal preparation in
Ableton Live.
Learn how to create effective rehearsal tracks and set up play-along
tracks.
Learn advanced editing techniques: clip editing, applying fades, and
tempo adjustments.
Gain practical insights into making precise edits and enhancing song
arrangements.
Master the art of clean and organized track management for
efficient rehearsals.

THE PLAYBACK
METHOD™: 
PRACTICE



PRACTICE VS REHEARSAL 
THE PLAYBACK METHOD™ WORKBOOK

Practice: An individual activity where musicians learn their parts.

Rehearsal: A group activity where the band comes together to integrate their parts
and work on the overall performance.

This simple distinction is key to setting the right expectations for your band. Practice is
where individual band members learn their parts separately, while rehearsal is where
everyone comes together to work to create a cohesive sound. Each band member must
take responsibility for practicing their parts individually to ensure a successful rehearsal
together.

There are a few helpful things we can do as Playback Engineers (even if we’re serving as
the music director) to help our band practice well.

GENERAL REHEARSAL TIPS

Don't Over-Practice One Part: Balance the need to perfect a part with keeping the
energy and flow of the rehearsal.

Provide Necessary Resources: Ensure everyone has access to the parts, tracks, and
information they need for effective individual practice.

Play Through Entire Songs: Ensure the band can play through each song
completely at least once before performing live to build confidence and cohesion.



TIPS FOR EFFICIENT
REHEARSALS

THE PLAYBACK METHOD™ WORKBOOK

1 Create Rehearsal Tracks: Provide full arrangement tracks and play-along tracks for
band members to practice individually.

2 Elevate or Solo Parts: Help musicians focus on their specific parts by elevating them
in the rehearsal track.

3 Share Key and Tempo Information: Ensure everyone practices with the correct key
and tempo.

4 Consistent Charts: If using charts, ensure they match the arrangement and are
accurate.

5 Unmute Missing Parts:If a band member is absent, use the muted track for their
instrument in Ableton Live for rehearsals.

6 Work with Individual Song Files: Initially rehearse with individual Ableton files for
easy editing.

7 Locate Specific Sections Quickly: Use shortcuts to start playback from specific song
sections, avoiding the need to start from the beginning each time.

8 Solo Parts as Needed: Utilize the solo feature to focus on specific instrument parts
during rehearsals.



HOW TO PREP YOUR BAND
FOR REHEARSAL AND HELP
THEM LEARN THEIR PARTS 

THE PLAYBACK METHOD™ WORKBOOK

Creating rehearsal tracks for your band members offers several benefits. Firstly,
it allows them to learn their parts at their own pace, reducing the time spent
during rehearsals on individual practice. Secondly, it promotes consistency and
accuracy in performances, as everyone is rehearsing with the same reference
tracks. Additionally, rehearsal tracks facil itate the integration of new band
members or substitutes by providing them with the necessary materials to learn
their parts quickly.

TYPES OF REHEARSAL TRACKS TO CREATE 

1
Export the full arrangement of the song as it is in Ableton Live, including any edits
made to the arrangement.

2

FULL SONG RENDER 

Export the full song along with the click track and cue tracks. This helps band
members practice with the same click and cues they'll hear during the actual
performance.

FULL SONG WITH CLICK AND CUES

3
Export each band member's specific parts. This is particularly useful for them to
focus on their individual part within the song.

INDIVIDUAL PARTS EXPORT 

4
A comprehensive mix that includes the individual part elevated, along with the full
song, click, and cues. This is ideal for practicing in context with the entire
arrangement.

INDIVIDUAL PARTS WITH FULL SONG, CLICK, & CUES 

5
Export the full song, click and cues, but minus their part, so they can rehearse
anywhere-before rehearsal.

PLAY-ALONG TRACKS



HOW TO PREP YOUR BAND
FOR REHEARSAL AND HELP
THEM LEARN THEIR PARTS 

THE PLAYBACK METHOD™ WORKBOOK
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HOW TO PREP YOUR BAND
FOR REHEARSAL AND HELP
THEM LEARN THEIR PARTS 

THE PLAYBACK METHOD™ WORKBOOK

Creating rehearsal tracks for your band members offers several benefits. Firstly,
it allows them to learn their parts at their own pace, reducing the time spent
during rehearsals on individual practice. Secondly, it promotes consistency and
accuracy in performances, as everyone is rehearsing with the same reference
tracks. Additionally, rehearsal tracks facil itate the integration of new band
members or substitutes by providing them with the necessary materials to learn
their parts quickly.

TYPES OF REHEARSAL TRACKS TO CREATE 

1
Export the full arrangement of the song as it is in Ableton Live, including any edits
made to the arrangement.

2

FULL SONG RENDER 

Export the full song along with the click track and cue tracks. This helps band
members practice with the same click and cues they'll hear during the actual
performance.

FULL SONG WITH CLICK AND CUES

3
Export each band member's specific parts. This is particularly useful for them to
focus on their individual part within the song.

INDIVIDUAL PARTS EXPORT 

4
A comprehensive mix that includes the individual part elevated, along with the full
song, click, and cues. This is ideal for practicing in context with the entire
arrangement.

INDIVIDUAL PARTS WITH FULL SONG, CLICK, & CUES 

5
Export the full song, click and cues, but minus their part, so they can rehearse
anywhere-before rehearsal.

PLAY-ALONG TRACKS



EXPORTING PROCESS IN ABLETON LIVE 

1
Depending on what you are exporting (full song, individual parts, etc.), select
the tracks in Ableton Live.

2

SELECT THE APPROPRIATE TRACKS 

Ensure the tracks are routed correctly for the export. For example, route
click and cue tracks to the main output when including them in the mix.

ADJUST OUTPUT ROUTING 

3
Use the 'Render Track' option in Ableton Live to export the tracks. Choose
'MP3' for a convenient format and ensure the correct tracks are selected for
rendering.

RENDER SETTINGS 

4
Name the files clearly and logically, so band members can easily identify
what each file contains. Organize them in a folder for easy access and
consider uploading to a cloud service as a “band hub”.

FILING NAME AND ORGANIZATION

5
Discuss with your band which types of tracks will be most helpful for them.
This ensures you're providing the most useful resources for their individual
practice.

COMMUNICATION WITH BAND MEMBERS 



WHY PLAY-ALONG TRACKS?
THE PLAYBACK METHOD™ WORKBOOK

Creating play along tracks in Ableton Live is an effective way to prepare band
members for rehearsals. It allows them to practice their parts in the context of
the full arrangement, minus their specific instrument, providing a more immersive
and focused practice experience. This method also ensures that all members are
familiar with the song structure and their role within it,  leading to more
productive and efficient rehearsals.

By following these steps, you can tailor the play along tracks to the needs of each
band member, enhancing their ability to learn and perfect their parts
independently. This approach not only saves time during group rehearsals but
also contributes significantly to the overall cohesiveness and quality of the band's
performance.

CREATING PLAY ALONG TRACKS IN ABLETON LIVE:

Open your song file in Ableton Live.
Set the song track to 'Sends Only'.
Adjust the Click and Cue tracks to route to the main output.

Select all return tracks.
Route them to the main output.

For creating a bass play along track, mute the bass part. This principle applies to
any instrument you're creating the track for.

Boost the click track level for clarity.
Adjust the levels of other parts as needed. For example, if the bass player wants
to rehearse with the drums more prominent, boost the drums in their mix.

INITIAL SETUP:

ROUTING RETURN TRACKS: 

MUTING THE PART FOR PLAY ALONG:

ADJUSTING LEVELS:



EXPORTING PLAY ALONG TRACKS:
THE PLAYBACK METHOD™ WORKBOOK

Select the full song track to ensure the entire arrangement is included in the export.

INITIAL SETUP:
Open the 'Export Audio/Video' window (Command + Shift + R or Control + Shift + R
on PC).
Set 'Render Track' to 'Main'.
Choose MP3 encoding for a convenient file format.
Name the file appropriately, like 'Bass Play Along' or 'Full Song No Bass', and export.

THE BURN IN: YOUR SECRET WEAPON TO
ENSURE EVERYTHING WORKS PERFECTLY

The concept of a "burn-in scenario" is a critical practice for playback engineers
and musicians, which involves thoroughly testing and familiarizing yourself with
your entire setup in a controlled environment before a rehearsal or l ive
performance. This process ensures that all equipment functions correctly and that
you're comfortable with the setup. Here's how to effectively implement a burn-in
scenario.

Recreate Your Performance Setup: Set up all your gear as you would for a
live performance. This includes computers, MIDI controllers, audio interfaces,
and any instruments you use.

Test in Private: Choose a space where you can work undisturbed for a few
hours. The more private and quiet, the better, as this will allow you to focus on
the task at hand.

Allocate Sufficient Time: Especially when you're new to playback engineering
or have added new gear to your setup, allocate several hours or even days for
the burn-in process. This time investment will decrease as you gain
experience.

Run Through Your Set: Perform your entire set as if it were a live show. Pay
attention to every detail, from song transitions to MIDI controller response.



Check for Physical Comfort: If you use instruments or controllers (like a MIDI
foot controller), ensure they're positioned as they would be during a live
performance. Comfort with your physical setup is as crucial as technical
proficiency.

Troubleshoot in Real-Time: Identify and resolve any technical issues.
Whether it's a cable malfunction or a software glitch, addressing these issues
in a burn-in scenario prevents unexpected problems during actual
performances.

Rehearse Multiple Times: Go through your entire set multiple times. This
repetition helps solidify your familiarity with the setup and boosts your
confidence.

Simulate Live Conditions: If possible, include elements like lighting and
sound systems in your burn-in scenario. This approach gives you a more
realistic feel of the live environment.

Document and Adjust: Take notes on any challenges or adjustments you
need to make. This documentation will be invaluable for future reference and
improvement.

Mindful Packing and Setup: After the burn-in, when packing your gear, be
mindful of how everything fits together. This awareness will make setting up
for the actual performance more efficient.

Practice Regularly: Even as you become more experienced, regular practice
remains crucial. However, the focus may shift more towards refining
performance rather than basic setup familiarity.

Involve the Band: If you're part of a band, involve them in the later stages of
the burn-in process. This collaboration ensures everyone is on the same page
and comfortable with the technical setup.



NAVIGATING YOUR SET WITH
EASE DURING REHEARSAL

THE PLAYBACK METHOD™ WORKBOOK

During rehearsal, efficiently navigating and editing your Ableton Live set is crucial to keep
things running smoothly. Here are some key strategies for managing your set during
rehearsals:

Starting Specific Songs: Utilize the locators in your set to quickly start playing from a specific
song. Clicking on the song title in the session view or pressing the corresponding number key
on your keyboard will start the song.

Skipping Songs: To skip a song, use the number keys to jump to the next song’s locator, then
press spacebar to start playing.

Restarting Sections: If you need to repeat a particular section during rehearsal, click on the
desired section and press 'C' (which is key-mapped to the record button for a one-bar count-
in). This ensures everyone starts together at the right tempo.

Adjusting for Missing Band Members: If a musician is absent, you can enable their
instrument's track in the set to fill the gap. For example, unmuting the drum or bass track will
play these parts through the playback system.

Soloing Parts for Practice: To help band members focus on their parts, use the solo function
on their instrument's track. This isolates their part, allowing them to hear it clearly over the
rest of the mix.

Making In-Rehearsal Edits: For quick edits during rehearsal, such as adjusting levels or
muting/unmuting tracks, use the mixer in Ableton Live. You can also make more significant
changes if necessary, but remember to save these changes for future rehearsals.

Using a Count-In for Start Points: Utilize the count-in feature for rehearsing specific sections.
This helps in synchronizing the start, especially in complex parts of the song.

Quick Navigation with Key Mappings: Make use of key mappings for fast navigation during
rehearsal. Map keys to functions like play, stop, record, and count-in for quick access.

Checking Levels and Mixes: Regularly check and adjust the levels and mixes to ensure that
every element of the set is audible and balanced.

Saving Changes: Always remember to save any changes you make during the rehearsal to
avoid losing them.



MASTERING QUICK EDITS TO KEEP
REHEARSAL RUNNING SMOOTHLY
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In rehearsal, being able to swiftly make edits in Ableton Live is a key skil l  that can greatly enhance
the efficiency and effectiveness of the session. Here are some of the common edits and maneuvers
you might need to perform:

Doubling Intros or Other Sections: Use the Command + Shift + D shortcut to duplicate
sections like intros. Remember to adjust or deactivate cue tracks if necessary to match the new
arrangement.

Inserting New Cues: Adding new cues can be done by simply dropping them into the timeline
where needed.

Applying Crossfades: To blend two sections smoothly, select the areas where you want the
crossfade and use Command + Option + F.

Volume Adjustments for Individual Songs or Parts: If a song or specific part like drums is
too loud, adjust the volume directly in the mixer. Group tracks can be helpful for making these
adjustments efficiently.

Soloing Parts for Clarity: If a band member needs to focus on a particular part, use the solo
function on their instrument's track.

Warping for Tempo and Key Changes: If there's a need to change the tempo or key of a
song, enable warping on the tracks, adjust the tempo and key, and then consolidate the tracks
to 'print' these changes. Remember to disable warping afterward to save CPU resources,
especially for large sets.

Handling Edits in Rehearsal: Be prepared to make quick edits based on feedback during
rehearsal. This includes adjusting arrangements, volumes, and even song keys or tempos.

Saving and Extracting Edits: After making edits during a rehearsal, ensure to save these
changes. If these edits need to be applied to individual songs outside the set, use the
extraction process to update the individual song files.



TRANSFORMING TRACKS ON THE FLY:
THE TOOLS NEEDED FOR QUICK EDITS
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Here’s some of the powerful tools and techniques available in Ableton Live for editing
songs quickly-particularly in a rehearsal:

Edit Time Commands :  Remember keyboard shortcuts for editing time (found in the
Edit menu). These commands, l ike cut time (Command + Shift + X), are essential for
efficient editing.

Editing Clips :  You can adjust the start and end points of clips, split clips, duplicate,
and delete. Use shortcuts l ike Command + D for duplicating and Command + X for
cutting. Deactivating clips (using '0') is also a useful feature.

Applying Fades and Crossfades :  Use fades to smoothly transition between parts of a
song. You can apply fades in and out on individual clips and create crossfades
between sections for seamless transitions.

Editing Cues :  Adjusting cue points is crucial, especially if you have changed the song
structure. Ensure your cues match the new arrangement for clarity during playback.

Changing Key or Tempo with Warping:  Warping allows you to change the key and
tempo of your tracks. Remember to select the appropriate warp mode (like Complex
Pro) for best results, especially when changing pitch.

Song Programming Consolidation: After making edits, consolidate your programming
clips to ensure they are easy to manage and use. This step involves combining
multiple smaller clips into one larger clip for 
each track.

Consolidating Stems:  If you've made significant changes, consider consolidating the
stems. This process essentially 'prints' your edits into the audio files, ensuring they
remain consistent.



Saving and Managing Edits :  Save your edited version as a new project within the
song folder. This keeps your original and edited versions separate but organized.
Always use the "Collect All and Save" feature in Ableton Live to ensure all necessary
files are included in your project.

By mastering these editing techniques in Ableton Live, you can transform and tailor
your music productions to fit specific needs or creative visions. These tools provide
the flexibility to make quick changes during rehearsals or to experiment with different
arrangements and sounds. Whether you're a producer, music director, or performing
artist, these skills will  enhance your ability to work effectively with music tracks in
Ableton Live. Remember, practice and experimentation are key to becoming proficient
with these tools and applying them creatively in your music projects.

Keyboard Shortcut Action in Ableton Live

Command + Shift + X (Mac) / Ctrl + Shift + X (Windows) Cut Time

Command + Shift + V (Mac) / Ctrl + Shift + V (Windows) Paste Time

Command + D (Mac) / Ctrl + D (Windows) Duplicate

Command + X (Mac) / Ctrl + X (Windows) Cut

Command + V (Mac) / Ctrl + V (Windows) Paste

Delete Delete Clips

0 (Zero) Deactivate Clips

Command + Option + F (Mac) / Ctrl + Alt + F (Windows) Apply Fades/Crossfades

Command + J (Mac) / Ctrl + J (Windows) Consolidate Clips

Spacebar Start/Stop Playback

c Count-in for Playback

TRANSFORMING TRACKS ON THE FLY:
THE TOOLS NEEDED FOR QUICK EDITS

THE PLAYBACK METHOD™ WORKBOOK



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

THE PLAYBACK
METHOD™: 

PERFORM

Now it's time to step on-stage.

Learn how to transform sound checks from chaotic to blissful, tailor
and save unique song arrangements, and efficiently reorder setlists on
the fly.

Learn the skills needed for a flawless performance, so you can stay
focused on the music-and having fun.



OPTIMIZING YOUR
COMPUTER FOR THE STAGE

Disable iCloud Optimized Mac Storage: If you're using iCloud Drive on a
Mac, ensure that the "Optimized Mac Storage" feature is turned off to
prevent files from being automatically moved to the cloud.

Use “Local” Files Only: All necessary files for the show should be stored
locally on your device, not just in cloud storage like Dropbox.

Turn On 'Do Not Disturb': Activate 'Do Not Disturb' on your Mac to
prevent distractions from messages and calls.

Disable Sound Effects: Turn off sound effects and change their output to
prevent them from being broadcast through your main audio output.

Energy Saver Settings: Turn off all energy-saving features like sleep mode,
hard disk sleep, etc., to ensure continuous operation.

Screen Saver Settings: Set the screen saver to 'never start' and adjust
display turn-off settings to ensure your screen stays active.

Hot Corners: Disable 'Hot Corners' to prevent accidental activation of
commands by mouse movement.

Disable Bluetooth and Wifi: Turn off Bluetooth and Wifi to prevent
interference and unauthorized connections (like Airdrop).

Close Unnecessary Programs: Ensure that only Ableton Live is running
during the performance. Close all other applications.

Turn Off Syncing Services: Disable any automatic backup or file syncing
services, like Backblaze, that may interfere with the performance.

Plugged-In Power: Always make sure your laptop or device is plugged into
a power source to avoid running out of battery during the performance.



SOUND CHECK CHAOS TO
SOUND CHECK BLISS: 

PERFORMING A LINE CHECK
A line check is a crucial step in the process that ensures the accuracy and consistency of
your audio setup. Conducting a thorough line check can significantly improve the
efficiency of sound checks and rehearsals, leading to a smoother performance overall.
It ensures all technical aspects are correctly set up and functioning before the
performance begins.

A line check is a process to verify that each input corresponds to the right channel
on the soundboard. This involves checking each microphone, instrument, in-ear
pack, and other inputs to ensure they are correctly connected and functioning as
intended.
Implementing a Line Check for Playback: I suggest using the Line Check
Template included with this lesson. This will give you all the tools you need to
properly line check your playback system.
Adding the Line Check Template to Your Set: Drag the appropriate line check file
(based on the number of outputs you use) into your Ableton set. I demonstrates
this with an example of a 12-output setup.
Using Test Tones and Samples: The template includes options like white noise and
a 1 kHz test tone, which provide a consistent level for checking each output. These
tones can help identify any issues with levels or faulty cables.
Checking Each Output Individually: You can either run all line check samples
simultaneously and solo/unmute channels accordingly or stagger them to play
sequentially. This helps ensure that each output is correctly labeled and
functioning.
Customizing the Line Check Process: Depending on your setup, you might want
to create your own samples or modify the existing ones in the template.
Organizing and Safeguarding the Line Check in Your Set: It’s important to place
the line check at a point in your set where it won’t be triggered accidentally.
Consider grouping the line check tracks and moving them to the end of the set for
this purpose.



MASTERING PLAYBACK ON
STAGE: TIPS & TRICKS FOR A
FLAWLESS PERFORMANCE

The performance stage is where everything matters. As a playback engineer, this is the
moment we’ve been working towards. The countless hours of preparation and effort
we’ve put in up to this point allow us to focus on the performance itself. 

Because we’ve put in all the work, this step in the process is the easiest.

By maximizing your screen real estate, using follow mode, and mastering the art of
transitioning between songs, we can ensure a seamless and successful performance.

Optimizing Screen Real Estate:

Maximize the screen space by closing unnecessary views in Ableton Live, like the
browser, info view, clip view, arrangement track controls, and return tracks.

Stay in Arrangement View for an overview of the set and individual songs.

Zoom in on specific songs by click on the song title clip and typing 'Z' for detail and
use 'X' to zoom out for a broader view.

Enable Follow Mode to keep the screen moving in real time with the playback.

Starting and Transitioning Between Songs:

Use a MIDI controller with mapped buttons for Play, Stop, Previous, and Next.

Double-click Stop to go to the beginning of the set.
Use the Play button to start songs and the Next button to skip to the next song.
You can let songs roll into each other or stop between songs, depending on the
performance needs.
Optionally, use keyboard shortcuts to select and start specific songs. For example,
press 1 to select song one, and spacebar to start the song.



Looping Sections During Performance:
In cases where you need to loop a section (like an intro), use the Previous
Locator button on your MIDI controller in the last measure of the section.
Ableton's global quantization (set to 1 bar) ensures that actions like looping
happen at the correct musical time.
Be mindful of cues and communicate with the band during these moments

Handling Unexpected Situations:
In case something goes wrong, you can solo the click track or cues to keep the
song going.
Use the Previous Locator button to jump back to the correct section.
Advanced techniques can help fade out and fade back in, or realign the beat if
the band and Ableton fall out of sync.

General On-Stage Strategy:
Keep the approach simple and flexible, allowing for real-time adjustments.
The preparation done beforehand in Ableton sets the stage for a smooth
performance.
Consider adding a button for soloing the click track or managing faders in case
of emergencies.



Throughout the course, we’ve stressed the importance of maintaining a separate songs and
sets folder. This is easy to do if you’re programming songs and sets separately. But what do you
do if in the moment, you’ve created a unique arrangement of a song within your set? How do
you “extract” that new arrangement from your full set? 

Here are the key steps:
Save the Set with the Edited Song: Start by saving the entire set that contains the edited
song. Choose a specific name that reflects the edit (e.g., "Imagination - Double Intro") to
make it easily identifiable.
Locate and Isolate the Edited Song: Open the set and find the song you have edited. You
will isolate this song by removing other elements from the set. 
Delete All Other Songs: Select and delete all songs and elements to the left and right of the
edited song. Use Delete Time (command shift delete) to remove these tracks, ensuring that
you are only left with the edited song.
Consolidate the Edited Song: If you have made any changes to the arrangement of the
song (like duplicating sections, cutting parts, etc.), you should consolidate these changes.
Select all parts of the song and use ( command J) to consolidate them into a single,
continuous clip.
Rename and Clean Up Song: Ensure that all cues and markers are correctly labeled and
match the edited arrangement.
Collect All and Save: Once you have your edited song isolated and consolidated, go to File
> Collect All and Save. This step is crucial as it gathers all the necessary files and samples
related to the edited song into one folder, making the file self-contained and portable.
Check the Saved Folder: Locate the folder where you saved the edited song on your
computer. It should contain all the necessary files and samples, making it easy to import or
use in different sets or performances.

By following these steps, you can efficiently extract and save any specific song edits from a
larger Ableton Live set. This process allows you to maintain an organized library of song
versions and arrangements, ready to be used in various performance contexts.

EXTRACTING & SAVING
CUSTOM ARRANGEMENTS



THE QUICK & EASY METHOD TO
REORDER SONGS ON STAGE 

The only thing that doesn’t change when working with artists, is the fact that everything will
change! One of the most common requests is to re-order songs in your set, after you’ve already
programmed it. Here’s a few quick ways to re-order songs

Quick Manual Reordering:

If the songs don't flow into each other, simply change the order of triggering the songs using the MIDI
controller or keyboard shortcuts. 

For instance, if you need to swap the second and third songs, finish the first song, then
select and play the third song instead of the second.
This method doesn't require changing the actual arrangement in Ableton Live. This is the
easiest and simplest way to to re-order songs.

Reassigning Keyboard Shortcuts:

If you have a little more time (a few minutes before the show), you can reassign the keyboard shortcuts 
for each song.

Use Command + K to open key mapping mode in Ableton Live.
Reassign the locators for each song according to the new order (e.g., change the locator for
the third song to 2, and the second song to 3).
Rename the locators for clarity. If you changed locator 3 to 2, rename it to 2-SONG NAME,
so that it’s clear which song is which.

Actual Reordering in the Set:

For a more thorough reordering with some time beforehand (around ten minutes before the set), you
can rearrange the songs in the set itself.

Use Command + Shift + X to cut time (the song) and Command + Shift + V to paste it in the
new position. You can click anywhere in the timeline to choose that time and use the paste
time command to split the songs and paste the clip in.
Readjust any stems that may have moved during the process and ensure the tempo is
correctly set (using Lead and Unfollow Tempo Automation).
Re-add any locators that were lost in the process and remap them using keyboard
shortcuts.
Swap the stems around for visual clarity and remap the song shortcuts.

These manual methods in Ableton Live are handy when you need to make a few small changes, but if
you’re planning on doing this often, you need to consider a setlist management solution. We’ll cover
these in-depth in The Advanced Playback Method.



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

THE PLAYBACK
METHOD™: 

OPTIMIZE

Imagine if you were able to know the true “limits” of your computer
before you step on stage. 

In this stage you’ll learn: 
What the CPU Limit of your setup is.
How many tracks your songs can have.
How many songs you can have in one set.
What the CPU usage of all your MIDI devices is.



OPTIMIZING YOUR COMPUTER
FOR LIVE PERFORMANCE

THE PLAYBACK METHOD™ WORKBOOK

Discover the CPU limit of your computer and optimize for latency or CPU usage.
Learn how to use the CPU usage simulator to find the highest CPU level before
audio issues arise. Learn how to adjust your settings for optimal performance
and low latency. Whether you’re a l ive looping artist or focused on processing,
find the right balance for your setup. 

WHAT’S OUR CPU LIMIT

FINDING YOUR CPU LIMIT PROCESS 

1
Connect the audio interface that you’ll use and connect headphones so you can
monitor audio through your interface. 

2

CONNECT AUDIO INTERFACE & HEADPHONES 

Close all other apps on your computer, so that only Ableton Live is open. 

CLOSE ALL OTHER APPS

3
Start by setting the sample rate. I suggest 44.1 kHz. If you’re processing audio in
realtime (live looping or virtual keys), choose the highest sample rate for the lowest
latency.

CHOOSE SAMPLE RATE

4
For Apple silicon Macs, buffer size can't exceed 256. Start with the lowest possible
buffer size for lower latency, then increase if necessary. 

CHOOSE BUFFER SIZE

5
Set the simulator to 80% and listen for audio issues like clicks, pops, or dropouts.

USE CPU USAGE SIMULATOR 

6
If experiencing audio issues, either lower the CPU limit to optimize for low latency
or increase the buffer size to optimize for CPU usage.

ADJUST CPU LIMIT OR BUFFER SIZE

7
Continuously test the setup by adjusting buffer size and sample rate to find an
optimal balance between CPU usage and acceptable latency.

ADJUST CPU LIMIT OR BUFFER SIZE



CPU LIMIT DATA 
THE PLAYBACK METHOD™ WORKBOOK

SAMPLE RATE 

BUFFER SIZE

TOTAL LATENCY

CPU LIMIT

HOW MANY SONGS CAN
YOU LOAD IN ONE

ABLETON SET?

Discover how many songs you can have in your Ableton set

without overloading your CPU. Learn the math and estimations

to determine the approximate CPU usage for different song

sets. No matter what sample rate and bit depth your stems are

or if you’re warping your stems, find out how many songs you

can comfortably run in your set and ensure you have enough

headroom for other elements. Plus, learn how to adjust your

file quality to accommodate larger song sets. 

Use your CPU Peak and the chart below to estimate how many

total songs you can load into one Ableton Set at a time.



Clip CPU
Peak

Estimated
CPU Usage

Number of
Songs

Song CPU
Peak

CPU
Headroom
(CPU Limit-
Song CPU
Peak)

2 x Clip CPU
Peak %

10

4 x Clip CPU
Peak %

20

8 x Clip CPU
Peak %

40

16 x CPU Peak
%

80

(Estimated
between 40
and 80 song
CPU usage)

50

50 song CPU x
2

100



1
Double the CPU peak percentage to estimate the CPU usage for a 10-song set.

3

ESTIMATE CPU FOR 10-SONG SET

Ensure the calculated CPU percentages fall within your system's CPU threshold and
leave enough headroom for other processes.

CONSIDER CPU THRESHOLD & HEADROOM 

4
If using warped tracks or different sample rates, adjust your calculations to reflect
the increased CPU usage.

ADJUST FOR WARPED TRACKS & SAMPLE RATES 

2
Continue doubling the CPU estimate to calculate the usage for 20, 40, 50, and 100-
song sets.

CONSIDER CPU FOR LARGER SETS 

SAMPLE RATE 

BUFFER SIZE

TOTAL LATENCY

CPU LIMIT

MAXIMUM TRACK LIMIT 

TRUE TRACK LIMIT

CLIP CPU PEAK

CPU HEADROOM 

(IF USING TRANSITIONS)

(CPU LIMIT- CLIP CPU PEAK ) 



10 SONG ESTIMATED CPU
PEAK

10 SONG CPU HEADROOM

20 SONG ESTIMATED CPU
PEAK

20 SONG CPU HEADROOM

50 SONG ESTIMATED CPU
PEAK

100 SONG ESTIMATED
CPU PEAK
100 SONG CPU
HEADROOM

40 SONG ESTIMATED CPU
PEAK

40 SONG CPU HEADROOM

80 SONG ESTIMATED CPU
PEAK
80 SONG CPU
HEADROOM

50 SONG CPU HEADROOM 



1

2

3

4

FINDING THE CPU LIMIT OF
OUR MIDI DEVICES 

THE PLAYBACK METHOD™ WORKBOOK

If  using MIDI devices of instruments in your set, you’l l  need to find the CPU
usage of your MIDI devices in your set and add that to your calculations.

Open an Ableton Set with only your MIDI devices loaded in.

OPEN YOUR SET WITH MIDI DEVICES 

Max out the CPU usage of your devices. For example, with instruments, sustain the
max number of keys that will take advantage of all possible polyphony, and
increase and use all available effects you would typically use.

MAX OUT ALL POSSIBLE CPU USAGE 

Using the chart below, notate your MIDI CPU limit.

NOTATE YOUR MIDI CPU LIMIT

As a placeholder, use 5% as the CPU Usage of Foundations and the cue player
usage, or test on your actual machine to find more accurate values.

FOUNDATIONS/CUE PLAYER CPU USAGE



Sample Rate

Buffer Size

Total Latency

CPU Limit

Maximum Track Limit

True Track Limit (If Using Transitions)

Clip CPU Peak

CPU Headroom (CPU limit- Clip CPU peak )

10 Song Estimated CPU Peak

10 Song CPU Headroom

20 Song Estimated CPU Peak

20 Song CPU Headroom

40 Song Estimated CPU Peak

40 Song CPU Headroom

80 Song Estimated CPU Peak

80 Song CPU Headroom

50 Song Estimated CPU Peak

50 Song CPU Headroom

100 Song Estimated CPU Peak

100 Song CPU Headroom

MIDI Device CPU Usage

CPU Headroom 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

Learn advanced programming skills to use Playback "Hands-Free" on
stage, allowing you to focus on the music and stay in the moment.

Master custom cues and the Custom AI cues player for improved
on-stage communication
Implement advanced song and set programming skills for hands-
free operation
Learn to use these skills with Setlist management solutions and The
Advanced Playback template

THE PLAYBACK
METHOD™: 

HANDS-FREE



Welcome to Stage 6 of The Advanced Playback Method ™. The goal of this stage is

to simplify our live performance setup with advanced programming techniques.

This stage is designed for those who have mastered the basics of song and set

programming and are ready to make their set fully “hands-off”. We'll explore

custom cues, advanced song and set programming, and look at implementing

these skills with both setlist management solutions, and using the Advanced

Playback Template.

Learn when to use the Advanced Playback template, and when to use a Setlist
management solution instead. 

Use the playback advanced template in conjunction with a virtual MIDI driver
(LoopBe1 for Windows or IAC Driver for Mac) for pre-configured control setups.

USING THE ADVANCED PLAYBACK TEMPLATE

INTRO TO ADVANCED
PROGRAMMING SKILLS 

THE PLAYBACK METHOD™ WORKBOOK

Learn how to design custom cues, song titles, and song sections, including the
creation of completely custom cue voices.

Understand the importance of having separate cue players for different members
of the performance, such as the artist, band, MD, and others.

CREATING CUSTOM CUES 



Set up Ableton to stop automatically after each song.

Set up Ableton to pause and then go to the next song, allowing you to navigate
your set by simply pressing play.

Learn how to reorder songs in your setlist quickly, without building a new set.

Learn how to fade in and out tracks using only one button on your MIDI controller.

ADVANCED SET PROGRAMMING 

Explore setlist management solutions like Setlist, AbleSet, LIOBOX, Taz SP and
Conductor for advanced level programming.

Integrate plugins or hardware devices (such as the LIOBOXv2 or the Floor Vista)
for enhanced song and set programming capabilities.

SETLIST MANAGEMENT SOLUTIONS 

Set up one-button loops and repeats for effortless control during performances.

Pre-program loops to automatically repeat song sections.

Implement dynamic cues to change your cues when repeating song sections.

ADVANCED SONG PROGRAMMING 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:
PLAYBACK ADVANCED

TEMPLATE
If you don’t have a setlist management solution, you can
choose to use the Playback Advanced Template. 

Learn what’s included in the Playback Advanced
Template and if it’s right for you
Learn how to transfer files programmed with the
playback basic template to the advanced template
Learn how to customize the Playback Advanced
Template
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1

2

3

WHAT’S THE ADVANCED PLAYBACK
TEMPLATE & IS IT RIGHT FOR ME?

THE PLAYBACK METHOD™ WORKBOOK

Let’s take a quick look at The Advanced Playback Template, so you can decide
if it’s right for you. 

The Advanced Playback Template in Ableton can be used with just a virtual
MIDI driver (LoopBe1 on Windows or IAC Driver on Mac).

The template includes advanced programming features that work with any
version of Ableton Live.

UNDERSTANDING THE TEMPLATE: 

Decide on either using a Setlist management solution, or the Advanced
Playback Template.

If you’re using AbleSet, LIOBOX, Conductor, or Taz SP/Pro you can use the
advanced playback template as well, without causing any conflicts.

If you’re choosing Setlist as your setlist management solution, you can not
use the Advanced Playback Template because the IAC Driver will create a
MIDI feedback loop and cause issues with Setlist.

If you’re using the template with your setlist management solution, only
use the template for features unavailable in your setlist management tool.

TEMPLATE OR SETLIST MANAGEMENT:

Consider leaving the “dynamic cues” track if you want to have your cues
reflect the fact you’re looping a song section.

You can use the song, click, tempo, cues, and markers track whether you’re
using the advanced features of the template or not.

TEMPLATE CUSTOMIZATION:



4

5

6

Remove features like "stop", "select next song", and "repeat control" if they
are replicated within your setlist management tool.

Delete any unused MIDI mappings, found in the MIDI mappings browser,
to avoid any conflicts with MIDI mapping.

ELIMINATE UNUSED FEATURES: 

The one-button fade in/out is the only feature of the Advanced Playback
template that can only be accomplished with the Advanced template.

You can use the Advanced Playback template and this feature with any
compatible setlist management solution like, AbleSet, TazSP, Conductor, or
LIOBOX.

TEMPLATE ONLY FEATURE:

Use the advanced template as a starting point to develop your
programming skills in Ableton.

Gradually transition to using setlist management tools as you become
more comfortable with the template and need more complex features.

STARTING POINT:

7
Adjust the template by keeping essential elements and removing
incompatible features based on your chosen setlist management tool.

Review MIDI mappings and delete any unused mappings.

Delete any extra tracks or MIDI clips that you aren’t planning on using. 

Disable the virtual MIDI driver if your using Setlist, due to the
incompatibility with Virtual MIDI drivers.

FINAL CONFIGURATION: 



1

2

3

PLAYBACK ADVANCED TEMPLATE
INTRO & WALKTHROUGH

THE PLAYBACK METHOD™ WORKBOOK

Let’s take a look at what’s included with the template. 

Ensure you have completed The Playback Method™: Program stage, to
understand how to properly program songs and sets.

Gain experience with the basic playback template, as the advanced
template builds on these foundational skills.

PREPARATION: 

Recognize that not all features in the template need to be used. Customize
the template based on your specific needs in upcoming sessions.

Delete any additional MIDI mappings or clips and tracks you’re not
planning on using.

UNDERSTANDING THE TEMPLATE: 

Learn to use the increased number of locators (20 instead of 8). These are
pre-mapped to your keyboard (1-9, Q-left bracket) to facilitate easy
navigation through songs in a setlist.

NAVIGATING WITH LOCATORS: 

4
The song and markers tracks are exactly the same in the basic and
advanced templates.

The dynamic cues track allows you to hear the correct cue when repeating
song sections.

GLOBAL PROGRAMMING TRACKS: 



5

6

Use the IAC Driver (Mac) or LoopBe1 (PC) to handle song transitions. Learn
to set up MIDI clips that can stop a song or select the next song
automatically.

This can allow you to treat the Advanced Playback Template as if it’s a
setlist management solution.

MIDI DRIVERS AND SONG TRANSITIONS: 

Repeat/Loop Track: Set up loops within songs without using Ableton’s built-
in loop brace.

Control Track: Explore various control options like adding locators
dynamically during a set.

Fade Track: Create fades based on song tempo using a single button on
your MIDI controller (pre-mapped to return tracks).

ADVANCED TRACK USAGE: 

7
Rename and reorder return tracks as needed. Review The Playback
Method™: Prep stage to learn more about how return tracks are used.

In the advanced template, the return tracks have been automatically
mapped to the one-button fade in/out control, to easily fade out all “tracks”
in case of emergency with only one button on your MIDI controller.

RETURN TRACKS: 



TRANSFERRING FILES TO THE
PLAYBACK ADVANCED TEMPLATE

THE PLAYBACK METHOD™ WORKBOOK

If  you’re working through the course in order, you’ve l ikely committed time to
programming songs with the basic Playback template. In this lesson, we’l l
discuss the differences between these templates, if  you should use the advanced
template, and how to transfer songs between templates.

1
The advanced playback template is designed to build upon the skills and
structure used in the basic template, making it easy to transition without
reprogramming songs from scratch.
The main difference between the advanced template and the basic template, is
the addition of functionality using a virtual MIDI driver. This allows you to
accomplish the advanced song and set programming techniques covered in the
“Hands-Free” section of the course using only the template. 
If you’re using a setlist management solution to accomplish these advanced
programming techniques, stick with the basic template.

UNDERSTANDING ADVANCED / BASIC DIFFERENCES

2
Duplicate the advanced template set for safety.
Open the advanced template and save a new copy using "File > Save Live Set As"
and then use "Collect All and Save" to ensure all files are included.
Drag and drop songs formatted in the basic template into the advanced
template set. 
If you haven’t customized the structure of the global programming tracks in
your basic template, the files are compatible and will fit seamlessly into the
advanced template structure.
Reorganize tracks as necessary, following the same steps as building a set with
the basic template.

USING BASIC TEMPLATE SONGS IN THE ADVANCED TEMPLATE

3
The advanced template offers additional functionalities like stopping playback at
the end of each song or setting up one-button repeats. These features require the
advanced template for proper execution.

ADVANTAGES OF UPGRADING TO THE ADVANCED TEMPLATE 



HOW TO CUSTOMIZE THE
PLAYBACK ADVANCED TEMPLATE

THE PLAYBACK METHOD™ WORKBOOK

If  you’re going to use The Playback Advanced Template, there’s l ikely some things you’l l
want to tweak and change. I  don’t even use every feature of this template. Let ’s take a
look at some of the things we have the flexibil ity to change, and the things that must
remain the same.

1
Keeping your “tempo track" is essential to be able to “save” your tempo with each song. 
Consider keeping your “markers” track so you can store your song sections with each song, and easily
navigate your song while on-stage.
While you can use an audio click instead of Foundations, consider keeping the click track as a MIDI to
maintain flexibility in adjusting click sounds and subdivisions.
While you can use audio cue files instead of the cue player, consider keeping the cue player in its
original MIDI format to avoid losing flexibility.

DON’T CHANGE 

2
If using third-party tools like Setlist which interfere with MIDI drivers, remove incompatible tracks (e.g.,
stop track, select tracks, next song, repeat control) and disable any virtual MIDI drivers, or stick with
the Basic Playback template.
If you’re using AbleSet, TAZ, LIOBOX, or Conductor, consider deleting tracks that the plugin handles
instead of relying on a virtual MIDI driver. For example, repeat, stop, control tracks or you can use the
Playback Basic Template instead.

DELETING UNNECESSARY TRACKS

3
Review and rename return tracks to match the instruments in your set.
Group tracks according to your needs, excluding any instruments not needed (e.g., lead vocals).
If the number of return tracks (limited to twelve) is insufficient, review our lesson in The Playback
Method™: Prep stage that explains how to work around this limitation.

CUSTOMIZING RETURN TRACKS 

4
Add more locators as needed for your template setup. For example, insert a locator at a specific
measure and map it for quick access.

ADDING AND MAPPING LOCATORS 

5
Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates folder as previously discussed.
Name the file in a way that you can distinguish it from the template you’ve downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements, such as samples from the cue
player or click track, are included in your template.
Make sure to backup your template in multiple places, as it’s the only copy of your customized
template available.

SAVING THE CUSTOMIZED TEMPLATE 



1

2

3

HOW TO SETUP AND CUSTOMIZE
YOUR TEMPLATE FOR REDUNDANCY

THE PLAYBACK METHOD™ WORKBOOK

If you’re planning on using the PlayAUDIO1U, there’s a quick addition you should
make to your template .

Start by opening the playback template you’ve customized for your needs.

OPEN YOUR TEMPLATE: 

If you haven’t installed LifeSine yet, download from the iConnectivity site
and install in Ableton.
Find the LifeSine plugin within your software tools.

LOCATE LIFESINE PLUGIN:

Drag and drop the LifeSine plugin into your template.
Place it specifically below the last global programming track to avoid
conflicts with other tracks. In the Playback Advanced Template, we’d add it
below the "fade" track.

INSERT LIFESINE BELOW GLOBAL PROGRAMMING TRACKS:

4
Rename the newly added track to something easy to understand, like
“Tone” or “LifeSine”.

RENAME THE TRACK: 

5
After placing and naming the LifeSine plugin, close the plugin window.

CLOSE THE PLUGIN WINDOW: 

6
Navigate to Ableton’s Preferences (CMD + ,) 
Navigate to the audio page and enable outputs 15/16.
Navigate to the track that contains the Lifesine plugin and set the output to
channels 15 and 16 to arm the interface automatically.

CONFIGURE AUDIO ROUTING:



9
Use the “Collect All and Save” function in Ableton to ensure all elements,
such as samples from the cue player or click track, are included in your
template. 

COLLECT ALL AND SAVE: 

10
Save the updated template both locally and in cloud storage.
Ensure you have multiple backups in different locations to secure your work.
Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates folder as
previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements, such as
samples from the cue player or click track, are included in your template.
Make sure to backup your template in multiple places, as it’s the only copy of
your customized template available.

BACKUP YOUR TRACK: 

8
Perform a “Save As” operation to save the modified template with a new name.
Navigate to File > Save Live Set As 
Save the customized template in a specific folder, ideally in a templates folder
as previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site. 
Use the “Collect all and Save” function in Ableton to ensure all elements, such as
samples from the cue player or click track, are included in your template 
Make sure to backup your template in multiple places, as it’s the only copy of
your customized template available.

SAVE THE UPDATED TEMPLATE:

7
Apply a color to the LifeSine track to ensure it matches the aesthetic of
your existing template setup.

COLOR CODE THE TRACK: 
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ADVANCED SONG
PROGRAMMING SKILLS:

CUSTOM CUES

Go beyond the cues included in the Cues player and create
custom AI generated cues.

Learn how to create your own custom cues and slates
Learn how to add your own song sections to the custom
cues player
Learn how to create custom pitch references and
custom vocal cues to your programmed songs



ADVANCED SONG PROGRAMMING 
SKILLS: CUSTOM CUES

THE PLAYBACK METHOD™ WORKBOOK

Let’s look at how to generate custom cues using AI voice synthesis from Eleven
Labs. While AI is certainly a current “buzz word”, we’re not using it simply
because it ’s AI. Since all of the cues in the cues player were created using AI,
this means you’re able to use the same voice (without hiring a studio voice
over artist) to say whatever you want. You can use the AI generator to create
song titles, custom song sections, and even create some fun easter eggs to
surprise your band and keep them motivated. (I  know you’l l  use the custom
voices to randomly swear at various band members during the set…just make
sure these remain only in the ears..  Hey.. we all do it. . )  

CREATING CUSTOM CUES USING AI

1
Start by signing up for a free account on Eleven Labs. This is necessary to
access the voice synthesis features and manage your custom cues.

2

SIGN UP FOR ELEVEN LABS

Below the lesson video, find links to five different AI-generated voices. Choose
one that you’d like to use to generate custom cues. 
While there’s five different voices includes, I’d suggest sticking with one voice
for consistency unless you need multiple voices for varied cues.

SELECT A VOICE

3
Click the link for the voice you chose, which will direct you to the Eleven Labs
website. If you're not already logged in, you will need to sign in or create an
account.
Once logged in, add the selected voice to your account by following the
prompt. The default name of these voices will be shown on Eleven Labs, I
highly suggest changing this to reflect the name in the cues player (i.e. Vox 2,
Vox 3, etc..)

ADD THE VOICE TO YOUR ACCOUNT 



4
Use the speech synthesis engine to input the text for your cue, such as
"guitar solo" or any other specific section of your song.
Experiment with generating the cue multiple times to achieve the desired
timbre. Download the best version as an MP3 file.
Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates folder
as previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements, such
as samples from the cue player or click track, are included in your template.
Make sure to backup your template in multiple places, as it’s the only copy of
your customized template available.

5

GENERATE YOUR CUSTOM CUE 

Drag your cue into Ableton Live.
Zoom in to the beginning of your cue and find the start of your cue. 
Highlight any extra space and hit delete on your keyboard to delete any extra
space at the front of your cue. 

DELETE EMPTY SPACE

6
Before using your custom cue, convert the MP3 file to WAV format, to avoid
any issues with Ableton.
Highlight the entirety of your cue, and press Command + J or Control +J on PC
to re-render your file and convert from MP3 to WAV format. 

CONVERT THE MP3 TO WAV FORMAT 

7
I recommend generating and exporting cues individually rather than in strings
for easier management. For instance, create separate cues for "Fields of
Dreams" and "Never Going to Let Go" instead of a combined cue.
Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates folder as
previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements, such as
samples from the cue player or click track, are included in your template.
Make sure to backup your template in multiple places, as it’s the only copy of
your customized template available.

BEST PRACTICES FOR CREATING CUES



ADVANCED SONG PROGRAMMING 
SKILLS: CUSTOM CUES

THE PLAYBACK METHOD™ WORKBOOK

If  we’re going to move our Playback system off-stage (more on this soon), how
will we know what song we’re about to play? Without needing to buy a “smart”
MIDI controller, or over-engineer a way to see your computer screen on-stage,
we can use song title “slates” in order to know exactly what song is about to be
blasted through the Front of House speakers, before we hear it.  This gives up a
few seconds to stop things if they went haywire, before we go full Ashlee
Simpson on SNL. 

CREATING SONG TITLE SLATES WITH THE CUSTOM CUES PLAYER

1
Use Eleven Labs to create a custom cue for each song.
Generate cues one at a time for accuracy, avoiding the potential mix-up of cues.
Download the generated cue and rename it for easy identification (e.g., "Never
Gonna Give You Up-Vox-1").

2

GENERATE INDIVIDUAL SONG CUES

Drag the cue into Arrangement View in any open audio track.
Trim any empty space at the beginning of the cue to ensure it starts immediately.
Convert the MP3 cue file into a WAV file for better quality and compatibility.

PREPARE AND CONVERT THE CUE

3
Decide on the placement of the cue within your song's arrangement.
Avoid adding the cue to a group track to maintain flexibility in routing.
I suggest putting the cue above your song stems in a dedicated "song cues" track.

PLACE THE CUE IN YOUR SET

4 ADJUSTING THE BASIC TEMPLATE

If  you’re using the Basic Template, you’l l  notice the Song Title cue is MIDI. If
you’re planning on using Song title Slates, I  suggest updating this track in your
template to be an audio track, and placing your “slates” in this track.



4
Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates
folder as previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements,
such as samples from the cue player or click track, are included in your
template.
Make sure to backup your template in multiple places, as it’s the only copy
of your customized template available.
Drop your song slate cue into the Song Titles Track at the top of your set.
Drag your song slate to the start of the song.
Consolidate the cue with the song's length to maintain alignment. You can
highlight the length of the entire song, and press Command + J or Control J
to consolidate to a single audio track. 
Rename your audio clip if need to match your song title, (i.e. NEVER
GONNA GIVE YOU UP)
Make sure to route the audio output of this track to match the audio
output of your current cues track.

ADJUSTING THE BASIC TEMPLATE (CONT.)

5
Carefully position the cue to avoid overlap with the song's intro or click tracks.
If necessary, insert additional measures at the beginning of the track to
accommodate the cue. For example, I’ll often move my song slate a quarter
note before the start of my song to avoid clashing with the count-in.
Re-render and consolidate your song’s stems if you've adjusted the
arrangement to include the cue at the start.
Disable warping on the cue to prevent CPU load and ensure playback stability.
Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates folder
as previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements, such
as samples from the cue player or click track, are included in your template.
Make sure to backup your template in multiple places, as it’s the only copy of
your customized template available.

OPTIMIZING CUE PLACEMENT



CREATING & ADDING CUSTOM SONG
SECTIONS TO YOUR CUE PLAYER 

THE PLAYBACK METHOD™ WORKBOOK

Let’s look at how to create and integrate custom cues into your Ableton sets.

INTRODUCTION TO CUSTOM CUES IN ABLETON

1
Open either the Basic or Advanced template, or your own custom template that
includes the AI cues player.

2

OPEN THE TEMPLATE 

Determine what specific cues are missing in your cue player that you need for your
song sections.

IDENTIFY MISSING CUES

3
Use Eleven Labs and a voice from the cues player to generate the custom cues you've
identified as missing.

GENERATE CUSTOM CUES

4 RENAME & ORGANIZE CUES 
Download and rename your generated cues for easy identification and organization.

5 ADD CUES TO ABLETON SET
 Import your cues into Ableton, starting with the arrangement view, and adjust their
start points to eliminate silence.

PREPARING CUES IN ABLETON

1
Consolidate each cue and convert them to WAV files, ensuring to turn off warp for
each clip.

2

CONSOLIDATE AND CONVERT CUES

Rename each clip appropriately in Ableton to reflect the specific cue it represents.

RENAME CLIPS FOR CLARITY 

3
Import your cues into the drum rack of the cue player, organizing them according to
your preference. I suggest adding all new cues after the current cues, so any existing
programming remains unchanged.

ADD CUES TO DRUM RACK  



PROGRAMMING CUES IN SONGS 

ADVANCED TEMPLATE ADJUSTMENTS 

1
Preview your cues by pressing the play button on each cell in the drum rack, to
ensure they play correctly and rename them within the drum rack for easier
identification.

2

PREVIEW AND RENAME CUES 

In the session view, insert new scenes for each cue, ensuring they're properly labeled.

INSERT NEW SCENES FOR CUES

3
 Modify the MIDI notes for each cue scene to trigger the correct cue.

ADJUST CLIPS FOR CUE TRIGGERS  

Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates
folder as previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements,
such as samples from the cue player or click track, are included in your
template.
Make sure to backup your template in multiple places, as it’s the only copy
of your customized template available.

1
If using an advanced template, replace and duplicate the dynamic cues track,
renaming and organizing it according to your setup.

2

CONFIGURE DYNAMIC CUES 

Save your new cue setup, either by updating your existing template or by saving it as a
new project file. Most importantly, make sure to use Collect All and Save to bring any
new samples into the Samples folder of your template. 

SAVE & ORGANIZE YOUR TEMPLATE 



USING CUSTOM CUES IN YOUR PROJECT 

1
Open your song project and integrate the new cues by dragging them into
arrangement view and positioning them as needed.

2

INTEGRATE CUES INTO SONG PROJECTS  

Play your project to test the cues in context, ensuring they trigger correctly and at the
appropriate times.

Navigate to File > Save Live Set As.
Save the customized template in a specific folder, ideally in a templates folder as
previously discussed.
Name the file in a way that you can distinguish it from the template you’ve
downloaded from the site.
Use the "Collect All and Save" function in Ableton to ensure all elements, such as
samples from the cue player or click track, are included in your template.
Make sure to backup your template in multiple places, as it’s the only copy of your
customized template available.

TEST CUES WITHIN SONGS 



HOW TO CREATE CUSTOM PITCH
REFERENCE CUES IN ABLETON LIVE

THE PLAYBACK METHOD™ WORKBOOK

In this lesson, we'll  look at how to use vocal cues and pitch references to
reduce the stress and burden on your vocalists, and make sure they always
start on the right note. 

1
Open Ableton Live and navigate to the bottom global programming track (using
the basic template, this would typically be a markers track).
Press CMD + Shift + T to create a new MIDI track.
Rename the MIDI track (e.g., "Pitch Reference") using Command + R.

2

CREATE A MIDI TRACK IN ABLETON LIVE

Go to Ableton Live's browser, find the Instruments section, and choose a piano
sound (or any preferred instrument).
Drag the chosen instrument into the MIDI track.
If you’ll be creating lots of pitch reference cues, it would be worth investigating the
best sounds for your vocalist and saving as a preset.

SELECT AN INSTRUMENT FOR PITCH REFERENCE

3
Determine the length of the count-in for the song and create a MIDI clip that spans
this length by clicking and dragging on the track.

CREATE A MIDI CLIP FOR PITCH REFERENCE

4 INPUT THE STARTING PITCH
Using a MIDI keyboard or the piano roll, find and input the starting pitch of the song
into the MIDI clip.
If uncertain, collaborate with the vocalist to decide on the most comfortable 

      starting pitch.

5 ADD CUES TO ABLETON SET
Play the MIDI clip to ensure the pitch reference is correct and at a comfortable
octave for the vocalist.
Make necessary adjustments based on feedback or personal judgment.



6 ROUTE THE PITCH REFERENCE TO THE 
APPROPRIATE OUTPUT

Route the output of this track to the same output as your cues track. 
If you have enough outputs on your interface, you could consider routing this to an
additional output on your interface, that only goes to the vocalist.
If you’re working with multiple vocalists, you could create separate pitch references
for each vocalist, ensuring they can hear their starting note clearly.

7

Right-click the track and select "Freeze" to minimize CPU usage, keeping the pitch
reference ready for playback.
Optionally, "Flatten" the track to convert it into an audio file for simplicity, though
freezing is recommended for flexibility.

OPTIMIZE THE PITCH REFERENCE TRACK 
FOR PERFORMANCE

8 FINALIZE AND TEST THE SETUP 
 Ensure the pitch reference works as intended during rehearsals, making any final
adjustments for clarity and volume in the mix.



ADDING YOUR OWN CUSTOM VOCAL
SAMPLES TO THE CUES PLAYER

THE PLAYBACK METHOD™ WORKBOOK

What do you do if you’ve already programmed all your cues in your set, and
suddenly the music director you're working with casually mentions they want
to use their own vocal cues??!! While quitting might sound the most appealing
option, if  you’re using the cues player, you can easily keep all your
programming, and easily replace the voice samples you’re using for each cue.
This will  allow you to make it through the gig despite your Music Director’s
lack of planning or communication (Thanks ALOT JOHN)...  and save yourself
hours of having to re-do your work.

1
Open the template used for initial song programming 
Save the template under a new name (e.g., "Wills custom cues") to prevent
altering the original template.
Perform a "Collect All and Save" operation to ensure all samples are included in
the new template.

2

INITIAL SETUP 

If not already available, ensure you have recordings for all desired cues (e.g., count-
ins, song sections).
Identify the existing cue player used in the template.

PREPARING FOR CUSTOM CUES  

3
Access the cue player within your project and navigate to the device view.
Duplicate an existing chain (e.g., "voice five chain") and rename it (e.g., to "custom cues").
Adjust the chain selector to include the new custom cues chain as an option.
Update the macro mappings to accommodate the addition of the custom cues chain.

INTEGRATING CUSTOM CUES 

4
Navigate to the custom cues instrument within the instrument rack.
Replace existing cues with custom voice recordings by dragging and dropping the
samples onto the appropriate drum pads or keys.
Save changes to the custom cues instrument.

ADDING CUSTOM VOICE SAMPLES  



5
After adding all your new vocal samples in, make sure to Collect All and Save, to
ensure all your samples are in your new template. 
Any time you add new additional cues, make sure to Collect All and Save.
When in doubt.. Collect All and Save. 
If the day of the week ends in “Y”.. consider using Collect All and Save again.

6

COLLECT ALL AND SAVE 

Add a previously formatted song to your template, or drag new cues from your
template into a song.
Verify the custom voice cues are functioning as expected by playing back sections
of the song.

TESTING AND IMPLEMENTING CHANGES 

7
Ensure all updated songs are saved within the new template framework to maintain
consistency across the set.

FINAL STEPS 



CREATING A SEPARATE CUES
PLAYER WITH SPECIAL CUES

THE PLAYBACK METHOD™ WORKBOOK

If  you’re a Playback Engineer working with an artist,  or the lead singer of your
band could benefit from some subtle reminders during the show, you may
want to consider a separate cue player just for them. 

1
Choose a song that could benefit from custom cues. In my course example, I’ll
use Post Malone's "Enough is Enough".
Decide on the types of cues needed, such as reminders of when to sing or
specific lyric reminders.

2

SONG SELECTION AND CUE PLANNING

Choose a voice from the AI cues player and use Eleven Labs to generate some
custom cues. Example cues might include "vocals in" and specific lyrics from the
song.
Experiment with the timbre of the text-to-speech output to find the right timbre
and feel for the cue.
Download and rename the generated cues for easy access and organization.

CREATING VOCAL CUES 

3
Create a new audio track for the vocal cues.
Position this track appropriately within your template. I suggest below the markers or
global programming tracks.
Import the vocal cues into the special cues track, placing them at relevant points within
the song structure.
If necessary, adjust the timing and format of the cues (e.g., converting to WAV format,
disabling warping) to ensure they play back as intended.

SETTING UP THE CUE IN ABLETON

4
Carefully route the cue track to ensure it is only audible to the intended recipient(s),
protecting the integrity of the live performance.
If applicable, assign the cue track to a specific output channel to segregate it from the
main mix or other cue mixes.

ROUTING AND PLAYBACK CONSIDERATIONS 



5
Route these cues to a specific discrete output on your interface, so that it can be
routed only to the Artist (or specific band member’s) in-ears.
Utilize these cues as a tool to enhance performance quality, especially during
extensive tours or performances where maintaining consistency and
engagement can be challenging.

6

CUSTOMIZATION AND UTILITY 

Ensure all cues are correctly formatted, placed, and routed.
Conduct a thorough soundcheck to test the cues within the context of a live
performance setting, making adjustments as needed for clarity and effectiveness.

FINAL ADJUSTMENTS AND TESTING 

The sky really is the limit when it comes to these cues. The exact cues you’ll want to create depend
on the artist/band you’re working with, but here’s a few ideas. 

Reminders of entrances and exits (Vocals In)
Reminder of Stage Placement (Downstage Center)
Reminder of things that could permanently injure you (Pyro Stage Left)
Reminder of what city you’re in (Hello Detroit!!) 
Reminder to walk off stage (Exit Stage Left)

SONG EXAMPLE CUES 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:
ONE-BUTTON REPEAT

Learn how to implement one-button repeats for effortless
section looping in your live performances.

Learn to repeat any song section, at any-time
Implement this skill using various setlist management
solutions:

Setlist
AbleSet 2
Conductor
Virtual MIDI drivers
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CREATING A ONE-BUTTON REPEAT
WITH SETLIST

THE PLAYBACK METHOD™ WORKBOOK

In this lesson, we're focusing on creating a loop that can be controlled by a single
button on a MIDI controller and using Setlist by Strange Electronic. This setup is
ideal for artists looking to manage their performance seamlessly without the need
to fiddle with multiple controls. While this process is technically “Creating a 
Pre-Programmed Loop”, here’s how we’l l  achieve it in Setlist.

1
Ensure the Setlist plugin is loaded into Ableton

2

LOADING SETLIST 

Enter MIDI mapping mode in Ableton by pressing Command + M on Mac or Control +
M on PC.
Click on Ableton's loop brace to select it for MIDI mapping.
Assign a button on your MIDI controller to control the loop brace. In this example, the
'Previous' button on my Oakboard Slide Duo is used to toggle Ableton's loop brace on
and off.
Exit MIDI mapping mode by pressing Command + M (Mac) or Control + M (PC) again.

MIDI MAPPING FOR LOOP BRACE ACTIVITATION 

3
Decide which part of the song you want to loop. 
Add a locator to the section of the song you wish to loop, and rename it to indicate the
loop and its duration (e.g., "Loop 16" for a 16-beat loop).

SELECTING THE LOOP SECTION

4
Play your set or song. When the playback reaches the designated loop section, Ableton's
loop brace will automatically activate, looping the specified section for the duration
you've set.
To exit the loop, press the 'Previous' button (or whichever button you've assigned) on
your MIDI controller to disable Ableton's loop brace.

ACTIVATING THE LOOP 

5
If you want to loop different sections within the same song, repeat the process of adding
locators and renaming them according to their desired loop duration.
Test each loop by playing the song and observing how Ableton and Setlist manage the
loop activation and deactivation automatically.

ADDITIONAL LOOPS



CREATING A ONE-BUTTON REPEAT
WITH ABLESET 2

THE PLAYBACK METHOD™ WORKBOOK

In this lesson, we'll  look at how to effortlessly set up a one-button repeat function using AbleSet 2.
While this is an easy process, it requires a few specific adjustments to your AbleSet fi le to ensure
smooth operation. If you're new to AbleSet or looking for a comprehensive understanding, I
recommend checking out the full AbleSet course. Now, let's break down the process step by step.

1
Make sure you have a locator at the beginning of your song and give it a name.
In this case, it's named "Beautiful."

2

START WITH A LOCATOR 

Navigate to your markers track. Change the track's name from "markers" to
"sections." This allows AbleSet to “read” the data in your locators track.

RENAME THE MARKERS TRACK 

3
Access the AbleSet menu and click on the settings icon to open settings.
Under the "playback" section, ensure the "auto loop the current section" is enabled. This
setting is crucial for the one-button repeat functionality.
For the "Jump Mode," it's recommended to leave it set to "end of section," although this
can be adjusted based on personal preference.
Optionally, you can enable the option to "place locators on section clips." This
automatically adds locators throughout every section of your song, facilitating easier
navigation and looping.

CONFIGURE ABLESET SETTINGS  

4
Open the AbleSet window. 
I prefer to keep AbleSet in a floating window for easy access. Navigate to your song
within this view.

UTILIZE THE ABLESET WINDOW 

5
Select a section you wish to loop. 
You’ll notice as your song plays, Ableton’s loop brace moves to highlight each new song
section (as defined by your “sections” track).
When you’re ready to repeat the current song section you can enable the loop in
AbleSet, by pressing “L” on your computer keyboard, or your MIDI controller. 
To exit the loop, press "L" on your keyboard, which deactivates the loop and continues to
the next song section.
Optionally, stop the loop by pressing the spacebar.

INITIATE LOOPING 

6
While not covered in this lesson, remember that you can MIDI map the loop function to a
controller for even easier access. This way when you’re ready to repeat the current
section, you simply press the button you’ve assigned to the loop to enable the loop, and
press the same button again to disable the loop. 

MIDI MAPPING 



CREATING A ONE-BUTTON REPEAT
WITH CONDUCTOR

THE PLAYBACK METHOD™ WORKBOOK

In this lesson, we're diving into the process of setting up a one-button loop feature using Conductor
within Ableton. This process is very similar to that of AbleSet.

1
Begin by dragging Conductor into your Ableton session. This setup parallels the
integration of AbleSet, utilizing Ableton Live's built-in loop brace for creating loops.

2

LOAD CONDUCTOR INTO YOUR ABLETON SET 

Choose the song section you wish to loop. Conductor's design allows for easy navigation
and selection of different sections of your song, separate from song navigation.

NAVIGATING TO YOUR DESIRED SONG SECTION 

3
Upon selecting a section in Conductor, note how the loop brace automatically adjusts to
select the chosen section. This visual cue indicates the specific part of the track that will
be looped.

AUTOMATIC LOOP BRACE 

4
Find and click the loop button within Conductor. This action toggles the looping feature
on, visually signaling that the section is ready to be looped.

INITIATE LOOPING 

5
When you're ready to end the loop and proceed to the next section of your song, simply
click the loop button again to disable looping.

DISABLE LOOPING 

6
For enhanced control and convenience, consider MIDI mapping the loop function to a
button on your MIDI controller. This allows for hands-on, immediate toggling of the loop
feature during live performances or while recording.

OPTIONAL MIDI MAPPING 



CREATING A ONE-BUTTON REPEAT
WITH VIRTUAL MIDI

THE PLAYBACK METHOD™ WORKBOOK

If  you don’t have a setlist management solution-no fear. Using the Advanced Playback template you
can easily implement a one-button repeat, without any additional software or hardware.

1
Before starting this lesson, make sure you’ve already installed, activated, and
configured your Virtual MIDI Driver.

2

SETUP YOUR VIRTUAL MIDI DRIVER  

Start with your song loaded into an advanced template in Ableton.
OPEN THE ADVANCED ABLETON TEMPLATE 

3
In your browser, locate your advanced template, and expand it to find the repeat clip
within your repeat track.

EXPAND YOUR ADVANCED TEMPLATE 

4
Click and drag the repeat clip into the appropriate repeat track.

DRAG THE REPEAT CLIP 

5
Ensure your repeat track is set to send MIDI to IAC Driver Bus 1, Channel 16, as
previously set up in the IAC setup lesson.

MIDI SETUP 

6
The repeat clip should contain a MIDI note (E-2) that outputs on Channel 16 to the IAC
Driver. This is already mapped to your previous locator using the Command + M (MIDI
map) function.

UNDERSTANDING THE MIDI MAPPING  



7
Use the Command + M function to MIDI map the on/off (track activator button) of the
repeat track to a button (e.g., "previous") on your MIDI controller. This effectively turns it
into a loop toggle.

ENABLING AND DISABLING LOOPING 

8
Play your song, and at any point of a song section, press your MIDI Controller to enable
the repeat track. If configured correctly, the section will loop perfectly due to the repeat
clip being programmed to jump back to the previous locator at the end of the measure,
facilitated by global quantization set to 1 bar.

TRIGGERING THE LOOP 

9
Add a repeat clip at the end of every last measure of each song section you wish to loop.
This can be done by copying and pasting the clip, ensuring it's added to the correct place
for each section. 

ADD REPEAT CLIPS TO SONG SECTIONS 

10
While we’re only testing this feature now, it’s worth noting that you’ll want to add these
clips while you’re programming each individual song. You’ll never need to program these
again, and they’ll move with the song, into your full set.
Make sure to MIDI map a button on your MIDI controller to control the track activator for
the repeat track, in your template. There’s no need to do this for each song, and we only
have to complete this mapping once-at our template level, for it to apply to every set,
going forward. 

MIDI MAP IN YOUR TEMPLATE 

11
After completing the setup, save your advanced template to retain these settings.

SAVE YOUR TEMPLATE 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:

PRE-PROGRAMMED
LOOP

Learn to create automatic repeats for consistent section
looping in your live performances.

Understand the benefits of pre-programmed repeats for
extended solos or intros
Master this advanced song programming skill using:

Setlist
AbleSet 2
Conductor
Virtual MIDI Driver
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CREATING A PRE-PROGRAMMED
LOOP WITH SETLIST 

THE PLAYBACK METHOD™ WORKBOOK

Let’s take a look at how to set a song section to automatically loop every time we reach it,  using
Setlist.  Spoiler Alert: This is the same process we used to create a One-button repeat. 

1
Ensure the Setlist plugin is loaded into Ableton.

2

LOADING SETLIST 

Enter MIDI mapping mode in Ableton by pressing Command + M on Mac or Control + M
on PC.
Click on Ableton's loop brace to select it for MIDI mapping.
Assign a button on your MIDI controller to control the loop brace. In this example, the
'Previous' button on my Oakboard Slide Duo is used to toggle Ableton's loop brace on
and off.
Exit MIDI mapping mode by pressing Command + M (Mac) or Control + M (PC) again.

MIDI MAPPING FOR LOOP BRACE ACTIVATION 

3
Decide which part of the song you want to loop. 
Add a locator to the section of the song you wish to loop, and rename it to indicate the
loop and its duration (e.g., "Loop 16" for a 16-beat loop).

SELECTING THE LOOP SECTION 

4
Play your set or song. When the playback reaches the designated loop section, Ableton's
loop brace will automatically activate, looping the specified section for the duration
you've set.
To exit the loop, press the 'Previous' button (or whichever button you've assigned) on
your MIDI controller to disable Ableton's loop brace.

ACTIVATING THE LOOP 

5
If you want to loop different sections within the same song, repeat the process of adding
locators and renaming them according to their desired loop duration.
Test each loop by playing the song and observing how Ableton and Setlist manage the
loop activation and deactivation automatically.

ADDITIONAL LOOPS 



CREATING A PRE-PROGRAMMED
LOOP WITH ABLESET 2 

THE PLAYBACK METHOD™ WORKBOOK

Let’s take a look at how to set up a pre-programmed loop in AbleSet 2. This process differs slightly
from the process used to create a one-button repeat. 

1
Open AbleSet and load your song project.
Identify the song section you want to loop (e.g., the intro section).

2

PREPARE ABLESET FOR LOOPING  

Rename the target song section by adding " +LOOP" to its name (e.g., "Intro + LOOP").
Play the song to verify the loop is functioning as intended.
Observe the loop enabled and the loop brace toggled on.

METHOD 1: BASIC LOOP SETUP 

3
Play the song section with the loop enabled.
Disable the loop, by using the loop icon in AbleSet, pressing “L” on your keyboard, or by
using your MIDI Controller (that’s been mapped to Loop) to exit and observe any abrupt
transitions.
Note how the song jumps immediately to the next section upon disabling the loop,
which might not always be desirable.

TESTING AND EXITING THE BASIC LOOP

4
Rename the section with " + LOOPFULL" instead of just " +LOOP" (e.g., "Intro +
LOOPFULL").
This adjustment ensures that the entire section finishes playing before moving on to the
next section, even after disabling the loop.

METHOD 2: IMPROVE LOOP SETUP (RECOMMENDED)

5
Play the song from the looping section.
Disable the loop midway and observe how the song continues to play until the end of
the section before transitioning.
This method provides a smoother exit from the loop and is generally more suitable for
live performances and seamless playback.

TESTING THE IMPROVED LOOP 

6
Experiment with both methods to understand the differences in transitions and practical
usage.
Decide which method suits your performance or playback needs better.
Practice enabling and disabling loops during live sessions to become comfortable with
the controls.

FINAL ADJUSTMENTS AND PRACTICE 



CREATING A PRE-PROGRAMMED
LOOP WITH CONDUCTOR

THE PLAYBACK METHOD™ WORKBOOK

Let’s take a look at setting up a pre-programmed loop with Conductor. While this process is
completely different from the one-button repeat process, it ’s sti l l  insanely simple.

1
Navigate to the upper right-hand corner of your screen.
Enable automation mode in Ableton to begin setting up your loop.

2

ENABLE AUTOMATION MODE 

In Arrangement View, go to the track where you have Conductor loaded. Typically, this
will be your Markers track.
With automation mode enabled, you’ll see two boxes on your track.
In the first box of your track’s interface, called the 'device chooser', select the
'Conductor' device.

SELECT CONDUCTOR 

3
In the second box called the “control chooser”, select the 'loop automation' option to
specify the type of automation you want to apply.

CHOOSE LOOP AUTOMATION 

4
Jump to the beginning of the song or to the specific section you wish to loop.
In this example, focus on looping the intro section of the track.

NAVIGATE TO THE SONG SECTION 

5
Use the draw mode (Command +B) to create a loop. Click and drag in the timeline over
the section you want to loop.
Ensure that the loop is marked as enabled in the automation lane, which should show
"loop enabled" at the intro section.

DRAW THE LOOP 

6
Once your loop is set, you can disable automation mode.
Alternatively, use the 'A' key on your keyboard to toggle automation mode on and off for
quick visual confirmation.

DISABLE AUTOMATION MODE (OPTIONAL)

7
Open the user interface and navigate back to the top of your intro section.
Press play to start playback and observe the looping section.
Verify that the loop engages as planned and continues to repeat.

PLAY AND TEST THE LOOP 

8
Decide when to exit the loop during playback. You can press the loop button in
Conductor, or use your MIDI Controller mapped to the loop functionality in Conductor to
disable this remotely. 

EXITING THE LOOP 



CREATING A PRE-PROGRAMMED
LOOP WITH VIRTUAL MIDI

THE PLAYBACK METHOD™ WORKBOOK

If  you don’t have a Setlist management solution, don’t worry. In this lesson, we’l l  take a look at using a Virtual
MIDi Driver to achieve the same functionality without needing any additional hardware, or software.

1
Begin with the lesson where you previously set up a one-button repeat. See the
“Creating a One-Button Repeat” with Virtual MIDI lesson to see how to do this step
by step.
If not already done, enter MIDI map mode by pressing Command+M (Mac) or
Control+M (PC). Assign the 'Repeat Track' activator button to a button on your MIDI
controller, such as the 'Previous' button. Note the MIDI channel and note (e.g.,
Channel 16, D#1).

INITIAL SETUP

2
Exit MIDI map mode.
In the control track (or duplicate it if it's used for other purposes), set the MIDI channel to
the one used in the mapping (e.g., Channel 16).
Go to the Arrangement View and create a new MIDI clip in the control track.
Rename the clip to "Enable Loop/Repeat."
Add a MIDI note matching the one assigned to the 'Repeat On/Off' (e.g., D#1). Make the
MIDI note span the entire length of the clip.

CREATING THE MIDI CLIP  

3
Copy the "Enable Loop/Repeat" clip.
Paste the clip into your song structure where you want the loop to start, such as the last
quarter note of the previous song section to ensure it triggers at the right moment.
Ensure that the default state of your repeat track is set to 'Off' to avoid unintentional
looping.
Make sure that the default state of your “Control” track is enabled so that it automatically
loops the section you’ve pre-programmed. 

PLACING THE MIDI CLIP IN YOUR SONG 

4
Play your song from the beginning to test if the repeat activates correctly.
Use your MIDI controller's assigned button to toggle the repeat track on and off as
needed.

TESTING AND ADJUSTING 

5
To use this setup across various projects, add the "Enable Loop/Repeat" clip to your
project template.
Open your template, ensure the MIDI channel and note are correctly set, and save the
template.

INTEGRATING INTO OTHER PROJECTS  



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:

DYNAMIC CUES
Learn to have the correct cues when repeating sections.

Understand the challenge of mismatched cues during
section repeats
Implement this advanced skill using various tools:

Setlist (with workaround)
AbleSet 2
Conductor (using virtual MIDI driver or workaround)
Virtual MIDI
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CREATING DYNAMIC CUES 
WITH SETLIST

THE PLAYBACK METHOD™ WORKBOOK

I  have bad news and good news. The bad news, there’s no “dynamic cues” feature built into Setlist.  The other
bad news is, you can’t use a Virtual MIDI driver while using Setlist,  so we can’t use the Advanced Playback

Template functionality to make this happen. And the good news….There’s a few perfectly suitable work-arounds
to make this work. Let ’s take a look!

1
Recognize that Setlist does not have built-in dynamic cue functionality.
Avoid using the IAC Driver with Setlist, to prevent MIDI feedback loops.

UNDERSTAND THE LIMITATIONS 

2
If dynamic cues are crucial, consider using AbletSet, or opt for a virtual MIDI driver and
the Advanced Playback Template.

EVALUATE THE NEED FOR DYNAMIC CUES 

3

Set up a virtual MIDI driver to manage dynamic cues independently from the setlist
functionality.
This method may require more manual intervention but offers greater flexibility in cue
management. 
We’ll talk about setting this up in a moment. 

OPTION 1: USE A VIRTUAL MIDI DRIVER WITHOUT
SETLIST MANAGEMENT  

4

Map a free button on your MIDI controller to the cues track in your template.
Use this button to toggle the cues track on and off during performance as needed.
This allows you to disable the audible cues to the band while repeating a section of the
music. 
Ensure there is a talkback microphone or another method to communicate with the
band members.
Use verbal cues or hand signals to coordinate when sections of the music are repeated.
Simply mute the cue track and inform the band to keep repeating the section as
required.

OPTION 2: MANUAL CUE CONTROL VIA MIDI
CONTROLLER

5
While this feature isn’t built into Setlist, it can easily be worked around with a MIDI
controller, and a talkback mic!
Remember that straightforward communication often resolves the need for complex
technical setups.

KEEP THE PROCESS SIMPLE 



CREATING DYNAMIC CUES 
WITH ABLESET 2

THE PLAYBACK METHOD™ WORKBOOK

If  you’re looking to use dynamic cues, and looking for a setlist management solution, you should
choose AbleSet. While the setup is the same as using a virtual MIDI driver and the Advanced Playback

template, the implementation is simple and easy! Here’s how to make it happen!

1
Begin by loading AbleSet within your session to start setting up your tracks.

OPEN ABLESET IN YOUR SESSION 

2
Go to your global programming track and your cues track.
Rename the cues track to 'guide' by adding 'plus' and typing 'guide'. This simple change
allows you to jump to specific sections like drums when looping.

MODIFY THE CUE TRACK 

3
Press play and enable the loop on the intro section. If pre-programmed, the section
should loop automatically.

ENABLE LOOPING 

4
Notice that the guide cue track gets automatically disabled when the section loops. This
is a key feature for managing transitions seamlessly. 

OBSERVE THE DISABLED CUTE TRACK 

5

If using the advanced template in AbleSet, the cues track is already duplicated. If not,
duplicate the cues track manually.
Add the cue for the current section to the new track, differentiating from the cue for the
section you are moving to.
For example, if you’re on the intro, add a cue that says intro, instead of verse in the last
measure of this track in the cue track.

DUPLICATE THE CUES TRACK FOR ADVANCED
MANAGEMENT 

Now, let ’s take a look at setting up our “dynamic” cue. This is the same exact 
process as using a Virtual MIDI Driver.



6
To speed things up, you can click on the cue before the section you’re working on (in the
regular cue track), and use option-click to drag (which automatically duplicates the clip)
and drop into your new cues track.
Set your grid to a fixed grid at 1 bar for faster and more precise selection.

ORGANIZE CUES EFFICIENTLY 

7
Rename the duplicated track to +LOOPGUIDE by using Command 'r' and typing
'+LOOPGUIDE'. Ensure correct spelling.

FINAL ADJUSTMENTS TO TRACK NAMING 

8
Open the AbleSet window to view your entire setlist.

OPEN ABLESET’S WINDOW 

9
Start playback and observe how the 'plus guide' track mutes and the 'plus loop guide'
track unmutes when entering a section. This allows for continuous playback of the
desired section without transitioning. 

MONITOR TRACK BEHAVIOR  

10
Jump around to other song sections, and test enabling the loop to observe how tracks
mute and unmute, ensuring the intended section loops as expected.

DEMONSTRATE WITH DIFFERENT SECTIONS  

11
Finally, disable the looping and watch the tracks return to their default state, moving
from chorus to the next section seamlessly.

DISABLE LOOPING AND RETURN TO DEFAULT 



CREATING DYNAMIC CUES 
WITH CONDUCTOR

THE PLAYBACK METHOD™ WORKBOOK

Similar to Setlist,  there’s no “dynamic cues” implementation in Conductor. But, no fear! Again, I ’m back at
it with alternative solutions. Spoiler Alert..  They’re the same as the solutions shared in the Setlist lesson.

1
Conductor does not have built-in dynamic cue functionality.
If dynamic cues are crucial, consider using Abletset, or opt for a virtual MIDI driver and
the Advanced Playback Template with Conductor.
Conductor doesn’t have the Virtual MIDI issues that Setlist has, so you could use dynamic
cues with a virtual MIDI driver and the Advanced template with Conductor if you’d like.

UNDERSTANDING THE LIMITATIONS 

2

Set up a virtual MIDI driver and the advanced playback template to manage dynamic
cues independently from the setlist functionality.
This method may require more manual intervention but offers greater flexibility in cue
management. 
We’ll talk about setting this up in a moment. 

OPTION 1: USE A VIRTUAL MIDI DRIVER WITHOUT
SETLIST MANAGEMENT 

3

Map a free button on your MIDI controller to the cues track in your performance setup.
Use this button to toggle the cues track on and off during performance as needed.
This allows you to disable the audible cues to the band while repeating a section of the
music. 

OPTION 2: MANUAL CUE CONTROL VIA MIDI
CONTROLLER 

4
Ensure there is a talkback microphone or another method to communicate with the
band members.
Use verbal cues or hand signals to coordinate when sections of the music are repeated.
Simply mute the cue track and inform the band to keep repeating the section as
required.

IMPLEMENTING EFFECTIVE BAND COMMUNICATION

5
While this feature isn’t built into Conductor, it can easily be worked around with a MIDI
controller, and a talkback mic!
Remember that straightforward communication often resolves the need for complex
technical setups.
If you’re using Conductor and HAVE to have dynamic cues, use the Playback Advanced
template to achieve this feature.

KEEP THE PROCESS SIMPLE 



CREATING DYNAMIC CUES 
WITH VIRTUAL MIDI

THE PLAYBACK METHOD™ WORKBOOK

If  dynamic cues are important to you, and you aren’t using AbleSet, here’s how to use a 
Virtual MIDI Driver and the Advanced Playback Template to make that happen!

1
Open a file you’ve formatted using the Advanced Playback Template.
Locate the "Dynamic Cues” track in the template.
If you’re using the Playback Basic template, or a custom template, duplicate the main cue
track to use as the Dynamic Cues track.
Follow the steps in the “one-button repeat” lesson to add repeat clips throughout your
song.

INITIAL SETUP 

2
Go to the first section of your song that might be repeated during a performance (e.g.,
the intro or verse).
Hold the option key (on Mac) or control key (on PC) and click and drag the cue from the
section prior to the one you are in to the last measure of the current section on the
Dynamic Cues track. (For example, while in the intro, drag the intro cue that sounds one
measure before the intro starts to the last measure of the intro.)
Repeat this process for each section of the song where a repeat might occur.
Set your grid to a fixed 1-bar view to simplify the placement of cues.

PLACING DYNAMIC CUES

3
Press Command+M (Mac) or Control+M (PC) to enter MIDI map mode in Ableton.
Map the on/off toggle of the repeat track to a button on your MIDI controller.
While still in MIDI map mode, map the Dynamic Cues track's on/off button and the main
cues track's on/off button to the same button on your MIDI controller for ease of live
control.

MIDI MAPPING FOR LIVE CONTROL  

4
Ensure the default state of your template or song has the repeat track and dynamic cues
track turned off, and the main cues track turned on.
Save your settings.

FINAL SETUP 

5
Play the song from the intro to check the default cues.
Use the mapped button(s) on your MIDI controller to toggle between the default and
dynamic cue states to ensure the functionality during live performance scenarios.
You’ll notice now when “repeat” is engaged, the normal “cues” channel is muted, and the
new “dynamic cues” track is un-muted.

TESTING THE SETUP 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:

CHOOSING A SETLIST
MANAGEMENT TOOL

Explore setlist management solutions for Ableton to
optimize your live performance setup.

Compare industry standards (Setlist, AbleSet) with
simpler options (Taz) and hardware integrations
(Oakboard, LIOBOXv2)
Choose based on your specific needs: from basic setlist
management to advanced remote control capabilities
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WHAT SETLIST MANAGEMENT
PLUGIN IS BEST

THE PLAYBACK METHOD™ WORKBOOK

Before we dive into advanced set programming skil ls,  let's explore various setlist
management solutions for Ableton. We’l l  dive into features, integration
capabilities, and recommended scenarios for each solution, helping you select
the ideal setup based on your specific needs.

Evaluate your needs: 
Determine whether you need simple setlist management or advanced
features like remote control and integration with hardware.

Explore industry standards 
Setlist by Strange Electronic:  Considered the industry standard with
features like loop creation and setlist reordering without rebuilding
songs. Requires Max for Live or Ableton Live Suite.
AbleSet:  Growing in popularity, it offers comprehensive features
including remote control capabilities and multiple set views. Works
with any edition of Ableton Live and does not require Max for Live.
AbleSet is more than a “setlist management” solution for Ableton, it ’s
really a custom view for Ableton, and a way to easily remotely access
Ableton “remotely”.

Consider Simplicity and Affordability:
Taz by Oaktone (Taz Lite, Taz Pro, Taz SP):  Offers varying levels of
functionality from basic setlist management (Taz Lite) to voice
notifications of song titles (Taz Pro) and simple setlist management
(Taz SP). Requires Max for Live or Ableton Live Suite.



Look at Hardware Integration Options:
Oakboard Floor Vista by Oaktone:  Ideal for guitar
players needing a view-only setlist display at their feet.
Works in conjunction with Taz Lite or Taz Pro.
LIOBOXv2 by Goo Roo Controllers:  Offers extensive
control capabilities with a built-in screen for navigating
and controlling setlists. Compatible with all versions of
Ableton and other music software.

Review newly released solutions 
Conductor by Full Fat:  A newer solution that blends the simplicity of
Taz and the features of Setlist, allowing for enhanced navigation
during rehearsals. Requires Max for Live or Ableton Live Suite.

Select based on specific needs 
For guitar players: Opt for Oakboard Floor Vista paired with Taz Lite
or Taz Pro.
For drummers, keyboard players, and offstage playback
engineers:  Consider LIOBOXv2 for comprehensive control over
setlists.
For aspiring professional playback engineers: Master Setlist and
AbleSet, as these are critical for industry-standard gigs in major music
cities.



HOW TO PROGRAM A SET
USING A SETLIST

MANAGEMENT SOLUTION

THE PLAYBACK METHOD™ WORKBOOK

While we cover how to build a setlist of pre-formatted songs in The Playback
Method™ course, it ’s worth briefly touching on how to build a set when using a
Setlist management solution. What changes, how do we organize a large catalog
of content? 

Review the Playback Method™: Prep Stage 
Begin by watching The Playback Method™: Prep stage to understand
the foundational concepts of set programming and management.

Understand setlet management tools:
Learn about different setlist management solutions, focusing on the
typical process for building a set.
While it ’s possible to use the “Multi-File Project” feature of AbleSet 2
to avoid building a set of songs at all ,  I  stil l  prefer building a setlist of
all my songs to avoid any potential delays or complications in opening
files.

Build a master set:
Aim to keep your set as small and manageable as possible to ease
performance and reduce computer load.
Decide whether to include all songs in one set or split them into
multiple sets based on the total number of songs and performance
structure.

Optimize your computer: 
Prior to building your set, assess your computer’s capability to handle
large sets by following the optimizing tips from The Playback
Method™: Optimize stage.



 Consider set structure: 
For bands with fixed song lists per set, consider creating separate
Ableton files for each set to manage performances more efficiently.
For example, Will ,  a student that is in a professional Tribute band,
splits his band’s two 45 minute sets into two different fi les. This
helps keep the total fi le size of each set manageable and easy to use.

Song Arrangement:
Initially, arrange songs in an alphabetical order or any order if using
a setlist tool that allows reordering and searching.
If you plan to perform without a setlist management tool and have a
smaller set, arrange songs in the order you expect to perform.

Follow the three-part framework:
Template: Start with a solid template for your set. Choose the
Playback Basic Template or if using a Virtual MIDI driver, choose the
Playback Advanced Template.
Program Songs: Individually program each song with your template,
to ensure proper integration into the set.
Program Sets: Drag every formatted song into your template and the
overall set to have access to all fi les in one place.

Fine Management: 
Maintain organized file structures with a dedicated folder for songs
and another for the master set.

Use Setlist management solution:
 Implement a setlist management tool l ike AbleSet to handle large
sets efficiently, ensuring flexibility and control during performances.

Continuous updates and improvements:
Regularly revisit and revise your set programming practices based on
performance feedback and technological advancements.



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:

CREATING A STOP
TRACK

Learn to implement automatic song stops for a more hands-
free performance experience.

Master this game-changing technique to stay focused on
the music
Implement automatic stops using various tools:

Setlist, AbleSet 2, Conductor
LIOBOXv2 and Virtual MIDI
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CREATING A STOP TRACK 
WITH SETLIST 

THE PLAYBACK METHOD™ WORKBOOK

Setlist makes it incredibly easy to set up an Auto Stop, so that your 
songs will  automatically stop once they’re complete.

1
Open your Ableton project and navigate to the point in the timeline where you want the
track to automatically stop.
Right-click at the desired stop point and select "Add Locator."

IDENTIFY STOP POINT  

2
Name the newly created locator "AUTOSTOP" to clearly mark it for automation.

NAME THE LOCATOR 

3
Launch the Setlist interface within Ableton.
Hit the "Refresh" button in Setlist. This ensures Setlist reads all the current information
and recognizes the new locator.

OPEN AND REFRESH SETLIST 

4
Press play in Ableton. As the playhead reaches the "AUTOSTOP" locator, it should
automatically stop playback, confirming that the setup is correct.

TESTING THE SETUP 

5
To maintain consistency and ease during your live set, consider applying an auto stop
locator at the end of each song in your setlist.

APPLY TO OTHER SONGS (OPTIONAL)

6
Avoid using the IAC Driver for internal MIDI loopback with Setlist as it can cause
interference. Instead, use it only for sending MIDI out of Ableton.
Navigate to Ableton's preferences (use the shortcut Command + ,) and ensure that the
MIDI input for the IAC Driver is disabled to prevent any unwanted feedback or conflicts.

CONFIGURATION TO AVOID TECHNICAL ISSUES



CREATING A STOP TRACK WITH ABLESET 2 
THE PLAYBACK METHOD™ WORKBOOK

As you probably guessed, AbleSet not only makes it easy to set up an automatic stop, 
it does it multiple ways to accommodate multiple use cases.

1
Navigate to the end of the track where you wish to stop. 
Right-click and choose to create a locator.
Name the locator "STOP".

CREATE A LOCATOR AT THE DESIRED STOP POINT 

2
After naming, a visual gap should appear between the end of your song, and the next
song, indicating where the song will automatically stop.
Press play to test this out!

VISUAL CONFIRMATION 

METHOD ONE: USING A LOCATOR NAMED “STOP”

1
Go to the end of another song in your set.
Right-click at the end and add a locator named "AUTOSTOP".

ADD A LOCATOR WITH A SPECIFIC NAME 

2
The "AUTOSTOP" locator functions exactly the same way as "stop", but it allows you to
import an Ableton setlist you built using Setlist, and maintain the same functionality
without needing to re-name any locators.

PORTABILITY WITH SETLIST

METHOD TWO: USING A LOCATOR NAMED “AUTOSTOP” 

1
Identify two consecutive songs in your set.

POSITIONING TWO TRACKS ADJACENTLY 

2
At the end of the first track (e.g., "Flowers"), place a dot at the beginning of the next
track's name to indicate a stop at the previous track.
Example: Rename "Imagination" to ".Imagination" if you wish to stop after "Flowers".
This renaming creates a clear visual cue that the track will stop at the previous song’s
end.
This allows you to automatically stop between songs, without having large gaps of space
between each song in your set.

RENAME THE FOLLOWING TRACKS 

METHOD THREE: USING A DOT PREFIX IN THE SONG NAME 



CREATING A STOP TRACK 
WITH CONDUCTOR

THE PLAYBACK METHOD™ WORKBOOK

While Conductor requires a bit more particularity to its stop setup,
it ’s sti l l  a simple skil l  to integrate into your setlist.

1
Begin by locating the end of your song within your project timeline.

IDENTIFY THE SONG ENDING

2
Right-click at the desired endpoint of your song on the timeline.
Select the option to add a locator.

ADD A LOCATOR  

3
Rename the new locator with an asterisk () followed by the word "stop". This is important
as it must be named differently from other locators or commands you might be using
with Ableton or Setlist.

RENAME THE LOCATOR 

4
After adding and renaming the locator, hit the "reload" button in Conductor to ensure
the new settings are applied and functioning correctly.

RELOAD CONDUCTOR 

5
Play your song and let it run towards the end.
Observe as it reaches the newly named locator and stops automatically.
Check if it correctly selects the next song, verifying that the setup works as intended.

TEST THE AUTO STOP 



CREATING A STOP TRACK 
WITH LIOBOXV2

THE PLAYBACK METHOD™ WORKBOOK

Let’s look at setting up automatic stops with the LIOBOXv2. 

1
Begin by launching the Ableton session for the song you want to automatically stop.

OPEN YOUR ABLETON SESSION 

2
Play through your song to identify the exact spot where you want it to stop. Pause the
song at this desired endpoint.

LOCATE THE STOP POINT 

3
Right-click at the top of the timeline where you paused the song and choose to add a
locator. This marks the point where the song will stop.

ADD A LOCATOR 

4
To keep the locator from being visible during your session, you will mask it. Click on the
locator you just added, and add an open parentheses.

MASK THE LOCATOR 

5
Inside the parentheses, type the word “STOP” in all caps. This label is critical as it signals
Ableton to halt playback when this point is reached. For example, (STOP)

LABEL THE LOCATOR 

6
Close the parentheses after typing “STOP” and hit enter to save this locator.

CLOSE THE PARENTHESIS AND SAVE 

7
Play your song from the beginning or from a point before the locator to ensure it stops
automatically when it reaches the masked locator.

TEST THE AUTOMATIC STOP 

8
To confirm that the locator is masked, navigate through your session to see if the locator
appears. It should not display the word “STOP” overtly, ensuring it remains hidden
during performances or while you are working within other parts of your session.

VERIFY THE MASKING 



CREATING A STOP TRACK WITH VIRTUAL MIDI 
THE PLAYBACK METHOD™ WORKBOOK

We’re ending with where this all began. This was the special skil l  that got me hooked
on “advanced set programming” many years ago. Here’s how to use a Virtual MIDI

Driver, and the Advanced Playback Template to create a stop track. 

1
Create a MIDI clip that functions as a MIDI controller by sending a specific note (e.g., C-2)
on a designated channel (e.g., Channel 16).
This clip will act similarly to pressing a MIDI controller button.

SETTING UP THE MIDI CLIP 

2
Enter MIDI Mapping Mode in Ableton Live (Command+M) and map the stop button to
respond to the MIDI channel and note set up in your clip.
This clip now acts just like an external MIDI Controller. When you press stop (when the
clip plays), Ableton automatically stops.
 Instead of trying to set up this process from scratch, use the Playback Advanced
Template to save yourself some time!
Drag the stop clip from the template into the stop track of your current set.

MIDI MAPPING THE STOP FUNCTION

THE BASIC SETUP STEPS (WITHOUT USING THE PRE-MADE TEMPLATE) 

3
Insert the stop clip at the end of each song within your set. Adjust it individually for each
song rather than at the set level to save time in the long run.
When Ableton’s play head reaches the clip in the stop track, it will automatically stop.

INTEGRATING THE STOP CLIP INTO SONGS 

4
If using a MIDI controller, ensure the MIDI mapping matches the settings of your stop clip.
Map your MIDI controller to Ableton’s stop button. 
Use the MIDI mappings browser to see what MIDI data your controller sends. 
Create a MIDI clip that matches this data exactly, including the MIDI channel and place the
MIDI clip in the Stop track in the template.
If the MIDI controller sends a different signal, adjust the MIDI clip in the stop track to
match the controller’s settings (e.g., changing the channel or note).

CUSTOMIZING MIDI CLIPS FOR USE WITH MIDI CONTROLLERS  

USING THE PLAYBACK ADVANCED TEMPLATE 

5
If your MIDI controller uses CC values, map these in Ableton Live’s envelope section to
match the stop clip.
This involves adjusting the CC value in the MIDI clip to coincide with the CC value mapped
on the stop button.

HANDLING MIDI CONTROLLERS WITH CC VALUES 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:

CREATING A PAUSE AND
GO TO NEXT TRACK

Master the 'pause and go to next' feature for seamless set
navigation.

Learn to automatically queue up the next song after
each performance
Implement this advanced skill using:

Setlist, AbleSet 2, Conductor
LIOBOXv2 and Virtual MIDI
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HOW TO PAUSE AND GO TO 
NEXT SONG WITH SETLIST  

THE PLAYBACK METHOD™ WORKBOOK

Because of how well Setlist is designed, pause and go to next is the
default behavior of the plugin. This feature is closely related to
the "Auto Stop" function, and the setup for both commands is

almost identical. Let ’s look at how it works. 

1
Open Setlist in either full or mini mode.
Navigate to the settings menu by clicking on the "Settings" option.

OPEN SETLIST SETTINGS 

2
In the settings menu, ensure that the "Automatically Select Next Song" option is
activated. This is typically the default setting but it’s important to verify.

ENABLE AUTOMATIC SONG SELECTION 

3
Select a song that you want to apply the "Pause and Go to Next" command. For
demonstration, we'll use a song titled "Beautiful."
Note: In this example, an AUTOSTOP" is set to occur just after the count-in, before the
intro starts.

WORK WITH A SONG

4
Play the selected song and observe how Setlist automatically selects the next song in the
list after reaching the point where "AUTOSTOP" is applied.
Stop the playback after the AUTOSTOP". Note that the song is paused.

OBSERVE THE FUNCTION IN ACTION 

5
Press play again after the song has stopped. Setlist will automatically proceed to the next
song in the queue.
You can repeat this action to continue advancing through your setlist, with each song
stopping at the designated "Auto Stop" point and ready to jump to the next on playback.

USE “PAUSE AND GO TO NEXT”

6
Combining both AUTOSTOP and the default “Automatically Select Next Song” feature
allows you to setup the order of your songs in Setlist, and simply navigate your set using
only the play button.

NAVIGATE YOUR SET WITH PLAY 



HOW TO PAUSE AND GO TO 
NEXT SONG WITH ABLESET 2  

THE PLAYBACK METHOD™ WORKBOOK

Similar to Setlist,  Pause and Go to Next can easily be enabled in
the AbleSet menu, and the implementation is practically

automatic. Let ’s take a look at making this happen in AbleSet.

1
Open AbleSet on your computer.
Click on the settings icon to access the configuration options.
Choose “Open Settings” in the menu.

ACCESS ABLESET MENU

2
In the settings menu, locate the option labeled “Auto Jump to Next Song.”
Ensure this setting is enabled. This is typically the default setting, but it’s good to double-
check.

ENABLE AUTO JUMP FEATURE  

3
Return to your Ableton setlist to review the current song and its settings.
Verify that each song has a stop command appropriately set up to ensure the "Auto
Jump" works correctly.

REVIEW ABLETON SETLIST

4
For ease of use during live performances, you might prefer opening AbleSet in a floating
window. This allows for easier access and visibility.

OPEN ABLESET IN A FLOATING WINDOW (OPTIONAL) 

5
Navigate to a song with a stop command.
Play through the song and observe the transition at the end. Once the stop marker is hit,
AbleSet should automatically select the next song on the list.

TEST THE SETUP

6
With the next song automatically selected, press the play button on your MIDI controller
or the spacebar on your computer keyboard to start playing the newly selected song.

INITIATE NEXT SONG 

7
With the “Auto Jump to Next Song” feature enabled, and by adding stop commands after
every song, you can now fully navigate your setlist by only pressing stop on your MIDI
controller.

NAVIGATE YOUR SET WITH PLAY  



HOW TO PAUSE AND GO TO 
NEXT SONG WITH LIOBOXV2  

THE PLAYBACK METHOD™ WORKBOOK

Sensing a theme here yet? The default behavior of LIOBOX is
similar to Setlist and AbleSet. But let ’s dive in and see how pause

and go to next works with LIOBOX.

1
Begin by adding a stop locator at the end of your song in Ableton Live. This locator is
essential to automatically stop, and to use the pause and go to next feature.
Ensure that the locator is masked so that it does not display on the LIOBOX interface.
Review the earlier, “Creating a Stop Track with LIOBOXv2” lesson for detailed steps to
make this happen.

SETTING UP THE STOP LOCATOR IN ABLETON LIVE 

2
Play the track in Ableton Live to demonstrate the functionality. As the track plays and
reaches the stop locator, it should automatically stop.
Observe that once the stop locator is hit, Ableton Live stops playback, indicating that the
setup is correctly implemented.

DEMONSTRATION OF DEFAULT STOP BEHAVIOR 

3
Pause and Go to Next is the default behavior of LIOBOX.
Test this by playing the end of a song. Once the song stops at the stop locator, the
LIOBOX will automatically queue up the next song in your list.

CONFIGURING PAUSE AND GO TO NEXT IN LIOBOX

4
Scroll back slightly in the current track in Ableton Live and play from the end to ensure
the transition is smooth.
Hit play after the track stops at the stop locator, and verify that the next song is correctly
selected and ready for playback.
This ensures that when you're ready to move to the next song, you simply press play,
and the LIOBOX handles the transition.

TESTING THE TRANSITION 

5
By adding stop markers in your set, you can automatically take advantage of the pause
and go to next feature of the LIOBOXv2. This allows you to fully navigate your set, by
only pressing play on-stage.

NAVIGATING YOUR SET WITH PLAY  



HOW TO PAUSE AND GO TO 
NEXT SONG WITH CONDUCTOR  

THE PLAYBACK METHOD™ WORKBOOK

Alright, now this is getting a bit humorous. You know the dril l .
Default behavior, easy to use…here’s how Conductor does it!

1
Access Conductor within your Ableton project to begin setting up the command.

OPEN CONDUCTOR IN ABLETON

2
Place a locator at the desired point in your song timeline where you want the song to
pause or stop.

ADD A LOCATOR 

3
Label the locator with an asterisk () followed by the word "stop" e.g., (stop). This is crucial
for the command to function correctly.

NAME THE LOCATOR 

4
After setting the locator and naming it, make sure to hit the "reload" button. This
refreshes Conductor, incorporating the new settings.

RELOAD CONDUCTOR  

5
Play the song from the beginning to test the setup. Ensure that everything is in order as
planned.

START THE SONG 

6
Scroll towards the end of the song where the locator has been set.

NAVIGATE TO THE END OF THE SONG  

7
Press "play" from the point near the locator, then hit "stop" to see if the song pauses and
the next song is automatically selected

TEST STOP COMMAND  

8
If the setup was successful, when you're ready to continue to the next song in the setlist,
simply press "play." This action should start playing the next selected song automatically.

READY FOR THE NEXT SONG 



HOW TO PAUSE AND GO TO NEXT 
WITH VIRTUAL MIDI DRIVER

THE PLAYBACK METHOD™ WORKBOOK

While not as simple and automatic as using a setlist management solution, it ’s sti l l
certainly possible to implement pause and go to next, using a virtual MIDI driver and

the Advanced Playback template. 

1
Start with the Playback Advanced Template: Avoid building from scratch to save
time and potential errors. The template already includes necessary components
like select next song commands.

Ensure Your Songs Are Pre-Programmed in the Template: All songs should
already have their endpoints and transitions configured within the template.

STEP ONE : USE THE TEMPLATE  

2
Add Stop Clips: Ensure each song in your set has a stop clip at its end.

Insert Song Clips for Transitions: For each song, add a clip that triggers the next
song. For instance, at the end of Song 1, insert a clip to jump to Song 2. These clips
are pre-mapped to locators in your Advanced Playback template.

STEP TWO : CONFIGURE SONG TRANSITIONS  

3
Fine-Tune Clip Placement: Place the transition clip precisely where the stop clip is
located to ensure a smooth transition.

Test Each Transition: Play through each transition to ensure clips trigger correctly
and smoothly move to the next song.

STEP THREE: ADJUST CLIP PLACEMENT AND TESTING



Setup MIDI Tracks: Each transition clip should send a MIDI note mapped to the
exact locator of the next song using a specific MIDI channel and note, like C#-1 on
MIDI channel 16.

Apply Track Delay: Set a track delay of at least 20 milliseconds on the select next
song track to ensure the clip triggers after Ableton has fully processed the stop
command.

IF DOING THIS FROM SCRATCH 
(WITHOUT THE ADVANCED TEMPLATE)

Ensure Correct Track Delay Settings: A common error is setting the track delay
too low; ensure it is at least 20 milliseconds.

Use Specific Locators, Not Relative Commands: Map each transition to a specific
locator rather than a relative next locator command to guarantee accuracy
regardless of playback starting point. For example, in the Advanced Template, each
clip corresponds to an exact locator, i.e. locator 3-not a relative mapping like “next”
locator.

Maintain Locator Order: Ensure locators are in the correct order and haven't
been rearranged inadvertently.

AVOID COMMON MISTAKES 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

ADVANCED SONG
PROGRAMMING SKILLS:

RE-ORDERING SONGS

Learn to quickly reorder your setlist on the fly for last-
minute changes.

Master efficient setlist management techniques for pre-
show adjustments
Implement flexible reordering using various tools:

Setlist, AbleSet 2, LIOBOXv2
Conductor, TAZ SP, and Virtual MIDI

From Studio to Stage -  Page 79From Studio to Stage -  Page 46
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HOW TO REORDER SONGS 
WITH SETLIST

THE PLAYBACK METHOD™ WORKBOOK

Reordering songs is the bread and butter of Setlist.  It ’s why it was
created. Let ’s take a look at how to make it happen now.

1
Open the Setlist plugin in Ableton.
You will see two windows: the full list of songs and the Setlist of songs.

STARTING WITH SETLIST

2
Click through the songs in the full list.
Use the 'Add to Setlist' button to transfer your selected songs to the Setlist.

ADDING A SONG TO THE SETLIST 

3
We can add songs to our “setlist” in any order, no matter what their order in our Ableton
set is. 
You can select any song in the full list and press ‘Add to Setlist’ to add to the Setlist, in
any order.

REORDERING SONGS INITIALLY 

4
Start playing from the top of the Setlist.
Continue pressing play to advance through the songs in the Setlist.

PLAYING AND SWITCHING SONGS

5
While a song is playing, you can navigate the Setlist and decide to change the order.
For example, you can select a song in the Setlist window and click the Move Up or Move
Down button in the Setlist window to move the order of the songs-while your audio is
still playing.

REORDERING ON THE FLY

6
Utilize the auto-stop feature which allows the track to stop abruptly after playing, making
it easy to switch the order of your set, or to start a different song immediately.

USING AUTO-STOP

7
Activate MIDI mapping by pressing 'Command + M' in Ableton Live.
Assign MIDI controls to various functions in Setlist, like navigating up and down the
Setlist, moving songs within the Setlist, and controlling play/stop actions.

MIDI MAPPING FOR ENHANCED CONTROL 

8
If an unplanned song needs to be added during a performance, select it directly from the
full list without needing to rearrange or add it to the Setlist.
Play the song directly from the full list, showcasing the flexibility of Setlist management.

ADDING UNEXPECTED SONGS



HOW TO REORDER SONGS 
WITH ABLESET 2

THE PLAYBACK METHOD™ WORKBOOK

The process of reordering songs in AbleSet is easy to do. Let ’s take
a look at making it happen.

1
Start by launching AbleSet on your computer to access your current set list.

OPEN ABLESET

2
Locate the “Edit Setlist” button within the AbleSet interface.
Click this button to enter the editing mode where you can make changes to your set list.

ACCESS SET LIST EDITING

3
Drag a single song to a new position in your setlist. For example, I will drag “Flowers” to
the top of my list to make it the opening song.
Continue adjusting the order of the songs as desired. For instance, I’ll adjust the order of
my songs to be “Flowers” with “September,” and then “Enough is Enough.”

REORDER SONGS

4
Identify any songs you don’t wish to include in the current performance.
Use the hide option to remove these songs from the active set list without deleting them
permanently, ensuring they are not visible or selectable during the performance.

HIDE UNWANTED SONGS  

5
After reordering and adjusting your set list, click “Save Setlist” to apply the changes.
This action updates your set list and finalizes the order of songs.

SAVE CHANGES  

6
Navigate back to the main screen of AbleSet where your new set list is displayed.
Select the first song on the list, (In my case “Flowers”), and press play to start your set.
Proceed through your set list by selecting and playing each song in the new order.

REVIEW AND USE NEW SET LIST 



HOW TO REORDER SONGS 
WITH LIOBOXV2

THE PLAYBACK METHOD™ WORKBOOK

The LIOBOX is the most unique MIDI controller that we’ve covered. 
It ’s the only MIDI controller that allows us to create or edit a setlist directly 

from the MIDI controller, without ever touching our computer. 
Let ’s take a look at how easy it is to do.

1
Access the settings on your LIOBOX. Start by changing the operational mode to
"Ableton Setlist Mode" to facilitate the loading and management of setlists directly
from the device.

ENTER SETTINGS 

2
Navigate to the setlist options and select "Add an Ableton setlist."
Enter the setlist interface. You may rename the default "setlist one" if desired, or
keep it as is for simplicity.
Add songs to your setlist. For example I’ll add the songs "September," "Enough is
Enough," "Flowers," and "Poppin” to my setlist.

CREATE A SETLIST 

3
Return to the main setlist menu to view the current order of your songs.
If necessary, reorder the songs according to your preference or set requirements.
Use the “load setlist” option to load this setlist locally to your device. This action will
display the tracks you've added in the order they are arranged.

MODIFY AND REORDER SONGS 

4
Begin playback to start with the first track in your setlist.
Seamlessly switch between tracks in real-time based on your flow.

PLAYBACK CONTROL 



HOW TO REORDER SONGS 
WITH CONDUCTOR

THE PLAYBACK METHOD™ WORKBOOK

Right in l ine with its simple but elegant design, Reordering songs in our setlist
using Conductor is simple-but elegant. Here’s how.

1
Launch Conductor within your Ableton set. Click on 'expand' to access the full view
of the interface.

OPEN CONDUCTOR IN YOUR SET 

2
Select the songs you want to include in your performance setlist. 

ADDING SONGS TO YOUR SETLIST  

3
Click and drag songs to rearrange their order according to your preference. Adjust
their sequence by simply moving them up or down in the list. 

REORDERING SONGS 

4
Utilize the play and stop buttons to start and stop the playback of the current song.
Use the next song button to skip to the next track in your setlist, ensuring a smooth
transition between songs during your performance.

USING PLAYBACK CONTROLS

5
Once you are satisfied with the arrangement of your setlist, minimize the Conductor
interface to declutter your screen and focus on the essential controls.

MINIMIZE INTERFACE 

6
Navigate through your set list by jumping from one song to the next. Start and stop
playback, and use the song navigation buttons to navigate through your setlist.

NAVIGATING THROUGH SONGS 



HOW TO REORDER SONGS 
WITH TAZ SP 

THE PLAYBACK METHOD™ WORKBOOK

TAZ SP is the version of TAZ that allows us to build and manage setlists.
Here’s how easy it is to do.

1
Taz Lite: Primarily displays the setlist or cue list with a simple interface and allows
you to get basic setlist navigation features. Also, integrates with the Oakboard
Floor Vista for control from your feet.
Taz SP: Allows creation and reordering of multiple cue lists.
Taz Pro: Includes all functionalities of Taz Lite and Taz SP, and adds voice cues and
locator features.

UNDERSTANDING THE DIFFERENT DEVICES 

2
Access your default setlist on either Taz SP or Taz Pro.
Navigate through the setlist as you would in Taz Lite, using simple commands to
play or stop tracks.

INITIATING EDIT MODE 

3
Click on 'Edit Presets' to modify your setlist.
Enter a name for your new cue list, for example, "Four Song Set", and hit enter to
load it.

CREATING A NEW SETLIST 

4
To change the order of songs, simply click and drag the songs to your preferred
positions within the cue list. The interface is designed to be user-friendly, requiring
no additional learning.

REORDERING SONGS 

5
Select the song you wish to remove and click 'Remove Cue' to delete it from the list.

DELETING SONGS 

6
After making the desired changes, click 'Update Preset' to save the new arrangement
of your setlist.

UPDATING THE SETLIST 

7
Navigate through the updated setlist to ensure all changes reflect correctly.
Switch back and forth between the original and updated setlists to compare or
revert changes.

NAVIGATING UPDATED SETLISTS



HOW TO REORDER SONGS 
WITH VIRTUAL MIDI 

THE PLAYBACK METHOD™ WORKBOOK

This is an odd way to start a lesson, but I don’t suggest you do this. I ’ l l  show you how to use
only a Virtual MIDI Driver, and the Playback Advanced template to reorder songs in your set,
but if you’re planning on doing this alot, I  would recommend a setlist management solution.

But if you’re stubborn, here’s how to make this happen.

1
Ensure you have the "Playback Advanced Template" installed in Ableton. This
template should have all necessary mappings pre-configured.
Familiarize yourself with the locators in your set. These are pre-mapped to specific
MIDI notes within the template.

PREPARATION 

2
Open the MIDI mapping mode in Ableton and review the mappings for each locator.
These will correlate to specific songs in your setlist.
Each locator should correspond to a MIDI note, which is crucial for reordering songs.

VIEW AND ADJUST MIDI MAPPINGS 

3
Locate the "Select Next Song" track within your template. If you look at the “Track
Delay” section of the track, you’ll notice the track delay is already set, which is part of
what allows this trick to work.
Prepare for song transitions by placing stop clips at desired points in your set,
allowing for automatic or manual song changes.

SETTING UP SONG SELECTION 

4
To jump to a specific song, manually select the locator mapped to the desired song and
activate the play command.
Use the "Select Next Song" feature to transition from one song to another, ensuring
global quantization is considered so transitions occur on the next downbeat.

EXECUTING SONG CHANGES 

5
For more complex arrangements, like medleys, use the MIDI mappings to jump
from one song to another seamlessly. This involves careful timing and might
require practice to ensure smooth transitions.

BUILDING MEDLEYS 

6
Test the setup in a live setting to ensure that all mappings and transitions work as
expected.
Consider the flow of the performance and adjust your setlist and transitions
accordingly to maintain energy and engagement.

LIVE PERFORMANCE CONSIDERATIONS 



CREATING A ONE-BUTTON FADE 
WITH VIRTUAL MIDI 

THE PLAYBACK METHOD™ WORKBOOK

Open the Playback Template: Load the "Playback Advanced Template," which has
the fade function mapped to return tracks by default.

MIDI Mapping:
Navigate to Session View.
Choose a button on your MIDI controller to map to the fade function.
Enter MIDI mapping mode in Ableton (e.g., Command + M).
Map this button to the clip launch button of the FADE Global Programming
track in your Advanced Template.

ADJUSTING SETTINGS IN ABLETON  

Customize Fade Length: Decide whether you want the default setting to be a one-
measure or two-measure fade. Whatever value you prefer, make them the topmost clips
in Session View, in the FADE track. For example, if you want a two measure fade in/out by
default, move the 2M FADE OUT/FADE IN clips to the top of that track.

Additional Mappings:
If you wish to also fade additional elements out, use the USE TO MAP TO VOLUME clip
to assign to additional elements. 
Solo your FADE track.
Trigger the clip launch button on the USE TO MAP TO VOLUME clip.
Press spacebar to stop playback.
Enter MIDI mapping mode in Ableton (e.g., Command + M).
Click on the fader/button you want to include in your mapping.
Press spacebar to send the MIDI value assigned to the USE TO MAP TO VOLUME clip. 
Press spacebar to stop Playback once mapped.
Enter MIDI mapping mode in Ableton (e.g., Command + M) and review your mappings
in your browser to make sure you didn’t accidentally map to extra features in your set. 

OPTIONAL CUSTOMIZATIONS 

Here’s how to use Virtual MIDI and the Advanced Playback Template to create a one-button fade.

Final Testing:
Play your track and test the fade function using the mapped button.

Save Your Settings: Save these settings in your playback template to ensure you can
easily reuse them in future sessions.

FINAL ADJUSTMENTS AND TESTING 
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THE PLAYBACK
METHOD™: 
REDUNDANT

Hope isn't a good backup plan. That's why we need a fully-redundant
Playback system, so that the show ALWAYS goes on-no matter what.
Instead of hoping and praying that things work, let's learn how to setup
and create a fully redundant Playback system. 

In this stage of The Playback Method™ you'll learn: 
Why redundancy is the secret that allows you to relax, and have fun
on-stage.
What gear you need for a redundant setup.
How to use the PlayAUDIO1U for full audio and MIDI redundancy.
How to manage files in a redundant system.



WHY DOES REDUNDANCY MATTER
THE PLAYBACK METHOD™ WORKBOOK

The show MUST go on. People are paying to see you perform. They’ve traded their hard earned
money to escape their problems for a few hours. The worst thing we want to do is say, “well
oops.. We didn’t have a backup plan so since our computer crashed, we’ve got to cancel the
show”. No! We’re pros. We have a backup plan, and “hope” isn’t a backup plan. Here’s why

redundancy matters so much in Live performance. 

1
Hope is not a good backup plan.
Without a backup plan, you’ll spend the whole performance “baby-sitting” your
computer and technology, and hoping it works. Or worst yet, canceling your show,
because you didn’t have a backup plan!

UNDERSTAND THE IMPORTANCE OF REDUNDANCY 

2
Start with simple backups, such as having an extra copy of your Ableton set on a
thumb drive for easy transfer between computers.
While this isn’t “redundant” gear, it ensures your show goes on.

IMPLEMENT A BASIC BACKUP PLAN

3
Incorporate a redundant audio interface, like the PlayAUDIO1U.
Use two computers and a MIDI controller to ensure that if one computer fails, the
other takes over seamlessly, without the audience or band noticing the switch.

UPGRADE TO A FULLY REDUNDANT SETUP

4
Playback is an instrument. The same way we need backup instruments, or to think about
what we do with our guitar, or drums.. We need to think about redundancy for playback.
Just like having a spare guitar or extra strings is standard for guitarists, having a
redundant setup should be standard for those using playback.
“But we can’t trust it..” If something goes wrong with Playback, and your band is quick to
mention, “but we can’t trust it, if something goes wrong…” remind them that “Playback is
an Instrument”. If a drum head breaks, a guitar string brings, a cable is bad, do you stop
trusting the drums, and guitar? No! We understand that things happen. So, we make a
backup plan. The same is true for Playback. Thankfully in our case, our backup plan is
much easier (and automatic) to implement!

APPLY THE CONCEPT OF REDUNDANCY BEYOND TECHNOLOGY



WHAT COMPUTERS DO YOU NEED FOR
A REDUNDANT PLAYBACK SYSTEM

THE PLAYBACK METHOD™ WORKBOOK

If  you’re going to build a redundant rig, how many computers do you need? And what type of
computers? Can you use that five year old macbook air as your backup computer? Here’s how

to choose a computer.

1
Redundancy math is simple. X2. Take the computer you’re about to buy for
Playback, and buy one more-exactly the same.

UNDERSTAND REDUNDANCY MATH 

2
The cornerstone of a redundant setup is the identical nature of the computers. This
means purchasing two of the exact same models, with the same specifications.
Whether it's RAM, storage capacity, or any other critical specification, both computers
should match perfectly.

SELECT IDENTICAL COMPUTERS 

3
It might be tempting to invest in a single, highly powerful computer with specs like
4000 GB of RAM or a 16 TB hard drive. However, no matter how powerful a single
computer is, it cannot provide the safety net that redundancy offers. Division of labor
between two identical systems is the goal.

AVOID THE TEMPTATION OF OVERKILL  

4
The reason behind insisting on identical computers is synchronization. When using a
MIDI controller to trigger playback, both computers should be able to stay in sync down
to the exact millisecond of the song. This precision ensures that switching from the
primary to the backup computer is seamless and does not affect the timing or flow of
your performance.

ENSURE SYNCHRONIZATION

5
The aim is to have a backup (B computer) that is just as reliable and high-performing as
the primary (A computer). This setup ensures that if something goes wrong with the A
computer, you can switch to the B computer without anyone noticing.

PREPARE FOR SEAMLESS FAILOVER



HOW MANY COPIES OF ABLETON DO I
NEED FOR A REDUNDANT SETUP

THE PLAYBACK METHOD™ WORKBOOK

Sure, we now understand redundancy math, x2. But does this mean we need to buy another copy of Ableton? 

If you intend to use Setlist, TAZ, Conductor, or any setlist management solution that
requires Max for Live, ensure your setup includes this capability.
Decide whether to upgrade to Suite for an all-inclusive solution or to add Max for Live to
your Standard version based on your needs.

1
A single Ableton Live license grants two authorizations, allowing you to run Ableton
on two computers simultaneously.
This setup is both legally compliant and aligned with Ableton's usage policies.

UNDERSTAND ABLETON’S LICENSING POLICY

2
Install Ableton Live on your primary (a) machine.
Install the same version of Ableton Live on your secondary (b) machine, using the
same license.

INSTALL ABLETON ON TWO COMPUTERS 

3
Authorize both installations with the same serial number via your Ableton account.
If you've previously used both authorizations, contact Ableton at
support@ableton.com or through the license portal to request an additional unlock
for your redundant setup.

AUTHORIZATION PROCESS

4
For basic playback functionality, Ableton Live Standard is necessary. The Intro version is
not sufficient.
For advanced playback and redundancy, consider upgrading to Ableton Live Suite or
adding the Max for Live add-on to access enhanced features and tools.

CONSIDER YOUR ABLETON LIVE VERSION 

5
Evaluate the benefits of upgrading to Ableton Live Suite, which includes additional
sounds and features, such as Max for Live.
Alternatively, you can add Max for Live to Ableton Live Standard if you're only seeking
that functionality.

UPGRADE OPTIONS

6 SET UP MAX FOR LIVE (IF NECESSARY) 



HOW TO BACK-UP AND MANAGE FILES
IN A REDUNDANT SETUP

THE PLAYBACK METHOD™ WORKBOOK

It ’s easy to stay focused on “gear” we need for a redundant setup, but one of the most important things to
consider to have a rock-solid, reliable gig, is to manage our fi les so that we NEVER lose any fi les!

1
Opt for a thumb drive with both USB-A and USB-C connectors. Although speed and
storage capacity (e.g., 64GB) may be modest, the versatility in connectivity makes it
invaluable. This drive serves as a reliable medium for transferring files between
primary and backup systems, a method affectionately known as "sneakernet."

PURCHASE A DUAL-FACED THUMB DRIVE 

2
Store your tracks and projects on an external SSD. This not only frees up your
computer's internal storage but also facilitates easy access to your files on different
systems.
Consider formatting your SSD in a manner compatible with your operating systems
and music production software.
Program and save your songs on this drive as part of your redundant file playback
system.

EXTERNAL SOLID STATE DRIVE (SSD) FOR SONG STORAGE 

3
It's wise to have a second external SSD as a backup. This ensures that you can access
your files from a secondary computer, further bolstering your redundancy strategy.

SECONDARY BACKUP SSD

4
Utilize cloud storage, such as Dropbox, for an additional layer of backup. This method
allows for automatic synchronization and access to your files across multiple devices.
However, be mindful of the following:
The capacity of your computer's internal drive could be quickly exceeded by syncing
large audio files. Plan accordingly by possibly opting for a computer with a larger internal
drive or adjusting your cloud storage settings.
Ensure that your critical files, especially Ableton sets, are fully downloaded and stored on
the computer's internal storage, not just accessed remotely. It may be helpful to move
important files out of the cloud storage's sync folder to a location on your desktop for
easy access and certainty of availability.

CLOUD STORAGE SOLUTIONS



WHAT WE NEED TO CREATE A
REDUNDANT AUDIO INTERFACE SETUP

THE PLAYBACK METHOD™ WORKBOOK

If  we’re going to create a redundant audio setup, there’s a few things we need to make this happen. Or, we
could buy one piece of equipment to handle it all…

1
To hear the output of both computers, you’ll need an audio interface for both
computers.

SEPARATE OUTPUTS 

2
In a redundant setup, we only want to hear one computer at a time. So how do we
switch between both interfaces? We use a switcher.
Use a switcher, like the Radial SW8, to connect the two audio interfaces, allowing for
seamless switching between the two sets of outputs.
The switcher should have inputs for both audio interfaces and a single set of outputs
to send to the front of house.

INCORPORATE AN AUDIO SWITCH

3
For a more streamlined setup, consider the PlayAUDIO1U, which combines two audio
interfaces and a switcher in one device.
This device offers twelve XLR outputs and additional outputs for headphones, 

CONSIDER AN INTEGRATED SOLUTION: PLAYAUDIO1U

4
For setups requiring digital audio like Dante or MADI, investigate specialized devices like
the Exbox.MD for Dante or the Prodigy MC/MP/MX.
Understand that while these solutions offer high-quality digital audio transport, they
don’t support MIDI redundancy..you’ll need to solve for this, somewhere else!

EXPLORE ADVANCED DIGITAL SOLUTIONS FOR REDUNDANCY 

5
If we’re creating a live performance network on-stage to control our instruments and
automate our production, how do we create a redundant MIDI solution? We’ll cover that
in our next lesson!

WHY’S MIDI LEFT OUT? 



HOW DO WE MAKE OUR 
MIDI REDUNDANT

THE PLAYBACK METHOD™ WORKBOOK

If  we’re going to create a redundant audio solution, we can’t neglect MIDI. How can we set up a redundant
MIDI setup, so that we can continue to automate our production, and control our instruments on-stage without

sending the same MIDI messages at the same time from both computers?

1
Recognize the importance of having backup systems (audio and MIDI) to ensure
that the live performance continues smoothly in case one computer fails.

UNDERSTANDING THE NEED FOR REDUNDANCY

2
Consider starting with two MIDI interfaces and a MIDI switcher as a basic redundancy
setup.
Discover specialized equipment like the Programmable Input Solutions from MIDI
solutions, suitable for setups requiring five-pin DIN connections.

EXPLORING MIDI REDUNDANCY SOLUTIONS  

3
For a streamlined solution that covers both audio and MIDI redundancy, investigate the
PlayAUDIO1U. These are designed to handle both aspects efficiently.

INTEGRATING AUDIO AND MIDI REDUNDANCY 

4
Examine the features of the PlayAUDIO1U, which includes MIDI redundancy capabilities
and supports five-pin and RTP MIDI over Ethernet for expansive stage setups.
Utilize the Ethernet port on the PlayAUDIO1U for a connected stage performance
network, enhancing the versatility and control of your MIDI setup.

PLAYAUDIO1U FOR MIDI REDUNDANCY 

5
For high-end setups requiring pristine digital audio and comprehensive MIDI
connectivity, the PlayAUDIO1U is recommended. It offers robust MIDI redundancy
options, including USB and RTP MIDI, and can be connected to both A and B computers
for ultimate reliability.
Pair the PlayAUDIO1U with the mioXM or mioXL from iConnectivity to achieve a versatile
setup that supports DIN and USB ports, catering to all your MIDI connectivity needs.

ADVANCED SOLUTIONS FOR PROFESSIONAL RIGS



SETTING UP YOUR MIDI CONTROLLER
WITH THE PLAYAUDIO1U
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The easiest way to create a redundant audio and MIDI setup is to use the PlayAUDIO1U. In this lesson, we’l l
explore how to set up our MIDI Controller with PlayAUDIO1U.

1
Begin by connecting the PlayAUDIO1U interface to both your main and backup
computers to establish a redundant setup.

CONNECT THE PLAYAUDIO1U TO REDUNDANT COMPUTERS

2
Use a single USB cable to connect your MIDI controller to the PlayAUDIO1U's USB
host port, favoring a direct connection for simplicity and reliability.

CONNECT YOUR MIDI CONTROLLER

3
Download, install, and open the Auracle for X-Series software, a crucial tool for managing
connections between your MIDI controller and the iConnectivity interface.

INSTALL AND LAUNCH AURACLE FOR X-SERIES SOFTWARE 

4
Within the Auracle software, reserve a USB host port for your primary MIDI controller to
ensure it consistently communicates through the same port.

MAKE A USB HOST PORT RESERVATION 

5

Consider setting up a backup MIDI controller by reserving another USB host port, which
allows for immediate switch-over in case of failure.

(OPTIONAL) RESERVE A USB HOST PORT FOR A BACKUP 
MIDI COMPUTER 
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6
Open Ableton Live’s MIDI settings to enable “remote” from your MIDI controllers,
ensuring both the primary and backup controllers are recognized and properly
configured.

CONFIGURE MIDI PREFERENCES IN ABLETON LIVE 

7
Utilize Ableton Live’s MIDI mapping function to assign playback controls (play, stop,
next, previous) to your MIDI controller, facilitating live performance management
directly from your controller.

MAP MIDI CONTROLS

8
After mapping your MIDI controls, save your setup and transfer it to your backup
computer. This step ensures both your main and backup systems mirror each other,
providing a truly redundant setup.

SAVE AND TRANSFER YOUR SETP 

9
Finally, test your setup by controlling Ableton Live from your MIDI controller, verifying
that both computers respond correctly to commands, ensuring your performance can
proceed flawlessly, even if one computer encounters issues.

TEST YOUR REDUNDANT SETUP 



SETTING UP MANUAL FAILOVER ON
THE PLAYAUDIO1U
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There’s two ways to manage “failover” on the PlayAUDIO1U. Let ’s take a look 
at my preferred method for managing failover.

1
Ensure you have two identical Ableton sessions ready for redundancy, each
running a set list management solution of your choice.

SETUP DUAL ABLETON SESSIONS 

2
Use a MIDI Controller like the Oakboard Slide Duo for remote control, connecting it
through a mioXM to a PlayAUDIO1U for navigating your Ableton set remotely.

INTEGRATE REMOTE CONTROL 

3
Acknowledge the three ways to switch between Computer A and B:

Using the front panel of the PlayAUDIO1U.
Automatic switching (covered in a separate lesson).
Manual switching using a footswitch, which is my preferred method.

UNDERSTANDING SWITCHING METHODS 

4
Obtain a Boss Dual Footswitch (FS-6) or any compatible footswitch.
Connect it to the PlayAUDIO1U using a TRS cable, plugged into the Control 1 port.

CONFIGURE THE MANUAL SWITCH (FOOTSWITCH SETUP)

5
Test the switching functionality between Scene A and Scene B using the footswitch.
Check the front panel to visually see the switchover happen, or you can see this in
Auracle for X-Series on the “Audio” page.

VERIFY MANUAL SWITCH OPERATION 

6
If you need to remotely control the manual switchover of your PlayAUDIO1U, you can
use a few adapters and XLR cables to make this happen.
Gather TRS to XLR adapters (TRS male to XLR male, and TRS male to XLR female).
Use an XLR cable to extend the connection from the PlayAUDIO1U to the footswitch
across the stage.

EXTEND FOOTSWITCH REACH FOR ONSTAGE USE 

7
Perform a walk-across-room test to demonstrate the footswitch's effective range in
switching between Scene A and Scene B.

TESTING DURING THE “BURN-IN SESSION



SETTING UP AUTOMATIC FAILOVER ON
THE PLAYAUDIO1U
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Sure, I  prefer manual failover (so I can be in control),  but it does take a bit more mental
bandwidth to manage, so most folks prefer automatic failover. Here’s how to make it happen

on the PlayAUDIO1U.

1
Visit the iConnectivity website and download the LifeSine plugin. Choose the version
compatible with your operating system (e.g., Apple Silicon version for Macs with M1 chips).

DOWNLOAD THE LIFESINE PLUGIN

2
After downloading, locate the LifeSine plugin file on your computer.
For Mac users, access the Library folder by holding down the Option key and clicking on the
Go menu. Navigate to Library > Audio > Plugins > Components.
Drag and drop the LifeSine plugin component (.component file) into the Components folder.

INSTALL THE PLUGIN 

3
Open Ableton and go to Preferences (Command + Comma).
Navigate to the Plugins section and ensure Audio Units V2/V3 or VST3 (depending on
your plugin version) are enabled.
Rescan your plugins so that Ableton recognizes the newly installed LifeSine plugin.

CONFIGURE ABLETON

4
In Ableton, find the LifeSine plugin in the browser and drag it into your set.
Consider adding the LifeSine plugin to your playback template for ease of use in future sets.

ADD THE PLUGIN TO YOUR SET  

5
Assign the plugin's output to external out, specifically choosing output 15 on the PlayAUDIO1U
interface. Adjust preferences and output configurations in Ableton if necessary.

SETUP PLUGIN OUTPUT  

6
Open Auracle for X-Series and navigate to the audio tab. Ensure the scene is set to A and
the system is armed for automatic failover.

CONFIGURE FAILOVER SETTINGS IN AURACLE FOR X-SERIES

7
Simulate a failure (e.g., turn off the LifeSine plugin or disconnect the computer) to
ensure the system automatically switches to the backup computer seamlessly.

TEST THE SETUP

8
In Auracle for X-Series, adjust failover settings such as audio timeout to prevent
premature switching. Disabling auto-switch back to Scene A is recommended for more
control over the failover process.

FINAL ADJUSTMENTS



HOW TO TRANSFER FILES BETWEEN
REDUNDANT COMPUTERS
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One of the hardest challenges of working with redundant setups is managing fi les. While you
might immediately consider a cloud based solution like Dropbox, here’s an alternative, and

free, open source solution that’s cross platform. 

1
Start by networking both Mac computers. This doesn't require an internet
connection but involves connecting both computers to the same network via
Ethernet cables and a network switch.
Any network switch will work, but I personally use the Netgear GS308.

NETWORK YOUR COMPUTERS 

2
Download and install LANdrop on both the source computer (Computer A) and
the destination computer (Computer B).

INSTALL LANDROP

3
For individual files or small sets, ensure they are ready to transfer. If you're
transferring Ableton projects, perform a "Collect All and Save" to include all
necessary files.
For larger projects or folders, right-click the folder and select "Compress" to create
a ZIP file, ensuring all components are included in a single package.

PREPARE FILES FOR TRANSFER 

4
Open LANdrop and choose "Send Files."
Drag the file(s) or folder(s) you wish to transfer into the LANdrop window or use
the "Add" button to browse and select them.
Select the destination computer (Computer B) from the list and click "Send."

INITIATE TRANSFER ON COMPUTER A 
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5
On Computer B, you'll receive a prompt to accept the incoming files. Click
"Yes" to start the transfer.
Files will transfer over your local network, showcasing the speed and
efficiency of LANdrop, especially with large files.

ACCEPT TRANSFERS ON COMPUTER B

6
Once the transfer is complete, locate the transferred files on Computer B.
For zipped folders, right-click and choose "Uncompress" to access the contents.
You can now open and use the files, such as an Ableton project, directly on
Computer B.

ACCESS TRANSFERRED FILES 

Edit Files on Computer A: 
Make any necessary edits to your files or projects on Computer A.

Repeat the Transfer Process: 
Use LANdrop to send the updated Ableton Set to Computer B, ensuring both
computers are still connected to the same network. If you’re only making an
edit, you don’t need to send the full project, only the Ableton Set.

Integration on Computer B: 
To make sure the files open properly on the b-machine, drag the Ableton set
back into the Ableton Project folder, and open the Ableton set from that
location.

MAKING EDITS AND UPDATING FILES 



HOW TO MANAGE EDITS IN A
REDUNDANT PLAYBACK SYSTEM 
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If  you’re in the middle of rehearsal and you’re making edits, how do you quickly get those
edits to your B computer? Here’s how to manage edits in a redundant playback system.

1
Ensure both A and B computers have the exact same Ableton project folder,
including all samples and necessary files. This serves as the baseline for both
systems.

START WITH IDENTICAL SETUPS

2
Choose your preferred method for transferring files between the two computers.
Options include physical transfer devices (sneakernet), cloud storage, or local
network solutions like LAN drop.

DECIDE ON A FILE TRANSFER METHOD 

3
When an edit is made to the file on the A computer, immediately save the project
with a new version number (e.g., from 000 to 001) to document changes without
overwriting the original file.

MANAGE EDITS WITH VERSION CONTROL  

4
After saving the new version, use your chosen transfer method to send the
updated file to the B computer. This ensures both computers have the latest
version of the file.

TRANSFER EDITS PROMPTLY 

5
Once the file is transferred to the B computer, place the new version into the
corresponding project folder to replace or join the previous version. This action
synchronizes the two computers.

INCORPORATE THE NEW VERSION INTO B COMPUTER

6
Open the updated file on the B computer to ensure that the changes made on the
A computer are reflected. Verify that samples and edits are correctly transferred.

OPEN AND VERIFY THE UPDATE ON COMPUTER B

7
Continuously update both A and B computers with any new changes to maintain
synchronization. In scenarios where time allows, consider transferring files even
while Ableton is running to minimize downtime.

MAINTAIN SYNCHRONIZATION



HOW TO CREATIVELY USE A
REDUNDANT SETUP IN REHEARSAL 
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 If  you’re using a redundant setup, here’s an easy way to creatively use your redundant
system to manage fi les in rehearsal.

1
Equip yourself with a redundant audio interface, such as the PlayAUDIO1U,
connected to both your primary (A) and backup (B) computers.
Temporarily add a folder containing all the songs or band repertoire to both
computers. Make sure you’ve still got plenty of space on your computer.

SETUP REQUIREMENTS  

2
Envision operating two decks (A and B rigs) where one song plays on the current
deck while the next song is queued on the other.
In rehearsal, focus on individual songs rather than the full set for precise editing
and preparation.

REPLICATE A DJ’S WORKFLOW

3
On the B rig, prepare the next song to be played, by opening the Ableton Session on the
b computer.
Continue rehearsing with the current song on the A rig. When ready to transition, switch
the audio output to the B computer via the PlayAUDIO1U interface.
Play the queued song on the B rig, then immediately prepare the next song on the A rig.
Toggle the scene button on the interface to switch back to the A computer for the next
song, and continue this process throughout the rehearsal.

SONG TRANSITION PROCESS 

4
Keeps rehearsal sessions dynamic and uninterrupted.
Facilitates on-the-fly editing and customization of individual songs.
Allows for a more focused and productive rehearsal environment, especially when
working on song arrangements and performance dynamics.

BENEFITS OF THIS METHOD 

5
Once individual songs are polished, integrate them into the full set for a
comprehensive production run-through.
This method is particularly useful before reaching the final stage of full set
preparation, offering a creative way to utilize your redundant rig for more than
just backup.

INTEGRATION INTO FULL SET PREPARATION 



T H E  P L A Y B A C K  M E T H O D ™  W O R K B O O K

THE PLAYBACK
METHOD™: 

REMOTE
We don't want to let the audience in our "secret" that we're using
Playback and we want to stay focused on the music, and in the
moment. By "remotely" controlling our Playback system, we'll be able to
move our Playback System off-stage, out of sight, and have full control
of our system, without looking like we're checking our email on-stage! 

In the "remote" stage of The Playback Method™, you'll learn:
What you need for remote control
How to remotely control a redundant system
How to MIDI map your controller with Setlist and AbleSet 2
Using a "Smart" MIDI controller for remote control
How to remotely access Setlist and AbleSet 2 with an iPad (whether
you have a MIDI controller or not!)



SETTING UP REMOTE CONTROL OF A
REDUNDANT PLAYBACK SYSTEM
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We don’t want to let the audience in on our “secret” that we’re using Playback, and we don’t
want to look like we’re checking our email on-stage. An easy way to accomplish this is to move
our Playback system off-stage. But how do we control this without having it near us? Here’s

what we need to set up remote control of our fully redundant, “hands-free” setup.

1
Network switch (e.g., Netgear GS308)
mioXM or mioXL device for converting USB or 5-pin MIDI signals to RTP (Ethernet)
PlayAUDIO1U interface
MIDI controller (e.g., Oakboard Slide Duo)
Network cables
Two computers for a redundant setup

EQUIPMENT CHECKLIST 

2
Sketch a "stage plot" for your configuration, detailing the placement of each piece
of equipment.
Install Auracle for X-Series on your computers to manage iConnectivity devices.

PREPARATION

3
Link all devices to the network switch using Ethernet cables.
Attach the MIDI controller to the mioXM.
Ensure the PlayAUDIO1U interface and both computers are also connected to the
network switch.

CONNECTING YOUR EQUIPMENT  

4
Utilize Auracle for X-Series to set up communication between the mioXM and
PlayAUDIO1U.
Configure a USB host reservation on the mioXM for the Oakboard Slide Duo.
Initiate an RTP network MIDI session from the mioXM to the PlayAUDIO1U.

DEVICE CONFIGURATION 

5
Adjust MIDI settings in Ableton Live, to recognize the PlayAUDIO1U interface.
Activate remote control options to permit MIDI commands from the PlayAUDIO1U
to interact with the DAW.

SOFTWARE SETUP 

5
Conduct a thorough test of the setup by using the MIDI controller to command the
DAW’s playback functionalities, verifying actions such as play, stop, and navigation
operate seamlessly through the mioXM, PlayAUDIO1U, and Ableton.
Make any necessary tweaks and troubleshoot connectivity issues as they arise.

BURN-IN TESTING 



WHAT DO WE NEED FOR 
REMOTE MIDI CONTROL 
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If  we’re going to remotely control our Playback System, what do we need? 

1
Begin by connecting the Oakboard Slide Duo to your computer using its USB
connection. This MIDI controller is chosen for its reliability and ease of use.

START WITH THE OAKBOARD SLIDE DUO  

2
Connect the Oakboard Slide Duo directly to your computer with a USB cable. Do
not use USB extenders, as they often fail and disrupt MIDI data transmission.

AVOID USB EXTENDERS 

3
For long-distance MIDI data management, use the mioXM device. This tool acts as a
bridge, converting USB or five-pin DIN MIDI signals into a format that can be transmitted
over Ethernet.

INCORPORATE THE MIOXM 

4
Utilize the Ethernet port on the mioXM to transform MIDI signals into RTP MIDI,
making it ready for network transmission.

CONVERT MIDI TO RTP MIDI 

5
Use a network switch (like the Netgear GS308) to connect multiple devices on the
same network. Connect the Oakboard Slide Duo through the mioXM to this
network switch.

EMPLOY A NETWORK SWITCH

6
Directly connect your computer to the network switch via Ethernet. If your
computer lacks an Ethernet port, employ a USB-C to Ethernet adapter to integrate
it into the network.

CONNECT TO YOUR COMPUTER 

7
Utilize the PlayAUDIO1U interface to achieve redundancy. This device allows MIDI
and audio data to be distributed to two computers simultaneously, ensuring
there's no single point of failure in your setup.

ENSURE REDUNDANCY WITH PLAYAUDIO1U

8
For setups requiring additional connections and presets, consider integrating the
mioXL. This device offers an expanded version of the mioXM, providing more RTP,
USB, and DIN connections for larger or more complex setups.

OPTIONAL: UPGRADE TO THE MIOXL FOR LARGER SETUPS 



HOW TO REMOTELY VIEW 
YOUR SETLIST 
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We know that we need to remotely control our Playback system, and we know what we need to
make that happen, but how do we remotely view our setlist? 

1

Recognize the importance of knowing exactly what you're controlling on stage,
especially when using a MIDI controller like the mioXM.

UNDERSTANDING THE NEED FOR VISUAL 
FEEDBACK & CONTROL  

2

For guitar players, consider the Oakboard Floor Vista. It offers a USB connection to
mioXM and subsequently to your network switch and computer. This device
displays your Ableton setlist, allowing navigation and play/stop controls, though it
does not permit reordering of songs.
For keyboard players, drummers, or those with a tabletop setup, the LIOBOXv2 is
recommended. It offers two USB connections for direct connectivity to computers
or through mioXM for control over both machines. Unlike the Floor Vista, it allows
for full control over your setlist, including reordering songs.

CONSIDERING HARDWARE MIDI CONTROLLERS 
WITH VISUAL FEEDBACK 

3
Use the Mira app on an iPad for a basic view-only control of Setlist, ensuring both
devices are on the same network.
For more comprehensive control, consider AbleSet for remote viewing and
manipulation of your Ableton set from an iPad, iPhone, or another computer. This
requires both devices to be connected to the same network.

SOFTWARE SOLUTIONS FOR REMOTE CONTROL 

4
Avoid relying on wireless connections for live performances due to stability issues.
Instead, use a wired connection for your devices.
For iPhone or iPad, use a lightning to Ethernet adapter to establish a stable
network connection. Ensure the adapter also supports power to keep your device
charged during use.

ENSURE RELIABLE CONNECTIVITY 

5
Choose between the Oakboard Floor Vista and LIOBOXv2 based on your role
(guitarist vs. keyboardist/drummer) and need for control over your Ableton setlist.
For remote control, prioritize using AbleSet with a wired network connection to
ensure reliability and control over your performance setup.

FINAL RECOMMENDATIONS 



HOW TO MIDI MAP YOUR
CONTROLLER WITH SETLIST 
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If  you’re planning on using Setlist as your setlist management solution, here’s
how to MIDI map your MIDI controller with Setlist.

1
Start by incorporating Setlist into your Ableton template. This way, every new set you program will
already include the setlist, pre-mapped and ready to use.
Opt for a MIDI controller that offers at least four buttons, possibly five, to cover essential controls.
For demonstration, the Oakboard Slide Duo is used alongside the mioXM for onstage control.

PREPARATION AND SETUP  

2
Enter MIDI map mode in Ableton (using Command + M) and identify the setlist elements you
wish to control. These elements are highlighted in a purplish-blue color within the setlist plugin.
Map the following controls from your MIDI controller to the Setlist plugin:
Play Button: Initiates playback of the selected song.
Stop Button: Stops playback.
Up/Previous Button: Navigates to the previous song in Setlist.
Down/Next Button: Navigates to the next song in Setlist.
Optionally, map the Open/Close Interface Button for toggling the Setlist interface within
Ableton. This enhances visibility during performances.

MIDI MAPPINGS ESSENTIALS 

3
Conduct the MIDI mapping process on your primary (A) machine first. This involves assigning
each desired action on your MIDI controller to its corresponding function in Setlist.
Save your Ableton set with the new mappings.

IMPLEMENTING MIDI MAPPINGS 

4
Transfer the newly saved Ableton set with MIDI mappings from your A machine to your B
machine. This ensures both machines are identically configured for redundancy.
Utilize your preferred method for file transfer (e.g., LAN drop) to complete this step.

FILE TRANSFER FOR REDUNDANCY 

5
On the B machine, open the transferred Ableton set and verify that all MIDI mappings are
correctly in place.
Ensure both A and B machines have the setlist plugin loaded and functioning with the MIDI
mappings.

VERIFICATION AND ADJUSTMENT 

6
Test the MIDI controller’s functionality with both machines to ensure seamless control over
playback, navigation, and setlist visibility.
Verify that both machines respond correctly to each command from the MIDI controller,
maintaining synchronization between them for redundancy.

OPERATIONAL TESTING 



SETTING UP REMOTE CONTROL USING
LIOBOXV2 WITH ABLETON LIVE 
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If  you’re looking for a hardware, fully-integrated solution for viewing,
controlling and building a setlist,  there’s nothing like the LIOBOXv2. Here’s how

to set up the LIOBOXv2 for remote control of your Playback System.

1
For this lesson, I’m assuming you’ve already set up the LIOBOXv2 and have some basic
understanding of the device. If not, view our LIOBOXv2 course.
Make sure the LIOBOXv2 control script is correctly installed on your A (main) and B (backup)
computers.
Secure your network as outlined in previous lessons, ensuring all devices are interconnected.

PREPARATION 

2
Use a USB cable to connect the LIOBOXv2 to the PlayAUDIO1U for local control capabilities.
Opt to use one of the two USB ports on the LIOBOXv2 for a unified workflow across different
MIDI controllers.

HARDWARE SETUP 

3
Launch Auracle for X-Series on your A computer to oversee USB and MIDI routing.
In Auracle, reserve the necessary USB host port(s) for your devices.
Configure MIDI routing from the LIOBOXv2 to both A and B computers, making sure to set up
both sending and receiving paths.

SOFTWARE CONFIGURATION 

4
Adjust the MIDI preferences on both A and B computers to allow the LIOBOXv2 to send to and
receive MIDI from Ableton via the designated ports.

ABLETON SETUP 

5
Confirm that both computers recognize the LIOBOXv2 and can manage Ableton sets, ensuring
sync and control from the device are intact.

TESTING LOCAL CONTROL 

6
Change the USB connection from PlayAUDIO1U to mioXM to enable remote control
functionalities.
In Auracle for X-Series, replicate the steps for USB and MIDI routing via mioXM, with a focus on
ensuring network connectivity.
Validate the setup by operating Ableton from the LIOBOXv2 through mioXM, checking that full
remote capabilities are active. 

SWITCHING TO REMOTE CONTROL  

7
Perform a comprehensive test of the whole system, including failover scenarios, to confirm
redundancy is effective.
Verify direct feedback and management of setlists from the LIOBOXv2.

FINAL VALIDATION

8
Employ the setup in a variety of rehearsal contexts to become accustomed to the workflow and
identify any potential issues.

PRACTICE AND REHEARSAL 



SETTING UP REMOTE CONTROL USING A
OAKTONE FLOOR VISTA WITH ABLETON LIVE
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As a guitar player, the Oakboard Floor Vista is the best solution for remotely
viewing your setlist from your pedalboard.

1
Understand that this floor controller is specially designed for on-stage musicians who need a hands-
free solution to control their playback system.

INTRODUCTION TO THE OAKBOARD FLOOR VISTA

2
Prepare two Ableton sessions, designated as Ableton session A and B. Ensure Taz Lite is loaded into
both sessions to facilitate the mirroring of the cue list on the Oakboard Floor Vista.

SETTING UP YOUR SESSIONS IN ABLETON

3
Initially, connect the Oakboard Floor Vista to the PlayAUDIO1U via a USB cable. This step is essential
for setting up a local connection before moving to a networked setup.

LOCAL SETUP WITH PLAYAUDIO1U

4
Configure MIDI settings in Ableton to enable remote control and MIDI mapping. This allows the
Oakboard Floor Vista to control playback and navigate through your setlist.

ABLETON CONFIGURATION FOR PLAYAUDIO1U

5
Link your devices (Oakboard Floor Vista, mioXM, and PlayAUDIO1U) through a networked setup. This
includes setting up ethernet connections and ensuring all devices are communicating correctly.

NETWORKING YOUR DEVICES

6

Use Auracle for X-Series software to configure settings for both local (PlayAUDIO1U) and networked
(mioXM) setups. This involves setting up USB host port reservations and MIDI routing paths.

CONFIGURING AURACLE FOR X-SERIES FOR LOCAL AND
NETWORKED CONTROL

7
Ensure that MIDI signals can flow both ways between your Ableton sessions and the Oakboard Floor
Vista. This step is crucial for the Oakboard Floor Vista to display the current setlist and receive
feedback from Ableton.

FINALIZING MIDI ROUTING FOR BI-DIRECTIONAL CONTROL

8
Conduct thorough tests to confirm that the Oakboard Floor Vista can control both Ableton sessions.
Verify that you can navigate the setlist, play songs, and the tempo indicator is functioning correctly.

TESTING YOUR SETUP

9
Practice switching your Oakboard Floor Vista connection from the PlayAUDIO1U to the mioXM.
This flexibility allows for easy transitions between rehearsal and live performance setups.

SWITCHING BETWEEN LOCAL AND NETWORKED SETUPS

10
Once you're satisfied with the setup, save your configuration on both the PlayAUDIO1U and
mioXM. This ensures that your system is ready to go for both rehearsal and live performances.

SAVING YOUR CONFIGURATION



HOW TO SETUP REMOTE CONTROL
OF SETLIST USING AN IPAD
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If  you’re using Setlist for setlist management, here’s how to use an iPad to remotely view your
set. If  you’ve also set up a MIDI controller for remote control, you can pair this functionality

with your MIDI controller to visually see what your MIDI controller is doing.

Ensure both of your computers (referred to as Computer A and Computer B) are connected
to the same network.
Connect your iPad to the same network to ensure seamless communication between devices.

INITIAL SETUP

On your iPad, search for and install the "Mira Controller" app from the App Store.
Upon first launch, allow the app to find devices on your local network.

INSTALLING THE MIRA CONTROLLER APP

Recognize the limitation of controlling only one setlist instance (Computer A) from the
iPad. For true redundancy, an additional solution is necessary.

ADDRESSING REDUNDANCY WITH COMPUTER B

Open the Mira Controller app on your iPad. It will search for Macs servers, which are
essentially the computers running your setlist.
Identify and connect to your primary computer (Computer A) to establish a link.

CONNECTING TO MACS SERVERS

View and operate your setlist directly from the iPad, mirroring the actions on Computer A.
Experiment with playing, stopping, and selecting songs within the setlist from your iPad.

NAVIGATING YOUR SETLIST ON THE IPAD



Connect a MIDI controller, such as the Oakboard Slide Duo, to a mioXM device, which
networks both computers.
Use the MIDI controller to simultaneously control setlists on both Computer A and
Computer B, ensuring perfect sync.

INTEGRATING MIDI CONTROLLER FOR REDUNDANT CONTROL

Switch the iPad to view-only mode, allowing it to serve as an additional visual aid rather
than a control device.
Navigate the setlist using the MIDI controller, with changes reflected on both computers
and the iPad.

CONFIGURING IPAD FOR VIEW-ONLY MODE

For stability and reliability, especially in live settings, connect the iPad to a wired network
using an Ethernet to Lightning adapter.
Disable Wi-Fi on the iPad and both computers to minimize interference and ensure a solid
connection.

ESTABLISHING A WIRED NETWORK CONNECTION

Arrange your MIDI controller and iPad in an ergonomic and visually accessible manner,
ensuring ease of navigation through your setlist.
Consider using an aesthetically pleasing iPad stand for a professional setup appearance.

FINALIZING THE SETUP



HOW TO SETUP REMOTE CONTROL OF 
ABLESET 2 USING AN IPAD

THE PLAYBACK METHOD™ WORKBOOK

AbleSet is the best solution for remotely controlling and viewing your Playback
System. If you don’t have a MIDI controller, it ’s sti l l  possible to have full remote

control of your Playback System from a remote device. Here’s how to do it.

1
Begin with two computers (referred to as Computer A and Computer B) running identical Ableton Live
sets with AbleSet open.
Ensure that AbleNet is enabled on both machines for bi-directional synchronization.

INTRODUCTION TO THE SETUP

2
Connect both computers to a network switch, creating a performance network.
Utilize a PlayAUDIO1U for audio connection and a mioXM for MIDI control, though MIDI control is
optional for this setup.

ESTABLISHING A NETWORKED STAGE 

3
Opt for a device with a larger screen like an iPad for better visual control, though a smartphone can
also suffice.
Connect the remote device to the same network as your computers using a lightning to Ethernet
adapter or its equivalent, depending on your device.

PREPARING YOUR REMOTE DEVICE 

4
Within ableset settings, set a web app password to secure access.
Locate and note the Remote IP Address from the ableset menu on one of the computers.

CONFIGURING REMOTE DEVICE ACCESS 

5
On your remote device, enter the noted IP address in a web browser to access your AbleSet remotely.
You'll initially have a view-only access; to interact with the setlist, click the lock icon and enter your password.

NETWORKING YOUR DEVICES

6
Navigate through the setlist, selecting songs or specific sections within songs from your remote device.
Changes made will sync across both Computer A and B, ensuring unified playback control.

INTERACTING WITH YOUR SETLIST REMOTELY

7
If incorporating a MIDI controller, midi map it to ableset for additional control capabilities.
The remote device can provide visual confirmation of selections made via the MIDI controller, offering a
comprehensive overview of the setlist status.

ENHANCING CONTROL WITH A MIDI CONTROLLER (OPTIONAL)


